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© Barco, Inc.  July 30, 2008

All rights reserved.  No part of this document may be copied, reproduced or translated. It 
shall not otherwise be recorded, transmitted or stored in a retrieval system without the prior 
written consent of Barco.

kçíáÅÉ
Barco provides this manual “as is” without warranty of any kind, either expressed or 
implied, including but not limited to the implied warranties or merchantability and fitness for 
a particular purpose. Barco may make improvements and/or changes to the product(s) and/
or the program(s) described in this publication at any time without notice.

This publication could contain technical inaccuracies or typographical errors. Changes are 
periodically made to the information in this publication; these changes are incorporated in 
new editions of this publication.

cÉÇÉê~ä=`çããìåáÅ~íáçåë=`çããáëëáçå=Ec``F=pí~íÉãÉåí
This equipment has been tested and found to comply with the limits for a class A digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area may cause harmful interference, in which case the user will be responsible for 
correcting any interference.

dì~ê~åíÉÉ=~åÇ=`çãéÉåë~íáçå
Barco provides a guarantee relating to perfect manufacturing as part of the legally 
stipulated terms of guarantee. On receipt, the purchaser must immediately inspect all 
delivered goods for damage incurred during transport, as well as for material and 
manufacturing faults Barco must be informed immediately in writing of any complaints.

The period of guarantee begins on the date of transfer of risks, in the case of special 
systems and software on the date of commissioning, at latest 30 days after the transfer of 
risks. In the event of justified notice of compliant, Barco can repair the fault or provide a 
replacement at its own discretion within an appropriate period. If this measure proves to be 
impossible or unsuccessful, the purchaser can demand a reduction in the purchase price or 
cancellation of the contract. All other claims, in particular those relating to compensation for 
direct or indirect damage, and also damage attributed to the operation of software as well 
as to other services provided by Barco, being a component of the system or independent 
service, will be deemed invalid provided the damage is not proven to be attributed to the 
absence of properties guaranteed in writing or due to the intent or gross negligence or part 
of Barco.

If the purchaser or a third party carries out modifications or repairs on goods delivered by 
Barco, or if the goods are handled incorrectly, in particular if the systems are commissioned 
operated incorrectly or if, after the transfer of risks, the goods are subject to influences not
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agreed upon in the contract, all guarantee claims of the purchaser will be rendered invalid. 
Not included in the guarantee coverage are system failures which are attributed to 
programs or special electronic circuitry provided by the purchaser, e.g. interfaces. Normal 
wear as well as normal maintenance are not subject to the guarantee provided by Barco 
either.

The environmental conditions as well as the servicing and maintenance regulations 
specified in this manual must be complied with by the customer.

qê~ÇÉã~êâë
Brand and product names mentioned in this manual may be trademarks, registered 
trademarks or copyrights of their respective holders.  All brand and product names 
mentioned in this manual serve as comments or examples and are not to be understood as 
advertising for the products or their manufactures.

`çãé~åó=^ÇÇêÉëë

Barco, Inc.
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 

• Fax: (916) 859-2515

• Website:  www.barco.com 

Barco N.V. 
Noordlaan 5
8520 Kuurne
BELGIUM 

• Phone: +32 56.36.82.11 

• Fax: +32 56.35.16.51

• Website:  www.barco.com

Technical Support 

• Tech Line:  (866) 374-7878 — 24 hours per day, 7 days per week

• E-mail: folsomsupport@barco.com
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léÉê~íçêë=p~ÑÉíó=pìãã~êó
The general safety information in this summary is provided for operating personnel, 
specifically pertaining to the hardware components of the Encore GC and ECU.

aç=kçí=oÉãçîÉ=`çîÉêë=çê=m~åÉäë
There are no user-serviceable parts within the unit.  Removal of the top cover will expose 
dangerous voltages. To avoid personal injury, do not remove the top cover.  Do not operate 
the unit without the cover installed.  

mçïÉê=pçìêÅÉ
This product is intended to operate from a power source that will not apply more than 230 
volts rms between the supply conductors or between both supply conductor and ground.  A 
protective ground connection by way of grounding conductor in the power cord is essential 
for safe operation.

dêçìåÇáåÖ=íÜÉ=mêçÇìÅí
This product is grounded through the grounding conductor of the power cord.  To avoid 
electrical shock, plug the power cord into a properly wired receptacle before connecting to 
the product input or output terminals.  A protective-ground connection by way of the 
grounding conductor in the power cord is essential for safe operation.

rëÉ=íÜÉ=mêçéÉê=mçïÉê=`çêÇ
Use only the power cord and connector specified for your product. Use only a power cord 
that is in good condition.  Refer cord and connector changes to qualified service personnel.

aç=kçí=léÉê~íÉ=áå=bñéäçëáîÉ=^íãçëéÜÉêÉë
To avoid explosion, do not operate this product in an explosive atmosphere.
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qÉêãë=få=qÜáë=j~åì~ä=~åÇ=bèìáéãÉåí=j~êâáåÖ=

t^okfkd
Highlights an operating procedure, practice, condition, statement, etc., which, if not strictly 
observed, could result in injury to or death of personnel.

`^rqflk
The exclamation point within an equilateral triangle is intended to alert the user to the 
presence of important operating and maintenance (servicing) instructions in the literature 
accompanying the appliance.

^sboqfppbjbkq>
Le point d´exclamation dans un triangle equilatéral signale à alerter l´utilisateur qu´il y a 
des instructions d´operation et d´entretien tres importantes dans la litérature qui 
accompagne l´appareil.

slopf`eq
Ein Ausrufungszeichen innerhalb eines gleichwinkeligen Dreiecks dient dazu, den 
Benutzer auf wichtige Bedienungs-und Wartungsanweisungen in der Dem Great 
beiliegenden Literatur aufmerksam zu machen.

Note Highlights an essential operating procedure, condition or 
statement.
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`Ü~åÖÉ=eáëíçêó
The table below lists the changes to the Encore GC and ECU User’s Guide. 

Table 0-1. Change History

Rev Date ECP # Description Approved By

00 7/30/08 560717 Encore GC and ECU User’s Guide J. Konst
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NK==fåíêçÇìÅíáçå

This chapter is designed to introduce you to the Encore GC and ECU (Encore Graphical 
Controller and Encore Control Unit).  Areas to be covered are: 

• Software Version

• Chapter Structure

• How to Use This Guide

• Conventions

• Terms and Definitions

• System Overview

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 2, “Hardware Orientation” on 
page 29.
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NK==fåíêçÇìÅíáçå
Software Version
pçÑíï~êÉ=sÉêëáçå
This version of the Encore GC and ECU User’s Guide is based on software version 1.00.  

`Ü~éíÉê=píêìÅíìêÉ
The following chapters provide instructions for all aspects of Encore GC and ECU 
operations: 

• Chapter 1, “Introduction” provides a system overview, a list of features and basic 
system diagrams.

• Chapter 2, “Hardware Orientation” on page 29 explains the Encore GC and 
ECU’s hardware. 

• Chapter 3, “Hardware Installation” on page 33 provides comprehensive system 
hardware installation instructions.    

• Chapter 4, “Getting Started” on page 43 provides instructions for starting up the 
Encore GC and ECU, installing the application and launching the system.

• Chapter 5, “Menu Orientation” on page 61 explains the Encore GC’s user 
interface, and provides basic menu navigation procedures. 

• Chapter 6, “System Setup” on page 143 outlines procedures for setting up and 
configuring the Encore GC and ECU.

• Chapter 7, “Operations” on page 163 provides basic Encore GC and ECU 
operating instructions. 

• Appendix A, “Specifications” on page 191 lists the Encore GC and ECU’s 
software and hardware specifications. 

• Appendix B, “Contact Information” on page 195 lists important Barco contact, 
RMA, warranty and technical support details. 

• Appendix C, “Upgrading Software” on page 197 provides a detailed procedure 
for upgrading Encore GC software.
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NK==fåíêçÇìÅíáçå
How to Use This Guide
eçï=íç=rëÉ=qÜáë=dìáÇÉ
Following are tips for streamlining your use of this User’s Guide in its electronic “PDF” form.

k~îáÖ~íáåÖ
Use Acrobat Reader’s “bookmarks” to navigate to the desired location.  All chapter files 
have the same bookmark structure for instant navigation to any section.   Please note:

• Extensive hyperlinks are provided within the chapters.

• Use Acrobat’s “Go to Previous View” and “Return to Next View” buttons to trace 
your complete navigational path.  

• Use the “Previous Page” and “Next Page” buttons to go to the previous or next 
page within a file. 

• Use Acrobat’s extensive search capabilities, such as the “Find” tool and “Search 
Index” tool to perform comprehensive searches as required.  

q~ÄäÉ=çÑ=`çåíÉåíë=~åÇ=fåÇÉñ
Use the Table of Contents bookmarks to navigate a desired topic.  Click any item to 
instantly jump to that section of the guide.  You can also use the Index to jump to specific 
topics within a chapter.  Each page number in the Index is a hyperlink.

dÉåÉê~ä=fåëíêìÅíáçåë
To ensure trouble-free installation, setup and operations, please follow all procedures as 
listed below:  

• For comprehensive hardware orientation, refer to Chapter 2, “Hardware 
Orientation” on page 29.

• For complete Encore GC and ECU installation instructions, refer to Chapter 3, 
“Hardware Installation” on page 33.

• To start up the system, refer to Chapter 4, “Getting Started” on page 43.

• For a comprehensive review of all Encore GC menus, refer to Chapter 5, “Menu 
Orientation” on page 61.

• For system setup instructions, refer to Chapter 6, “System Setup” on page 143.

• For operating instructions, refer to Chapter 7, “Operations” on page 163.

Should you have any questions regarding the installation or operation of the Encore GC 
and ECU, please consult with the factory.  Refer to Appendix B, “Contact Information” on 
page 195 for contact information.  
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NK==fåíêçÇìÅíáçå
Conventions
`çåîÉåíáçåë=
The following conventions are used throughout this guide: 

• The symbol  denotes an operations procedure. 

• The symbol  denotes an example.

• Entries written in bold-face letters denote physical buttons or connectors.  

Press Power to ... 

• Buttons on the Encore GC interface are also shown in bold-face letters.

Press Source 1 to …

qÉêãë=~åÇ=aÉÑáåáíáçåë
The following terms and definitions are used throughout this guide: 

• A “Background” is typically an unscaled source originating from a computer’s 
multi-head graphics card, or a frame grab from a scaled source.  The Encore VP 
(Video Processor) provides two background sources (BG A and BG B), each of 
which appears at the system’s lowest priority — visually in back or underneath all 
other sources.

• A “Destination” is a location to which you can route the output of a VP.  A 
destination can be configured as:

~ a single screen (one projector)

~ multiple screens (such as a wide screen application)

~ an external processor (such as a ScreenPRO-II)

• “GUI” is the acronym for Graphical User Interface.

• A “Key” is an electronic (and visual) process whereby one image is electronically 
superimposed over another source or background.  Keys are typically used for 
titles, logos, and banners.

• A “Layer” is an image display element (such as a PIP, Key or Background) that 
has an associated visual priority — either in front (or in back) of another layer.  

• A “Mixer” is the circuitry that enables you to transition (and scale) PIPs and Keys 
over a background. 

• “M/E” (Mix/Effects) is synonymous with “mixer.”  Each M/E in the VP is capable of 
layering either two PIPs, two keys, or one of each.

• “Operator” refers to the person who uses the system. 

• “PIP” refers to Picture-in-Picture, an on-screen configuration in which one picture 
(typically of reduced size) is positioned over another background image — or 
another PIP.  PIPs can be reduced, enlarged, bordered, shadowed, and mixed on 
and off Program.  PIPs can overlap each other, depending on their visual priority.  

• A “Preset” is a storage register in which you can store (and recall) the entire 
configuration or “look” of your destination(s).   

• “System” refers to the Encore GC and ECU. 
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System Overview
• A “Scaler” is the electronic circuitry that enables you to reduce or enlarge source 
images, thus creating PIPs and Keys that can be positioned (and transitioned).

• The Encore GC supports the following Video Processors:

~ “VP” refers to Video Processor, the system’s full-input Video Processor.

~ “VPx” refers to the VP chassis with a reduced set of inputs.  VPx is used 
only for widescreen and special widescreen “preview” configurations.

~ “SP-II” refers to the ScreenPRO-II. 

póëíÉã=lîÉêîáÉï
The following topics are discussed in this section:

• About Encore GC and ECU

• Encore GC and ECU Features

• The Encore Video Processor

• A Word About Layers

• A Word About Destinations

• Effect Combinations

• Integration with Signal Routers

• Encore GC and ECU System Configurations

^Äçìí=båÅçêÉ=d`=~åÇ=b`r
Encore GC is a graphical user interface (GUI) designed to control the Encore and 
ScreenPRO-II video processors — without the need for an Encore LC or SC controller.  
The ECU-1 (Encore Control Unit) is an advanced server that connects video processors, 
routers, and the PC (which runs the Encore GC) together. 

Overall, the Encore GC and ECU simplify your system configuration and provide a cost 
effective solution for your event’s requirements. 

• A Versatile Tool — The Encore GC runs on Windows XP or Vista, and provides 
the majority of functions currently available from the Encore or ScreenPRO-II 
controllers.  Full backup and restore functions are provided.   

• Control and Configuration — System control is achieved by configuring a 
closed network that consists of your PC, the Encore Control Unit (ECU), your 
system’s Encore or ScreenPRO-II video processors, monitoring, and the desired 
destination devices (e.g., projectors or monitors).  In addition, for external control, 
third party controllers such as Crestron or AMX can be connected to the Encore 
GC network.  In this type of setup, presets are programmed and stored using the 
Encore GC, downloaded to the ECU-1, and then triggered externally.  
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System Overview
båÅçêÉ=d`=~åÇ=b`r=cÉ~íìêÉë
Following is a detailed list of Encore GC and ECU features:

• Configuration

~ Encore Video Processor and VPx support

~ ScreenPRO-II support

~ Barco and non-Barco router support

~ Windows® XP™ or Vista™ support

~ Encore Control Unit (ECU) support

~ Widescreen support

~ Multiple destination support

~ External device control via Crestron, AMX or Medialon

• Setup and Operations

~ Preset control

~ Automatic Preset conflict resolution

~ Input, background/DSK, and output setup

~ Source switching

~ Background transitions

~ PIP and Key control

~ Layer control (size, position and moves)

~ Effects (freeze, Z-order)

~ Frame grab support

~ Show back-up

qÜÉ=båÅçêÉ=sáÇÉç=mêçÅÉëëçê
As an integral part of an Encore GC and ECU system, the Encore Video Processor 
provides the system’s input and output circuitry.  Two models are available:

• The “standard” Video Processor (VP) is a full-featured unit that includes all input, 
output, genlock and link circuitry.

• The VPx is a VP with a reduced set of inputs (DVI only).  The VPx is used for 
widescreen configurations.  VPx includes all output and link circuitry, no genlock 
circuitry, and only a small subset of the standard VP’s input circuitry.  

Both units are housed in a 3RU rack-mount chassis that can be configured with one, two or 
three M/E (mixer) boards.  One or two M/E systems can be upgraded with additional M/Es. 

Note For complete information on VP and VPx hardware, refer to 
the Encore Presentation System User’s Guide.
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fåéìí=cäÉñáÄáäáíó
Each M/E board in the Encore Video Processor provides two independent Athena scalers 
with universal inputs that handle both analog and digital video sources.   

The figure below illustrates a block diagram of the VP’s M/E.

Figure 1-1.  M/E Board Block Diagram, VP

The VP accepts the following inputs:

• Standard component and composite analog video formats (NTSC, PAL, SECAM)

• SDI and HD-SDI Video

• Computer input resolutions up to 1920 x 1200 (analog or digital)

• Analog HD formats including 720p, 1080I, 1080p

• 2048 x 1080p Digital Cinema video

• Plasma display resolutions 

The figure below illustrates a block diagram of the VPx’s M/E.

Figure 1-2.  M/E Board Block Diagram, VPx

The VPx accepts the following inputs:

• Computer input resolutions up to 1920 x 1200, via DVI

VP M/E Board
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Mixer
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VPx M/E Board
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Source Link

DVI
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pÅ~äáåÖ=~åÇ=hÉóáåÖ
For both Video Processor models, the Athena scaler features the following: 

• 1:1 pixel sampling

• Motion adaptive de-interlacing for both standard and high definition sources

• 3:2 and 2:2 pull down detection

• Aspect ratio correction and image cropping

• Real-time window resizing and positioning 

• Full support for seamless transitions, window borders, drop shadows and keying

lìíéìí=cäÉñáÄáäáíó
Each Encore VP and VPx incorporates one output board, which provides all output 
interface functions as well as the blending and data-doubling functions required to support 
wide screen applications.  Supported output resolutions include:

• Computer output resolutions up to 1600 x 1200

• Analog HDTV resolutions including 720p, 1080I, 1080p

• HD-SDI video

• 2048 x 1080p digital cinema video

• Plasma display resolutions. 

Output synchronization is supported to lock the output frame rate to an externally applied 
NTSC/PAL black burst signal.

^=tçêÇ=^Äçìí=i~óÉêë
Within the Encore GC system, each mixer has two layers, A and B, and each can be 
assigned to either PIP or Key functionality.  A single mixer application is shown below.

Figure 1-3.  Layer Illustration — Background, Single Mixer + DSK

Please note the following important points:

• The Downstream Key (DSK) is the highest priority layer, using an unscaled DVI 
input or a scaled frame grab.  The DSK visually appears over all other images 
(PIPs and keys) on all mixers.  

• The high resolution Background layer has the lowest priority, using an unscaled 
DVI input or a scaled frame grab.  This layer visually appears behind all other 
PIPs, keys, and the DSK.  The system can transition between two background 
sources — both of which must be at the projector’s native resolution.  

Wilderness

Background

Layer A: PIP

Layer B: Key

DSK

Nature
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• On any mixer, a PIP layer appears over backgrounds and under the DSK.  Effects 
include mixes, smooth moves and resizing, adjustable aspect ratio, borders, drop 
shadows and soft edges.  

• On any mixer, a Key layer also appears over backgrounds and under the DSK.  
Key effects include luminance keys, and split keys (key alpha and fill).  

• Within a single mixer, layer B has priority over layer A, but you can change that 
priority as desired by using the Swap Z-Order function.  

• On a triple mixer system, up to six inputs can be scaled to produce PIP or Key 
images that can be transitioned independently or in pairs.

• Between mixers, the hierarchy of priorities is easy:  

Figure 1-4.  Mixer Priority

~ The Background layer is always at the bottom.

~ All effects on Mixer 1 are visually in front of the background. 

~ All effects on Mixer 2 are in front of Mixer 1. 

~ All effects on Mixer 3 are in front of Mixers 1 and 2. 

~ The DSK is visually in front of Mixers 1, 2, 3 and background. 

^=tçêÇ=^Äçìí=aÉëíáå~íáçåë
The Encore GC system offers complete flexibility with regard to destinations.  Examples of 
each destination “type” are listed below:

• Single Screen Destination — this is a “single projector” destination that takes its 
input from a VP.  A VPx can only be used as a single destination in a special 
widescreen “preview” configuration.

• Wide Screen Destination — this is a “multiple projector” destination that takes its 
inputs from two (or more) VP or VPx units.

• ScreenPRO-II Destination — this is a standalone ScreenPRO-II that takes its 
inputs via direct connections or routers.   When the ScreenPRO-II output is 
connected to a “side” projector (or monitor), it can be controlled from Encore GC 
as a unique destination.

Background

M/E 1 (Mixer 1)

M/E 2 (Mixer 2)

M/E 3 (Mixer 3)

DSK
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bÑÑÉÅí=`çãÄáå~íáçåë
A fully-loaded VP or VPx is a unit with three mixer (M/E) boards.  A unit configured in this 
way can scale six input sources to create PIPs and/or Keys.  These in turn can be sized 
and positioned on the screen in real-time.

This section illustrates the many (but not all) combinations of image effects that you can 
create on 1, 2 and 3 mixer systems.  Please note:

• In the following illustrations, the specific layers used in creating each effect are 
labeled (e.g., PIP 1A, PIP 1B).  For example, 1A denotes the first PIP or key on 
Mixer 1, 1B denotes the second PIP or key on Mixer 1, etc.

• The symbol ↔ denotes a PIP or a key that can transition.  For example, PIP 2A 
↔ 2B indicates that you can dissolve between sources within the PIP.

The following topics are discussed:

• Single Mixer Effects

• Dual Mixer Effects

• Triple Mixer Effects

páåÖäÉ=jáñÉê=bÑÑÉÅíë
A single mixer VP provides two backgrounds, two scalable layers in the Mixer plus an 
unscaled DSK.  

Please note:

• If the DSK is in use, the background cannot transition between A and B because 
of “available resources.”  

• The DSK and backgrounds are unscaled, in all cases.  

In Chapter 7, refer to the “A Word About Resources” section on page 167 for important 
information about system resources, as they apply to Presets.

• Single Mixer Effect 1

This effect includes a non-transitioning background (either A or B), one 
transitioning PIP and the DSK.

Figure 1-5.  Single Mixer Effect 1 Diagram

Background

PIP
1A ↔ 1B

DSK
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• Single Mixer Effect 2

This transition is similar to effect 1, but because the DSK is not in use, the 
background can transition from A to B, and the PIP can transition between layers 
A and B.

Figure 1-6.  Single Mixer Effect 2 Diagram

• Single Mixer Effect 3

In this effect, because the DSK is in use, the background cannot transition.  Here, 
you can independently fade (or cut) one scaled PIP and one scaled key.  

Figure 1-7.  Single Mixer Effect 3 Diagram

• Single Mixer Effect 4

This transition is similar to effect 3, but because the DSK is not in use, the 
background can transition between sources A and B.  You can also independently 
fade, cut, size and position both the PIP and the key.

Figure 1-8.  Single Mixer Effect 4 Diagram

• Single Mixer Effect 5

In this effect, because the DSK is in use, the background cannot transition — you 
can only use background A.  Here, you can independently fade two scaled PIPs 
up and down — with or without the DSK on screen.  

Figure 1-9.  Single Mixer Effect 5 Diagram

Background A ↔ B

PIP
1A ↔ 1B

Background

PIP
1A

DSK
Key 1B

Background A ↔ B

PIP
1A Key 1B

Background

PIP
1A

PIP
1B

DSK
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• Single Mixer Effect 6

This transition is similar to effect 5, but because the DSK is not in use, the 
background can transition.  You can also independently fade the two PIPs.

Figure 1-10.  Single Mixer Effect 6 Diagram

aì~ä=jáñÉê=bÑÑÉÅíë
A dual mixer VP provides two backgrounds, a total of four scalable layers in the two mixers, 
plus an unscaled DSK. 

• Dual Mixer Effect 1

Using the capabilities of two mixers, this effect enables you to transition 
backgrounds, in addition to transitioning the PIPs on both mixer 1 and 2 — with or 
without the DSK on screen.

Figure 1-11.  Dual Mixer Effect 1

• Dual Mixer Effect 2

With this dual mixer effect, you can transition backgrounds between A and B, plus 
independently size, position, cut or fade a PIP and key on each Mixer.  Transitions 
within the PIPs cannot be performed.  The DSK can be used without restriction.

Figure 1-12.  Dual Mixer Effect 2

Background A ↔ B

PIP
1A

PIP
1B

Background A ↔ B

PIP
1A ↔ 1B

PIP
2A ↔ 2B

DSK

Background A ↔ B

PIP
1A

PIP
2A

DSK
Key 1B Key 2B
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• Dual Mixer Effect 3

This effect enables you to transition between backgrounds, and size/position four 
PIPs on screen — with or without the DSK.  In addition, any PIP could be 
substituted for a key, but transitions within a PIP (or transitions between keys) 
cannot be performed.

Figure 1-13.  Dual Mixer Effect 3

qêáéäÉ=jáñÉê=bÑÑÉÅíë
A triple mixer VP provides two backgrounds, a total of six scalable layers in the three 
mixers plus an unscaled DSK.

• Triple Mixer Effect 1

With this three mixer effect, you can transition between backgrounds, fade or cut 
the DSK as desired, and independently transition within three PIPs.

Figure 1-14.  Triple Mixer Effect 1

• Triple Mixer Effect 2

This effect enables you to transition between backgrounds sources, plus 
independently size, position, cut or fade a PIP and key on each of the three 
mixers.  Transitions within the PIPs or transitions between keys cannot be 
performed.  

Figure 1-15.  Triple Mixer Effect 2

Background A ↔ B

PIP 1A

PIP 1B

PIP 2A

PIP 2B

DSK

Background A ↔ B

PIP
1A ↔ 1B PIP

2A ↔ 2B

DSK

PIP
3A ↔ 3B

Background A ↔ B

PIP 1A
PIP 2A

DSK

PIP 3A

Key 1B
Key 2B

Key 3B
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• Triple Mixer Effect 3

Here, you can transition between backgrounds, and size/position six PIPs on 
screen — with or without the DSK.  Any PIP can be substituted for a key, but 
transitions within PIPs (or transitions between keys) cannot be performed.

Figure 1-16.  Triple Mixer Effect 3

fåíÉÖê~íáçå=ïáíÜ=páÖå~ä=oçìíÉêë
The use of routers (routing switchers) is an integral part of the Encore GC system.  Barco 
offers a complete line of routers for use with the Encore GC, including models available in 
analog, SD-SDI, HD-SDI and DVI formats.  All of our routers are designed and tested to 
ensure quality, reliability and ease of use.  Encore GC is also compatible with other 
manufacturers' routers. 

Background A ↔ B

PIP
1A

PIP
1B PIP

2A PIP 2B
PIP
3APIP

3BDSK
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båÅçêÉ=d`=~åÇ=b`r=póëíÉã=`çåÑáÖìê~íáçåë
This section provides two examples of Encore GC and ECU system configurations.

• System 1 — Single Destination Encore GC and ECU system

Figure 1-17.  Sample single destination Encore GC and ECU system

This single destination system consists of the following components:

• 1 x ECU

• 1 x laptop, running the Encore GC application

• 1 x 3 M/E Encore Video Processor

• 1 x SDI Router

• 1 x RGBHV Router

• 1 x Destination (Projector)

In this configuration, the user programs events and stores Presets using the Encore GC (on 
the laptop).  In this manner, Presets reside on the ECU, enabling the user to preview and 
edit the presentation’s “look” as desired, and run the Presets from the Encore GC.

Laptop or PC running 
Encore GC

ECU

Out

PCs (DVI)

In

Out

16 x 16 MatrixPRO RGBHV Router

16 x 16 MatrixPRO SDI Router

Encore Video Processor, 3 M/E

Destination 1

PG 2

PVW

PG 1

Program Preview

6 x RGBHV

1 x Bgnd

1-6

6 x SDI

1-6

1 x DSK

Up to 16 SDI Inputs

Up to 16 Analog Inputs

Background DSK

Ethernet Switch
(Local Network Only)

Out
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• System 2 — Externally controlled Encore GC and ECU system

Figure 1-18.  Sample externally controlled Encore GC and ECU system

This single destination system consists of the following components:

• 1 x ECU

• 1 x external third party controller

• 1 x 3 M/E Encore Video Processor

• 1 x SDI Router

• 1 x RGBHV Router

• 1 x Destination (Projector) 

In this configuration, with all Presets residing on the ECU, the laptop is removed and 
replaced by an external third party controller.  Presets are executed from the ECU using the 
third-party controller.  

External Third 
Party Control

ECU

Out

PCs (DVI)

In

Out

16 x 16 MatrixPRO RGBHV Router

16 x 16 MatrixPRO SDI Router

Encore Video Processor, 3 M/E

Destination 1

PG 2

PVW

PG 1

Program Preview

6 x RGBHV

1 x Bgnd

1-6

6 x SDI

1-6

1 x DSK

Up to 16 SDI Inputs

Up to 16 Analog Inputs

Background DSK

Ethernet Switch
(Local Network Only)

Out
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få=qÜáë=`Ü~éíÉê
This chapter provides detailed information about the ECU-1 (Encore Control Unit), also 
known as the ECU for short.  

The ECU is a 19”, 1 RU standalone server that runs a Linux operating system.  When all 
components are connected to a closed network, the configured ECU enables you to run 
without a physical Encore controller.  Using the Encore GC and ECU, you can control 
routers, VPs, and store all the Presets required for your event.  

The following topics are discussed:

• ECU Front Panel

• ECU Rear Panel

Important For detailed information about the Encore VP and VPx, refer 
to the Encore Presentation System User’s Guide.

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 3, “Hardware Installation” on 
page 33.
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b`r=cêçåí=m~åÉä
The figure below illustrates the ECU front panel: 

Figure 2-1.  ECU front panel 

Following are descriptions of each front panel section: 

1) HDD LED

The HDD LED indicates hard disk activity.

2) Power LED

The Power LED indicates when power has been applied to the ECU’s 
motherboard.

3) Reset Switch

The Reset Switch is used to reboot the CPU, if required. 

4) CPU Power Switch

The CPU Power Switch is a momentary (non-latching) switch that is used to 
apply power to the motherboard, after the Main Power Switch (on the rear panel) 
has been turned on.  The CPU Power Switch is also used to shut down the ECU.

5) USB Ports

The two front panel USB Ports are not used.

6) Hard Drive Lock

The Hard Drive Lock prohibits user access to the ECU’s hard drive.  Access 
should only be permitted to qualified technical support personnel.

ECU-1

HDD POWER RESET POWER Visibly yours

1 3

2 4

5 6

1) HDD LED 3) Reset Switch 5) USB Ports

2) Power LED 4) CPU Power Switch 6) Hard Drive Lock
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b`r=oÉ~ê=m~åÉä
The figure below illustrates the ECU rear panel:

Figure 2-2.  ECU rear panel 

Following are descriptions of each front panel section: 

1) Exhaust Fan

To prevent chassis overheating, do not block the Exhaust Fan with cables or 
other equipment.

2) AC

One AC Connector is provided for connecting the ECU to AC power.  The 
integral switch turns the chassis on and off.  In Appendix A, refer to the “Physical 
and Electrical Specifications” section on page 192 for power details.

3) Main Power Switch

The Main Power Switch is a latching switch that turns the ECU on and off.  After 
the switch is turned on, use the front panel CPU Power Switch to apply power to 
the motherboard.

4) USB Ports

These two rear panel USB Ports are not used.

5) Blank Panels

The two Blank Panels are not used. 

6) PS2 Port

The PS2 Port is not used. 

3

1 2

4

5

9 10 11

7 136 128

1) Exhaust Fan 6) PS2 Port 11) USB Port

2) AC 7) COM 1 12) VGA

3) Main Power Switch 8) COM 2 13) Exhaust Fan

4) USB Ports 9) LAN 1

5) Blank Panels 10) LAN 2
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7) COM 1

One 9-pin D COM 1 Port is provided for RS-232 serial communications with an 
ASCII terminal.  The port settings are:

~ 115200 baud, N81, no hardware handshaking 

8) COM 2

The 9-pin D COM 2 Port is not used. 

9) LAN 1

The LAN 1 Ethernet port is provided for the closed network.  Connect this port to 
an Ethernet Switch, and then to your system’s VPs, VPx units, laptop or PC, 
routers, and other system devices.  

10) LAN 2

The LAN 2 Ethernet port is provided for your company network, and for third-party 
external show control applications (e.g., Crestron, AMX, Medialon).  

11) USB Port

This rear panel USB Port is not used.

12) VGA

The VGA connector is not used.

13) Exhaust Fan

To prevent chassis overheating, do not block the Exhaust Fan with cables or 
other equipment.

Note This port is designed to be used by qualified service 
personnel only.  To connect the COM 1 Port to a standard PC 
RS232 port (e.g., using ProComm), a “null modem” cable or 
crossover cable is required.

Important This port functions as a DHCP server.  Do not connect the 
LAN 1 port to your company network. 

Note This port functions as a DHCP client.  
32 Encore GC and ECU  •  User’s Guide



PK==e~êÇï~êÉ=fåëí~ää~íáçå

få=qÜáë=`Ü~éíÉê
This chapter provides comprehensive hardware installation instructions for the Encore GC 
and ECU system.  The following topics are discussed:

• Safety Precautions

• Unpacking and Inspection

• Site Preparation

• Rack-Mount Installation

• Cable, Adapter and Accessory Information

• Installation

Note Once you have reviewed the sections in this chapter, please 
continue with Chapter 4, “Getting Started” on page 43.
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Safety Precautions
p~ÑÉíó=mêÉÅ~ìíáçåë=
For all Encore GC and ECU installation procedures, observe the following important safety 
and handling rules to avoid damage to yourself and the equipment:

• To protect users from electric shock, ensure that the power supplies for each VP, 
VPx, router and other peripheral gear connects to earth via the ground wire 
provided in the AC power Cord.

• The AC Socket-outlet should be installed near the equipment and be easily 
accessible.

råé~ÅâáåÖ=~åÇ=fåëéÉÅíáçå=
Before opening the boxes, inspect them for damage.  If you find any damage, notify the 
shipping carrier immediately for all claims adjustments.  As you open each box, compare its 
contents against the packing slips.  If you find any shortages, contact your Barco sales 
representative. 

Once you have removed all the components from their packaging and checked that all the 
listed components are present, visually inspect each device to ensure that there was no 
damage during shipping.  If there is damage, notify the shipping carrier immediately for all 
claims adjustments.

páíÉ=mêÉé~ê~íáçå=
The environment in which you install your Encore GC and ECU system should be clean, 
properly lit, free from static, and have adequate power, ventilation, and space for all 
components. 

o~ÅâJjçìåí=fåëí~ää~íáçå
When rack mounting, remember the following important points:

• The ECU is supplied with front rack-mount ears and rear rack-mount brackets.  
Both are required to support the unit’s full weight.  

• Other Encore GC and ECU equipment (e.g., VP, VPx, routers, etc.) is also 
supplied with front rack-mount ears and rack-mount brackets.  Installation of the 
rear rack-mount brackets is recommended but not required.

• Leave at least one inch of space (front and rear) to ensure that the airflow through 
the fan and vent holes is not restricted. 

• Distribute the units evenly to prevent hazardous conditions that may be created by 
uneven weight distribution. 

• For the front rack ears, install the lower of the two mounting holes first. 
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Cable, Adapter and Accessory Information
`~ÄäÉI=^Ç~éíÉê=~åÇ=^ÅÅÉëëçêó=fåÑçêã~íáçå
The table below provides cable, adapter and accessory information for the ECU:

fåëí~ää~íáçå
Detailed installation procedures are provided below for two Encore GC and ECU 
configurations.  Select the desired configuration, and follow all procedures as listed:

• Single Screen Encore GC and ECU Configuration

• Wide Screen Encore GC and ECU Configuration

Table 3-1. ECU Cables and Adapters

Cable / Adapter / Accessory Description Quantity

AC Power Cord 2 meter, 10A (US Power Cord) 1

AC Power Cord 2.5 meter, 10A (European Power Cord) 1

Keys Keys for hard drive 1 set

Rack mount rails Required to support the unit’s full weight 1 set

Screws For rack mount rails 1 set
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páåÖäÉ=pÅêÉÉå=båÅçêÉ=d`=~åÇ=b`r=`çåÑáÖìê~íáçå
The figure below illustrates a sample “single screen” Encore GC and ECU configuration.  
Use this diagram for reference in the following procedure.  

Figure 3-1.  Sample Single Screen Encore GC and ECU Configuration

For this configuration, you will need:  

Laptop or PC running 
Encore GC

ECU

Out

PCs (DVI)

In

Out

16 x 16 MatrixPRO RGBHV Router

16 x 16 MatrixPRO SDI Router

Encore Video Processor, 3 M/E

Destination 1

PG 2

PVW

PG 1

Program Preview

6 x RGBHV

1 x Bgnd

1-6

6 x SDI

1-6

1 x DSK

Up to 16 SDI Inputs

Up to 16 Analog Inputs

Background DSK

Ethernet Switch
(Local Network Only)

Out

Table 3-2. Equipment List, Single Screen Encore GC and ECU Configuration

Qty. Item Note

1 VP VPx cannot be used in this example

1 ECU

1 Video Projector Customer supplied

2 DVI or Analog Monitors Program and Preview (customer supplied)

1 Ethernet Switch Customer supplied.  Note: do not use a hub.

2 Ethernet cables Customer supplied.  Additional cables required for routers.

TBD Sources, routers, cables Analog, Video and/or DVI sources as required (customer supplied)
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Use the following steps to install a single screen Encore GC and ECU configuration:

1. Follow the unpacking procedures as listed in the “Unpacking and Inspection” 
section on page 34. 

2. In Appendix A, refer to the “Physical and Electrical Specifications” section on 
page 192 for electrical and mechanical details.

3. In Chapter 2 of the Encore Presentation System User’s Guide, refer to the 
“Video Processor Rear Panel” section for all VP connector locations.

4. Follow the rack mount procedures as outlined in the “Rack-Mount Installation” 
section on page 34.  

5. Ethernet Connections — a totally “local” network connection is required.  Using 
Ethernet cables:

a. Connect the VP and your laptop (or PC) to the Ethernet Switch.  

b. Connect the ECU to the Ethernet Switch using the ECU’s LAN 1 port.   

c. Connect router(s) to the Switch.  

d. As required, connect ScreenPRO-II systems to the Switch. 

6. Direct Source Connections — if you elect to use direct connections in place of 
(or in addition to) router connections:

a. On the VP, connect the desired “direct” sources to each M/E’s input 
connectors, as required.

b. On the VP, connect unscaled background and DSK sources, as provided 
from a PC’s single head graphics card, as required. 

7. D/A Connections —  

a. If your system includes analog, SDI or DVI D/As, connect video inputs to 
the D/As as required.

b. On the VP, connect D/A outputs to the to the desired M/E inputs.

8. Router Connections — if you elect to use router connections in place of (or in 
addition to) direct connections:

a. For Ethernet controlled routers, ensure that the router(s) are connected 
to the same Ethernet Switch as the ECU and the VPs.  Ensure that each 
router has a unique IP address.

b. To connect serial routers to the system, a third-party Ethernet-to-Serial 
converter is required, such as the Lantronix model UDS2100 (http://
www.lantronix.com).  Each UDS2100 can control two serial routers.

• Using RS-232 cables, connect each router to the UDS2100.

Note Ensure that your laptop is configured to obtain an IP address 
automatically.  Consult with your Network Administrator for 
details. 

Important The ECU is a DHCP server.  If you have an Encore Controller 
in your system configuration, disconnect it from the Ethernet 
Switch.  Because the Controller is also a DHCP server, it will 
conflict with the ECU.
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• Set up a static IP address on the Lantronix.  The recommended 
range is 192.168.0.191 - 192.168.0.240 — so as not to conflict 
with Barco devices.  See the Lantronix User’s Guide.

• Using an Ethernet cable, connect the UDS2100 to the same 
Ethernet Switch as the ECU.

c. Ensure that all sources are properly connected to your router(s).

d. On the VP, connect all selected router outputs to the desired M/E inputs.

9. ScreenPRO-II Connections — if your system includes one (or more) destination 
ScreenPRO-II units, you can configure the unit for internal or external routing:

a. When External routers are used, connect two outputs from an Analog 
router to the first two HD-15 inputs on the ScreenPRO-II.  An SDI router 
can also be connected to BNC inputs 1 and 2.  During setup, you will 
define these specific patches. 

b. When Internal routing is used, connect Analog sources to inputs 1 - 8 on 
the HD-15 connectors, and SDI sources to BNC inputs 1 and 2.  During 
setup, you will define these specific patches.

In Chapter 6 of the Encore Presentation System User’s Guide, refer to the 
“ScreenPRO-II Destination Setup” section for more information. 

10. Output Connections —

a. Connect the VP’s analog or digital Preview Output to the input of your 
Preview Monitor.  

b. Connect the VP’s analog or digital Program 2 Output to the input of your 
Program Monitor.  

c. Connect the analog or digital Program 1 Output to the projector (or 
primary display) input.  

d. Connect the Program Out HD/SDI connector to an SDI or HDTV 
monitor, or to the proper video distribution equipment.  

11. Power Connection — connect AC power cords to the AC Power Connectors on 
the rear of the VP and ECU, and then to AC outlets.  Connect AC Power cords (or 
AC adapters) to all peripheral equipment.  Please note:

~ Connect each unit only to a properly rated supply circuit. 

~ Reliable grounding of rack-mounted equipment should be maintained.

12. System ID — Using the Unit ID Selector, set the ID of the VP to 1.  

13. Power On — All startup instructions are covered in Chapter 4, “Getting Started” 
on page 43.

Please continue with Chapter 4, “Getting Started” on page 43.

 

Note This output only works if the selected output resolution is a 
valid SDI or HD/SDI format.
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táÇÉ=pÅêÉÉå=båÅçêÉ=d`=~åÇ=b`r=`çåÑáÖìê~íáçå
The figure below illustrates a sample “triple” wide screen configuration.  Use this diagram 
for reference in the following procedure.  Please note:

• This procedure can be used for wide screen configurations consisting of from 2 to 
32 screens.  

• A VP must be used as the “master” processor.  Thereafter, either a VP or a VPx 
can be used.

Figure 3-2.  Sample Wide Screen Encore GC and ECU Configuration

For this procedure, you will need:  

Laptop or PC running 
Encore GC

VP #1

VP or VPx #2

VP or VPx #3

Destination 1

PG 2

PVW

PG 1

Projector #1 Projector #2 Projector #3Program #1 Program #2 Program #3

Preview #1 Preview #2 Preview #3

PG 2

PVW

PG 1

PG 2

PVW

PG 1

Scaled 
Sources

Unscaled
 Sources

M/E Inputs

Unscaled
 Sources

Unscaled
 Sources

Program
Link

Source
Link

Program
Link

Source
Link

To ScreenPRO-II
PresentationPRO-II

Routers, ImagePRO

Note:   VP only, not VPx

ECU

Ethernet Switch
(Local Network Only)

Table 3-3. Equipment List,  Wide Screen Encore GC and ECU Configuration  

Qty. Item Note

1 VP VPx cannot be used as the “master” processor in this example.

2 VP or VPx Use either processor as a “slave” unit in a widescreen configuration

1 ECU
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Use the following steps to install a wide screen Encore GC and ECU configuration:

1. Follow the unpacking procedures as listed in the “Unpacking and Inspection” 
section on page 34. 

2. In Appendix A, refer to the “Physical and Electrical Specifications” section on 
page 192 for electrical and mechanical details.

3. In Chapter 2 of the Encore Presentation System User’s Guide, refer to the 
“Video Processor Rear Panel” section for all VP connector locations.

4. Follow the rack mount procedures as outlined in the “Rack-Mount Installation” 
section on page 34. 

5. Ethernet Connections — a totally “local” network connection is required.  Using 
Ethernet cables:

a. Connect the VP(s), VPx(s) and your laptop (or PC) to the Switch.  

b. Connect the ECU to the Ethernet Switch using the ECU’s LAN 1 port.  

c. Connect router(s) to the Switch.  

d. As required, connect ScreenPRO-II and ImagePRO systems to the 
Switch. 

3 Video Projectors Customer supplied.  

6 DVI or Analog Monitors Program and Preview (customer supplied).  

1 Ethernet Switch Customer supplied.  Note: do not use a hub.

4 Ethernet cables Customer supplied.  Additional cables required for routers.

TBD Program Link Cables Use 1 for double wide screen application, left justification

Use 2 for triple wide screen application, left justification

Use 2 for double wide screen application, center justification

Use 3 for triple wide screen application, center justification

TDB Source Link Cables Dependent on the number of M/Es installed in the Processors  

TBD Sources, routers and cables Analog, Video and/or DVI as required (customer supplied)

Table 3-3. Equipment List,  Wide Screen Encore GC and ECU Configuration   (Continued)

Qty. Item Note

Note Ensure that your laptop is configured to obtain an IP address 
automatically.  Consult with your Network Administrator for 
details. 

Important The ECU is a DHCP server.  If you have an Encore Controller 
in your system configuration, disconnect it from the Ethernet 
Switch.  Because the Controller is also a DHCP server, it will 
conflict with the ECU.
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6. Direct Source Connections — if you elect to use direct connections, in place of 
(or in addition to) router connections:

a. On the first VP, connect the desired “direct” sources to each M/E’s input 
connectors.  In a wide screen system, scaled sources only connect to 
Processor 1.  “Links” carry the signals to the other VP or VPx units.

b. Unscaled Backgrounds must originate from computers with multi-head 
graphics cards, and connect to the same input on each VP or VPx.  

To connect an unscaled background source in a triple processor 
system (each VP or VPx with three M/Es):

• Connect the computer’s “head 1” to processor 1, input 3A 

• Connect the computer’s “head 2” to processor 2, input 3A

• Connect the computer’s “head 3” to processor 3, input 3A

c. The DSK source may originate from a computer with a multi-head 
graphics card, but it is not a requirement.

Connecting a single-head graphics card to processor 3 only would 
enable a bug to be placed only in that screen space.  

To use a multi-head graphics card for the DSK, connect it to the same 
input on each VP or VPx — to the highest priority M/E (M/E 1).  

To connect an unscaled DSK source in a triple processor system 
(each processor with three M/Es):

• Connect the computer’s “head 1” to processor 1, input 1A

• Connect the computer’s “head 2” to processor 2, input 1A

• Connect the computer’s “head 3” to processor 3, input 1A  

7. D/A Connections —

a. If your system includes analog, SDI or DVI D/As, connect video inputs to 
the D/As as required.

b. On the VP, connect D/A outputs to the to the desired M/E inputs.

8. Router Connections — if you elect to use router connections, in place of (or in 
addition to) direct connections:

a. For Ethernet controlled routers, ensure that they are connected to the 
same Switch as the ECU and processors.  Ensure that each router has 
an unique IP address.

b. To connect two (or more) serial routers, a third-party Ethernet-to-Serial 
converter is required, such as the Lantronix model UDS2100 (http://
www.lantronix.com).  Each UDS2100 can control two serial routers.

• Using RS-232 cables, connect each router to the UDS2100.

• Set up a static IP address on the Lantronix.  The recommended 
range is 192.168.0.191 - 192.168.0.240.  

Note Input 3A resides on the lowest priority M/E in a 3 M/E system.  
To connect an alternate background, use input 3B.

Note Input 1A resides on the highest priority M/E in a 3 M/E 
system.  To connect an alternate DSK, use input 1B.
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• Using an Ethernet cable, connect the UDS2100 to the same 
switch as the ECU.

c. Ensure that all sources are connected to your router(s).

d. Connect all selected router outputs to the desired M/E inputs on VP 1.

9. ScreenPRO-II Connections — if your system includes one (or more) destination 
ScreenPRO-II units, you can configure them for internal or external routing:

a. When External routers are used, connect two outputs from an Analog 
router to any two HD-15 inputs on the ScreenPRO-II.  An SDI router 
can also be connected to BNC inputs 1 and 2.  During setup, you will 
define these specific patches. 

b. When Internal routing is used, connect Analog sources to inputs 1 - 8 on 
the HD-15 connectors, and SDI sources to BNC inputs 1 and 2.  During 
setup, you will define these specific patches.

In Chapter 6 of the Encore Presentation System User’s Guide, refer to the 
“ScreenPRO-II Destination Setup” section for more information. 

10. Output Connections —

a. For each VP or VPx, connect the analog or digital Preview Output to the 
input of the associated Preview Monitor.  

b. For each VP or VPx, connect the analog or digital Program 2 Output to 
the input of the associated Program Monitor.  

c. For each VP or VPx, connect the analog or digital Program 1 Output to 
the input of the associated projector.  

d. Connect the Program Out HD/SDI connector to an SDI or HDTV monitor 
as required, or to the proper video distribution equipment.  

11. Link Connections — in a widescreen application, the Program Link and Source 
Link connections are used to connect processors together, and bridge inputs and 
outputs for the proper “overlap” between projectors.  In Chapter 3 of the Encore 
Presentation System User’s Guide, refer to the “Program and Source Link 
Connections” section for details.

12. Power Connection — connect AC power cords to the AC Power Connectors on 
the rear of the VP and ECU, and then to AC outlets.  Connect AC Power cords (or 
AC adapters) to all peripheral equipment.  Please note:

~ Connect each unit only to a properly rated supply circuit. 

~ Reliable grounding of rack-mounted equipment should be maintained.

13. System ID — Using the Unit ID Selector, set the ID of Processor #1 to 1, 
Processor #2 to 2, and Processor #3 to 3.  Each must have a unique ID.

14. Power On — All startup instructions are covered in Chapter 4, “Getting Started” 
on page 43.

Please continue with Chapter 4, “Getting Started” on page 43.

Note This output only works if the selected output resolution is a 
valid SDI or HD/SDI format.
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This chapter provides instructions for installing the Encore GC application, launching the 
system, and preparing the system to the point that you can fully learn all tabs and menus.     

The following topics are discussed:

• Overview

• ID Setup and System Power-up

• Installing Encore GC Software

• Launching the Encore GC Application

• Updating ECU and Processor Software

• Resetting Software

• Destination Setup

• Router and DA Setup

• Saving the System Configuration

• System Shutdown

Important When you complete this chapter, all system devices 
(including the ECU, routers, DAs, video processors and 
Lantronix devices) will be detected and operational, and all 
tabs on the Encore GC will be active.  This will enable you to 
fully learn all tabs and menus.  

At the end of this chapter, however, source inputs and router 
outputs will not be patched.  These functions will be 
performed in Chapter 6, “System Setup” on page 143.

Note Once you have reviewed the sections in this chapter, please 
continue with Chapter 5, “Menu Orientation” on page 61.
Encore GC and ECU  •  User’s Guide 43



4.  Getting Started
Overview
lîÉêîáÉï
To get started learning the Encore GC system, here is an overview of the steps that you will 
perform in the following sections.  Links are provided to each individual sequence.  

1. “ID Setup and System Power-up,” page 45.

2. “Installing Encore GC Software,” page 46.

3. “Launching the Encore GC Application,” page 50.

4. “Updating ECU and Processor Software,” page 52.

5. “Resetting Software,” page 54.

6. “Destination Setup,” page 55.

7. “Router and DA Setup,” page 57.

8. “Saving the System Configuration,” page 60.  

Important For the optimum setup, it is recommended that you follow all 
procedures in the order outlined below.

Important In the following sections, descriptions of the tabs are very 
brief.  All tabs will be fully explained in Chapter 5, “Menu 
Orientation” on page 61.
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Encore GC startup:  Step 1.

This section provides instructions for setting up individual Encore VP and VPx IDs and 
powering up your Encore GC and ECU system.  If ScreenPRO-II units are used as 
destinations, you will also set their IDs and enable remote control.  Each unit in your 
system must have a unique ID.

Use the following steps to set IDs and start up your system:

1. Ensure that all Encore equipment is properly cabled, including VP and VPx units, 
routers, and program and preview monitors.  In Chapter 3, refer to the 
“Installation” section on page 35 for instructions. 

2. Ensure that all Encore equipment, the ECU and your laptop (or PC) are properly 
connected to an Ethernet Switch.  This is the required “closed network.”

3. To set Encore VP and VPx IDs:

a. Using the Unit ID Selector on the rear of each processor, set the desired 
ID.  Logical IDs 1 - 16 are available on the selector.    

b. Repeat step 3 for all other VP and VPx processors in your system.

4. Turn on power to the VP(s), VPx(s), Ethernet Switch, monitors, routers, PC (or 
laptop) and all additional peripheral equipment.

5. To set ScreenPRO-II IDs and enable remote control:

a. Ensure that the ScreenPRO-II units are connected to the same Ethernet 
Switch as the Video Processor(s).

b. Press {REMOTE CONTROL} on the Home Menu to access the Remote 
Control Menu.

c. Scroll to the Unit ID line, and select a unique ID.  The ID range is 1 to 32.

d. Scroll to the Remote Control/DHCP line, and enable remote control.  

e. Press {SAVE} to save the system state in non-volatile memory.

f. Repeat step 5 for all other ScreenPRO-II units in your system.

6. Once your PC boots up, ensure that it is configured to obtain an IP address 
automatically.  Consult with your facility’s Network Administrator for details.  

7. On the ECU, turn on the Main Power Switch on the rear panel.  Then, press the 
CPU Power Switch on the front panel.  After a few moments, when the HDD LED 
on the front panel stops blinking, the system is ready to be used.

8. Please continue with the “Installing Encore GC Software” section on page 46.

1

Tip You may wish to complete a set of system connection charts.  
In Chapter 3 of the Encore Presentation System User’s 
Guide, refer to the “Connection Charts” section for details.

Note Remember that the ECU is a DHCP server. 
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Encore GC startup:  Step 2.

This section provides instructions for installing (or updating) Encore GC software. 

Use the following steps to install or update Encore GC software.

1. Please note the following important preliminary steps:

~ If this is a “first time” software installation, insert the supplied Encore GC 
CD-ROM into your PC or laptop.   Navigate to My Computer, open up 
the Encore GC CD-ROM, and then double-click the 
EncoreGCInstall.exe file. 

~ If this is a re-install or a software update, uninstall the previous version of 
Encore GC software.  

Next, locate the downloaded EncoreGCInstall.exe file (or insert the new 
Encore GC CD-ROM), and run the file. 

Once the installer launches, the figure below illustrates the “Introduction” screen, 
which outlines each of the installation steps.

Figure 4-1.  Installer Introduction screen  

2. Quit all open programs as requested, and click Next to display the “Choose 
Install Folder” screen.

2
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3. The figure below illustrates the “Choose Install Folder” screen:

Figure 4-2.  Choose Install Folder screen

Use the default installation folder (recommended), or click Choose to select a 
different folder.  

4. Click Next to display the Choose Shortcut Folder screen:

Figure 4-3.  Choose Shortcut Folder screen

Select the desired location where you would like to create an Encore GC shortcut.  
All radio buttons are mutually exclusive.  In addition, if you want to create icons for 
all users, check the “Create Icons for All Users” check box.  
Encore GC and ECU  •  User’s Guide 47



4.  Getting Started
Installing Encore GC Software
5. Once you have made your selection, click Next to display the Pre-Installation 
Summary screen:

Figure 4-4.  Pre-Installation Summary screen

Review all information on screen.  If you wish to revise any of your choices, click 
Previous to return to the appropriate screen.  

6. After reviewing all information, click Install to begin Encore GC installation.  The 
Installing Encore GC screen appears.

Figure 4-5.  Installing Encore GC screen
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Once the installation is complete, the Install Complete screen appears.

Figure 4-6.  Install Complete screen

7. Click Done to complete the procedure, and exit the installer.

8. Please continue with the “Launching the Encore GC Application” section on 
page 50.
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Encore GC startup:  Step 3.

Use the following steps to launch the Encore GC application and connect to the ECU:

1. Click the Encore GC shortcut on the desktop (or in the Quick Launch Bar), or, if 
you selected this option during installation, click Start > Programs > Barco > 
Encore GC > Encore GC.  

Figure 4-7.  Encore GC Program File Location

The Encore GC Splash Screen appears briefly, after which the System Tab 
appears.  By default, the Discovery Dialog automatically appears.   

Figure 4-8.  Discovery Dialog  (sample)

2. The Discovery Dialog initiates the ECU connection process.  Please note:

~ The Show Only ECU’s check box will be grayed out if only ECU devices 
have been discovered.  To continue, click the drop-down arrow and 
select the ECU to which you want to connect.  Continue with step 3.

~ If the Show Only ECU label is active and the check box is unchecked, 
the system has discovered both ECU and non-ECU devices (e.g., Barco 
projectors) on the closed network.  In this case, check the box to filter the 
list for ECUs only, click the drop-down arrow and select the ECU to which 
you want to connect, and continue with step 3.

3

Note If the dialog does not appear, re-check your Ethernet 
connections, then click Discover ECU in the System Tab.
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~ If a red “No devices found” message appears, close the Discovery 
Dialog, re-check your Ethernet connections, and then click Discover 
ECU in the System Tab.

Figure 4-9.  Error message:  No devices found

3. Click Connect to display a brief connection status window.  After the connection 
interval is complete, the System Tab populates with the selected ECU and all 
video processors that have been discovered.  

4. In the ECU section of the tab, if the ECU line is colored pink, a software update is 
required.    

Figure 4-10.  System Tab, ECU section  (sample)

To update software, refer to the “Updating ECU and Processor 
Software” section on page 52 for instructions.  

~ If ECU software is current, please continue with step 5 below.

5. On the System Tab, check the Processors section to ensure that all of your 
video processors are listed, with the correct number of M/Es.  If any are not listed, 
check all Ethernet connections, then click Refresh to update the entire tab.  

6. Check the Processors section for any pink colored lines and specifically, any 
labels in the “Issues” column such as Checksum Mismatch.  

Figure 4-11.  System Tab, Processors section  (sample)

~ If the Checksum Mismatch label appears, the current version of video 
processor software does not match the installed version of processor 
software, and an update is required.  Refer to the “Updating ECU and 
Processor Software” section on page 52 for instructions.  

~ If processor software is current, please continue with step 7 below.

7. With ECU and processor software updated, please continue with the “Resetting 
Software” section on page 54.

Important If the Encore GC does not detect any valid video processors, 
you will not be able to set up your destination(s). 
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Encore GC startup:  Step 4.

Because Encore GC software acts as the “master” software version in an Encore GC and 
ECU system, this section provides instructions for updating ECU and video processor 
software to match that of Encore GC.  The following topics are discussed:

• Updating ECU Software

• Updating Processor Software

réÇ~íáåÖ=b`r=pçÑíï~êÉ
On the System Tab, in the ECU section, if the ECU line is colored pink, the ECU software 
must be updated.  

Use the following steps to update ECU software:

1. In the System Tab, click Update SW to display the Software Update Window.  In 
the left-hand section are device selection controls, plus a table that lists the 
software versions of all “discovered” processors (including VP, VPx and 
ScreenPRO-II).  In the right-hand section, a status box is provided.

2. In the Device Selection section, click the ECU radio button.

Figure 4-12.  Software Update Window  (sample)

3. Click Start Software Update to begin updating the ECU.  During the update 
procedure, software files are transferred from Encore GC to the ECU, and all 
actions are reported in the Status box.  

4. At the conclusion of the procedure, you will be asked if you want to reconnect.  
Click Connect to continue.  

5. When all tables in the System Tab have re-populated, check the ECU SW 
Version column in the ECU section to ensure that versions match.

6. Return to the “Launching the Encore GC Application” section on page 50, and 
continue the startup procedure from the point at which you left off.

4
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If the Checksum Mismatch label appears (as indicated in the “Issues” column in the 
Processors section on the System Tab), the current version of software in the processor 
does not match the version installed in the ECU, and processor software must be updated.  

Use the following steps to update processor software:

1. In the System Tab, click Update SW to display the Software Update Window.  In 
the left-hand section, the window displays device selection controls, plus a table 
that lists the software versions of all “discovered” processors (including VP, VPx 
and ScreenPRO-II).  In the right-hand section, a status box is provided.

2. In the Device Selection section, click the Processors radio button.

Figure 4-13.  Software Update Window  (sample)

3. In the Processors Download Type section, choose the desired option:

~ Click Download if a software mismatch is present.

~ Click Force Download to update processor software, whether or not a 
mismatch is present.

4. Click Start Software Update to begin updating the selected processors.  During 
the update procedure, software files are transferred from the ECU to the 
processors, and all program and preview output video from the processors 
switches to black.  

At the conclusion of the procedure, program and preview video from the selected 
processor(s) is restored.  

5. Close the Software Update Window.

6. When all tables in the System Tab have re-populated, check the “Issues” column 
in the Processors section to ensure that all versions match.

7. Return to the “Launching the Encore GC Application” section on page 50, and 
continue the startup procedure from the point at which you left off.

Note This procedure can take several minutes.
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Encore GC startup:  Step 5.

This procedure enables you to reset the ECU and all video processors to their factory 
default settings.

Use the following steps to reset the system to factory default settings:

1. In the System Tab, click Reset to display the Reset Window.

Figure 4-14.  Reset Window

2. In the Device Selection section, click All Devices.

3. In the Reset Type section, click Factory Defaults.   

4. Click Reset.  A warning dialog will be displayed.  

5. Click Yes to continue. This action causes the ECU to reset and disconnect from 
the Encore GC system. 

6. At the conclusion of the procedure, you will be asked if you want to reconnect.  
Click Connect to continue.  

7. Please continue with the “Destination Setup” section on page 55.

5
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Encore GC startup:  Step 6.

This procedure enables you to set up your system’s destinations.  Please note that this is 
an abbreviated procedure, designed to get you to the “learning” stage in Encore GC as 
quickly as possible.  In Chapter 6, complete destination setup steps are provided in the 
“Destination Setup” section on page 146.  

Use the following steps to set up destinations.  

1. Click the Destination Setup Tab.  At first startup, the left-hand Destination Table 
is completely empty.

Figure 4-15.  Destination Setup Tab at startup

2. In the Destination Table, click the row for the destination number that you wish to 
set up.  Any row can be selected.  

3. In the right-hand Destination Settings Section, enter a name for the new 
destination in the Name field, if desired.  Otherwise, use the default name 
provided by the system (e.g., Dest 1, Dest 2, etc.).

4. Click the Type drop-down menu to choose the type of destination.  The 
destination choices are:

~ Single Screen VP

~ Single Screen SP

~ Wide Screen VP

6

Note The procedure can also be used to add destinations to your 
Encore GC system.
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5. Click the “+” adjacent to the Processor Selection heading to expand the section.  

Figure 4-16.  Destinations Settings - Processor Selection Section  (sample)

6. To add processor(s) to the destination, highlight the desired processor(s) in the 
Available column, and then click << to transfer the processor(s) to the Added 
(Master) column.

7. Click Apply All at the top of the Destination Settings Section to enter all 
changes, and send the parameters to the ECU.  

8. Repeat the procedure from step 2 to add additional destinations, provided that 
video processors are available.   

9. Please continue with the “Router and DA Setup” section on page 57.

Note Once you click Apply All, the Destination Table fills in with 
the new destination.  In addition, a new tab appears for the 
newly created destination (to the left of the System Tab) — 
indicating that a valid destination is now available.

Note Remember that this is an abbreviated destination setup 
procedure.  In Chapter 6, complete destination setup steps 
are provided in the “Destination Setup” section on page 146.
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Encore GC startup:  Step 7.

This procedure enables you to set up your system’s routers and DAs.  Up to eight routers 
can be configured.  These steps must be followed precisely, so that all routers will be 
properly recognized on the System Tab. 

The following topics are discussed:

• Router Setup

• DA Setup

• Checking Router Status

oçìíÉê=pÉíìé
Use the following steps to set up routers.  

1. Click the Routers Tab.  At first startup, the left-hand Router Table is empty.

Figure 4-17.  Routers Tab at startup

2. Click any blank line in the Router Table.  

3. In the right-hand Router Data Section, click the Router Radio Button.

4. In the Name field, enter a name for the router, if desired.

5. Use the Signal Type drop-down menu to choose the router’s signal type — either 
analog, DVI or SDI. 

6. Use the # of Inputs field to list the size of the router’s input matrix.

7. Use the # of Outputs field to list the size of the router’s output matrix.

8. Use the Manufacturer drop-down menu to choose the manufacturer.

7

Note The line that you select also increments the router’s 
associated Ethernet Address.
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9. Use the Communication Type drop-down menu to select the router’s 
communication type, either Ethernet or Lantronix.  

10. If Ethernet is selected, enter the router’s IP address (and port, if applicable) in the 
Communication Setup section.

11. If Lantronix is selected, the Communication Setup section changes to display 
Lantronix-specific information:

~ Use the Device drop-down menu to choose the specific Lantronix device 
that is connected to Encore GC’s closed Ethernet network.

~ Use the Channel selector to specify the Lantronix serial channel (either 
1 or 2) that is connected to the router. 

~ Use the Baud Rate drop-down menu to match the baud rate of the router 
connected to the Lantronix.

~ In the Data Bits section, specify the number of data bits. 

~ In the Stop Bits section, specify the number of stop bits. 

~ In the Parity section, specify the type of router parity. 

12. When all fields have been entered for the router, click the Apply button (at the top 
of the section) to apply all new data.  The Router Table updates with the new 
information, and the new data is sent to the ECU.  

13. Repeat steps 2 through 12 to configure the next router.  

14. Please continue with the “Checking Router Status” section on page 59.
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Use the following steps to set up DAs.  

1. Click any blank line in the Router Table. 

2. In the right-hand Router Data Section, click the DA Radio Button.  

3. Use the Name field to enter a user-specified name for the DA.

4. Use the Signal Type drop-down menu to choose the DA’s signal type. 

5. For DAs, the # of Inputs is fixed at one.

6. Use the # of Outputs field to list the number of DA outputs.

7. When all fields have been entered, click the Apply button (at the top of the 
section) to apply all new data.  The Router Table updates with the new 
information, and the new data is sent to the ECU.  

8. Repeat steps 1 through 7 to configure the next DA.   

9. Please continue with the “Checking Router Status” section on page 59.
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Use the following steps to check router status, and to test router communications if 
required. 

1. Click the System Tab, and then click Refresh to update the entire table. 

2. Check the Routers section to ensure that all routers and DAs are properly listed.  

3. Under the Status column, if the label “Connected” does not appear for a router, 
right-click the router in question to display the Test Router Comm Button. 

Figure 4-18.  Test Router Comm Button

4. Click the Test Router Comm Button to display the Testing Comm Window, 
which tests communications with the selected router.

Figure 4-19.  Testing Comm Window  (sample)

5. Click OK to close the Testing Comm Window.

6. Click Refresh.  The router should now appear connected.

7. Repeat steps 3 through 6 for each router that does not appear connected.  If 
connection problems persist, re-check all Ethernet connections to the router(s), 
verify all entries on the Routers Tab, and repeat from step 1. 

8. Please continue with the “Saving the System Configuration” section on 
page 60.

Note Router status can also be checked on the Routers Tab, using 
the same method.
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This procedure enables you to save the current Encore GC configuration in the ECU, so 
that you can shut down and power-up again with the identical system setup. 

Use the following steps to save the system configuration: 

1. In the Menu Bar, click ECU > Save Configuration.  This action saves the 
configuration of equipment, all setup parameters, and all of the Presets that you 
have created.

qç=`çåíáåìÉ
At this point, your system has a connected ECU, valid destinations, and connected DAs 
and routers — and is “ready” to the point that you can fully learn all tabs and menus.  Note 
that inputs and router outputs are not patched yet.  

To continue, please refer to Chapter 5, “Menu Orientation” on page 61 for a complete 
review of all Encore GC menus.

póëíÉã=pÜìíÇçïå
As required, use the following steps to shut down the Encore GC application:

1. Ensure that you have saved the system configuration.  

2. In the Menu Bar, click File > Exit to quit the application.

3. On the ECU, press the CPU Power Switch on the front panel.  After a few 
moments, when the POWER LED on the front panel turns off, the system is shut 
down.  If desired, turn off the Main Power Switch on the rear panel.  

4. Turn off all peripheral equipment, including your laptop (or PC), the VP(s), VPx(s), 
the Ethernet Switch, monitors, routers, etc.
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This chapter describes all Encore GC menus and tabs, including how they are accessed 
and the functions that are available.  Before you start using the Encore GC system for your 
next event, it is recommended that you review this section completely. 

The following topics are discussed:

• GUI Overview

• Menu Bar

• System Tab

• Destination Setup Tab

• Routers Tab

• Output Patch Tab

• Sources Tab

• Stills Tab

• Destination Control Tabs

• Multiple Destinations Tab

• Demo Mode

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 6, “System Setup” on 
page 143.
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The Encore GC consists of a Menu Bar plus Tabs that enable you to set up your system’s 
routers, patches, destinations, sources and your presentation’s overall “look.”  The figure 
below illustrates the layout when Encore GC is on line and connected to VPs.

Figure 5-1.  Encore GC layout

• Use the Menu Bar for quick access to important Encore GC functions.  Refer to 
the “Menu Bar” section on page 63 for details.

• Select a Destination Control Tab to configure the “look” on your screen(s), 
including all PIP and Key effects, image placement and source selection.  Refer to 
the “Destination Control Tabs” section on page 100 for details.

• Select the System Tab to detect and identify your ECU(s), Processor(s), 
Router(s) and Lantronix devices.  This tab also enables you to update software 
and reset devices.  Refer to the “System Tab” section on page 71 for details.  

• Select the Destination Setup Tab to set up each of your destination’s 
parameters, including destination type (e.g., single screen, wide screen), output 
settings, test patterns, EDID settings and processor selection.  Refer to the 
“Destination Setup Tab” section on page 76 for details.

• Select the Routers Tab to set up each of your system’s routers, including name, 
manufacturer, signal type, matrix size, communication type and IP address.  Refer 
to the “Routers Tab” section on page 86 for details.

• Select the Output Patch Tab to patch router outputs to various video processor 
inputs.  Refer to the “Output Patch Tab” section on page 91 for details.

• Select the Sources Tab to set up all inputs, either via router or direct connection 
to the processor(s).  Selections on this tab directly determine the active inputs on 
the Destination Control Tab(s).  Refer to the “Sources Tab” section on page 93.

• Select the Stills Tab to name, save, recall, erase and delete still frames.  Refer to 
the “Stills Tab” section on page 97 for details.

• If two or more destinations are configured, select the Multiple Destinations Tab 
to configure multiple destination Presets.  

Figure 5-2.  Multiple Destinations Tab

Refer to the “Multiple Destinations Tab” section on page 139 for details.

The Menu Bar and all Tabs are discussed in the following sections. 

Note If the system does not detect any valid video processors, no 
Destination Control Tabs will appear. 
62 Encore GC and ECU  •  User’s Guide



5.  Menu Orientation
Menu Bar
jÉåì=_~ê
The Menu Bar provides quick access to important Encore GC functions.  There are three 
ways to use the menus:

• Click a menu item directly.

• Press ALT (on your keyboard), then use the keyboard’s arrow keys to navigate.

• Use “CTRL” shortcut combinations as listed in the menus (e.g.,  CTRL + E).

The Menu Bar changes form, depending on which tabs are selected. 

• Menu Bar Form 1

• Menu Bar Form 2

jÉåì=_~ê=cçêã=N
When the System, Routers, Output Patch, Destination Setup and Sources tabs are 
selected, the Menu Bar takes the following form:

Figure 5-3.  Menu Bar  (form 1)

• The New, Open, Save, Save As, and Close functions are currently not 
implemented.

• Click File to display the File Menu:

Figure 5-4.  File Menu

~ Click Offline to use Encore GC in an offline mode.  When selected, 
Encore GC is disconnected from the ECU, processors and routers.  To 
reconnect all devices, click Connect on the System Tab. 
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~ When the system is offline, the Load Demo Cfg function appears in the 
File Menu:

Figure 5-5.  File Menu in Offline mode

Click Load Demo Cfg to load a demonstration version of Encore GC.  
Refer to the “Demo Mode” section on page 141 for more information.  To 
exit the  mode, click Connect on the System Tab. 

~ Click Exit to exit the Encore GC application.  Ensure that you have 
performed a “System Save” prior to exiting.

• Click Presets to display the Presets Menu:

Figure 5-6.  Presets menu

~ Click Preset Recall Options to display the Preset Recall Options 
Dialog.

Figure 5-7.  Preset Recall Options Dialog

When recalling Presets, this dialog provides three options that determine 
which portions of the stored Preset data is recalled.  Any combination of 
options can be enabled:

• Check Background to include background sources in the 
recall.  If un-checked, current backgrounds will be retained.  

• Check DSK to include the DSK sources in the recall operation.  
If un-checked, the current DSK sources will be retained.  

• Check Border to include stored border parameters in the recall.  
If un-checked, current border parameters are retained.  
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• Click ECU to display the ECU Menu:

Figure 5-8.  System Menu

~ Click Save Configuration to save the current Encore GC configuration 
in the ECU, enabling you to shut down and power-up with the identical 
configuration.  If you change your system configuration in any way, 
always click Save Configuration prior to exiting the application.

~ Click Backup Configuration to back the current configuration up to a 
local or offline storage device (e.g., a thumb drive).

~ Click Restore Configuration restore a configuration from a local or 
offline storage device back to the system.

~ Click Get Logs to save ECU system logs.  The Save Remote Log Files 
dialog appears, in which you can select a location to save the logs.  This 
feature is designed for technical support use only.  Once you specify a 
location, a Log Files Transfer Status Window confirms the procedure.

In Chapter 7, refer to the “Backing Up and Restoring Configurations” section 
on page 189 for backup and restore instructions.

• Click Help to display the Help Menu:

Figure 5-9.  Help Menu

~ Click About Encore GC to display the About Encore GC Dialog.

Figure 5-10.  About Encore GC Dialog

The dialog lists the current software version, the Barco website and the 
technical support email address.  Click OK to close the dialog.
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When a Destination Control Tab is selected, the Menu Bar takes the following form:

Figure 5-11.  Menu Bar  (form 2) 

• The File, Presets, ECU and Help menus are identical to those in “Form 1.”  Refer 
to the “Menu Bar Form 1” section on page 63 for details.

• Click View to display the View Menu.  

Figure 5-12.  View Menu  (sample)

Note Different sets of icons are active or grayed out, based on 
which PIP(s) are selected in the Palette (your work surface in 
the Destination Control Tabs).  In the sample above, all 
icons are active for discussion purposes only.
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~ Click Preview to view only the destination’s preview output in the Palette 
(for the selected destination).

~ Click Program to view only the destinations’s program output in the 
Palette.

~ Click Preview and Program to create a split screen in the Palette, with 
the program output above and the preview output below.

The following three menu items control your “view” of the Palette:

~ Click Zoom In to zoom the view closer to PIPs on the Palette.

~ Click Zoom Out to zoom the view farther away from PIPs.

~ Click Show All to adjust the view to ensure that the entire destination 
screen is visible on the Palette.

In the next section, the first four menu items are only enabled when a PIP is 
selected.  Background Properties can be selected at any time.

~ Click Border Properties to display the Border Properties Dialog, 
which allows you to manipulate PIP borders, styles and colors.  This 
dialog can also be accessed by right-clicking a PIP, and selecting Border 
Properties in the pop-up.  Refer to the “Border Properties Dialog” 
section on page 111 for details.

~ Click Shadow Properties to display the Shadow Properties Dialog, 
which allows you to manipulate the size, position and transparency of the 
shadow.  This dialog can also be accessed by right-clicking a PIP, and 
selecting Shadow Properties in the pop-up.  Refer to the “Shadow 
Properties Dialog” section on page 112 for details.

~ Click Key Properties to display the Key Properties Dialog, which 
allows you to adjust key parameters.  This dialog can also be accessed 
by right-clicking a PIP, and selecting Key Properties in the pop-up.  See 
the “Key Properties Dialog” section on page 113 for details.

~ Click Input Properties to display the Input Properties Dialog, which 
allows you to adjust all input parameters.  This dialog can also be 
accessed by right-clicking a PIP, and selecting Input Properties in the 
pop-up.  See the “Input Properties Dialog” section on page 114.

~ Click Background Properties to display the Background Properties 
Dialog, which allows you to adjust background video parameters.  A 
background must be enabled in the Palette first.  This dialog can also be 
accessed by right-clicking the background layer and selecting the 
Background Properties Pop-up.  Refer to the “Background 
Properties Dialog” section on page 118 for details.

The following six menu items are only enabled when two or more PIPs are 
selected simultaneously (using the standard SHIFT + click technique).  If only one 
PIP is selected, the items are grayed out.

~ Click Align Bottom to align the bottom edges of all selected PIPs.

~ Click Align Top to align the top edges of all selected PIPs.

~ Click Align Left to align the left edges of all selected PIPs. 

~ Click Align Right to align the right edges of all selected PIPs.

~ Click Align Centers Vertically to align the vertical axes of all selected 
PIPs.
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~ Click Align Centers Horizontally to align the horizontal axes of all 
selected PIPs.  

The following three menu items are only enabled when one (or more) PIPs are 
selected in the Palette.  If the background is clicked, the items are grayed out.  
Note that if two or more PIPs are selected, the PIP selected first is the master for 
the selected function.  

~ Click Center Horizontally to center all selected PIPs horizontally, along 
the destinations’s vertical axis.  PIPs do not change vertical position.

~ Click Center Vertically to center all selected PIPs vertically, along the 
destination’s horizontal axis.  PIPs do not change horizontal position.

~ Click Center to center all selected PIPs vertically and horizontally, along 
the destination’s horizontal and vertical axes.  

The following two menu items are only enabled when one (or more) PIPs are 
selected in the Palette.  If the background is clicked, the items are grayed out.

~ Click Full Screen Vertical to take the selected PIP(s) to full screen, 
using the source’s height as the guide.  If borders are on, they will be 
taken into account so that they are visible. 

~ Click Full Screen Horizontal to take the selected PIP(s) to full screen, 
using the source’s width as the guide.  If borders are on, they will be 
taken into account.

The last three menu items are only enabled when two (or more) PIPs are selected 
in the Palette.  If the background is clicked, or if only one PIP is selected, the items 
are grayed out.  Note that if two or more PIPs are selected, the PIP selected first is 
the master for the selected function. 

~ Click Make Same Size to make the second (and subsequent) PIPs that 
you select the same size as the first selected PIP.

~ Click Make Same Width to make the second (and subsequent) PIPs that 
you select the same width as the first selected PIP.

~ Click Make Same Height to make the second (and subsequent) PIPs 
that you select the same height as the first selected PIP.

• Click Layers to display the Layers Menu. 

Figure 5-13.  Layers Menu

~ Click Selected PIP to display the Selected PIP Menu.  Please note:

• If a PIP is not selected in the Palette, you will be prompted to 
select one.

Note In each case, the PIP selected first is the master for the 
selected function.  For example, given two PIPs in the 
Palette, one screen left and one screen right, you can align to 
either one — provided that you click it first, and then SHIFT + 
click the second PIP. 
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• If two (or more) PIPs are selected in the Palette, all menu items 
will be grayed out. 

• If only one PIP is selected in the Palette, the menu is active.

The figure below illustrates the Selected PIP Menu:

Figure 5-14.  Selected PIP Menu

• Click Border Properties to display the Border Properties 
Dialog.  Refer to the “Border Properties Dialog” section on 
page 111 for details.

• Click Shadow Properties to display the Shadow Properties 
Dialog.  Refer to the “Shadow Properties Dialog” section on 
page 112 for details.

• Click Key Properties to display the Key Properties Dialog.  
Refer to the “Key Properties Dialog” section on page 113.

• Click Input Properties to display the Input Properties Dialog.  
Refer to the “Input Properties Dialog” section on page 114.

• Check (or uncheck) Lock Aspect Ratio to lock or unlock the 
PIP’s aspect ratio.  The checkmark indicates “locked.”  When 
locked, a PIP’s H and V size tracks proportionally.  When 
unlocked, H and V size can be adjusted individually.

The figure below illustrates the Crop Menu:

Figure 5-15.  Crop Mode Menu

~ Check Crop Enabled to crop the edges of a PIP.  When enabled, several 
Crop Mode functions are available:

• Enable Crop.  Place your cursor over the edge of a PIP, and 
then click and drag to crop the image.

• In Crop mode, place your cursor over the inside of the image, 
and then click and drag to move the image around — inside the 
cropped region.

• In Crop mode, place your cursor over the inside of the image 
hold down CTRL, and then click and drag to move the cropped 
region around the Palette, leaving the image in place.
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• Enable Resize to move the cropped image around the Palette, 
or resize the cropped image by clicking and dragging an edge.  

~ Click Background Properties to display the Background Properties 
Dialog.  Refer to the “Background Properties Dialog” section on 
page 118 for details.

~ Click DSK Properties to display the DSK Properties Dialog.  Refer to 
the “DSK Properties Dialog” section on page 124 for details.

Note If you un-check Crop Enabled, the image returns to full size, 
and all cropped edges are cleared.
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The System Tab enables you to detect and identify your ECU(s), Processor(s), Router(s) 
and Lantronix devices.  This tab also enables you to update software and reset various 
devices.  The figure below illustrates the System Tab.  

Figure 5-16.  System Tab  (sample)

The tab is divided into five sections:

• Functions Section

• ECU Section

• Processors Section

• Routers Section

• Lantronix Section

Note Within the tables in each section, you can change the order of 
the columns by clicking and dragging a column heading to a 
new location.
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At the top of the System Tab, three buttons are provided:

• Click Refresh to re-synchronize the active Encore GC configuration with the ECU.  
Use this function in case a device is not recognized, or if another device is 
connected.  All tables will be re-populated.

• Click Update SW to display the Software Update Window.  Because the Encore 
GC software acts as the “master” software version in an Encore GC system, this 
function enables you to update ECU and video processor software to match that 
of the Encore GC.  In Chapter 4, refer to the “System Shutdown” section on 
page 60 for details. 

• Click Reset to display the Reset Window.  A software reset is recommended, for 
example, after the Encore GC system has returned from an event or other 
presentation.  In Chapter 7, see the “Resetting Software” section on page 182.  

b`r=pÉÅíáçå
The figure below illustrates the ECU Section on the System Tab:

Figure 5-17.  System Tab - ECU Section  (sample)

In the table, the following information is provided:

• The Name column lists the ECU that is connected to the Encore GC.  

• The ECU Connection Address column lists the ECU’s IP address.

• The IP Address 2 column is provided for future use. 

• The ECU SW Version column lists the version of the connected ECU.

The following functions are provided in the ECU Section:

• Click Discover ECU to initiate the procedure whereby Encore GC searches the 
local network for available ECU(s).  The Discovery Dialog appears:

Figure 5-18.  Discovery Dialog  (sample)

Please note the following important points:

~ The Show Only ECUs check box will be grayed out if only ECUs have 
been discovered.
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~ If a red error message appears (e.g., No devices found), close the 
dialog, re-check your Ethernet connections, then click Discover ECU in 
the System Tab.

Figure 5-19.  Error message:  No devices found

~ If the Show Only ECUs label is active and the check box is unchecked, 
the system has discovered both ECU and non-ECU devices on the 
network (e.g., Barco projectors).  In this case, check the box to filter the 
list for ECUs only.

Use the drop-down menu and select the single ECU to which you want to connect.  
Click Connect to display a status window, which appears briefly while all devices 
are being discovered.  Once the procedure is complete, all tables on the System 
Tab will be repopulated.

• Click Disconnect to disconnect the Encore GC from the ECU.  In this mode, the 
system is offline.  Once disconnected, all tables on the System Tab are cleared.  

mêçÅÉëëçêë=pÉÅíáçå
The figure below illustrates the Processors Section on the System Tab:

Figure 5-20.  System Tab - Processors Section  (sample)

The table in the Processors Section lists all VP(s) discovered and/or configured by the 
system, including ScreenPRO-IIs, VPs and VPxs.  The following information is provided:

• The ID column lists the VP’s physical ID, as set with the ID Selector Switch on 
the rear of each VP.

• The Type column lists the type of VP (e.g., VP, ScreenPRO-II).

• The IP Address column lists each processor’s IP address.

• The ME Count column lists the number of ME’s (Mix Effects banks) within the 
video processor.

• The Features column lists optional features installed in the processor (e.g., the 
EOC option on ScreenPRO-II).

• The SW Version column lists the software version that the processor is currently 
running.

• The Issues column lists any problems present in the processor.  For example, if 
the Checksum Mismatch label appears in the column, the current version of 
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Encore GC software does not match the installed version of video processor 
software, and an update is required.  

Figure 5-21.  Checksum mismatch  (sample)

If any issues are present, the specific processor row (in the table) will be colored 
pink, as shown in the sample above.  In this condition, it is recommended that you 
update your processor software.  In Chapter 4, refer to the “System Shutdown” 
section on page 60 for details. 

• The Status column lists the current status of the processor (e.g., Connected).    

If the Status column is blank and a specific processor row in the table is yellow, 
the processor is configured but not connected.  

Figure 5-22.  Disconnected processor  (sample)

In this situation, check your Ethernet cables, connections and the Switch, and 
then click Refresh.

oçìíÉêë=pÉÅíáçå
The figure below illustrates the Routers Section on the System Tab:

Figure 5-23.  System Tab - Routers Section  (sample)

The table in the Routers Section lists all routing switchers discovered and/or configured by 
the system, including Barco routers and those made by other manufacturers.  The following 
information is provided:

• The ID column lists a unique system-assigned ID number to the router.

• The Router Name column lists the user name, as entered on the Routers Tab.

• The Router Type column lists the manufacturer (e.g., Barco, Extron, Sierra, etc.).

• The Signal Type column lists the router’s signal type (e.g., Analog, SDI, DVI).

• The Status column lists the current status of the router (e.g., Connected.)

Note If the system does not detect any valid video processors, you 
will not be able to configure destinations.   
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Please note the following important points:

• If a router does not appear “connected” after it is assigned on the Routers Tab, 
right-click the router in question to display the Test Router Comm Button.

Figure 5-24.  Test Router Comm Button

Click the Test Router Comm Button to display the Testing Comm Window, 
which tests communications with the selected router.

Figure 5-25.  Testing Comm Window  (sample)

When you click OK, the router should appear “connected.”  If connection 
problems persist, re-check all Ethernet connections to the router(s), verify all 
entries on the Routers Tab, and re-test communications.  

i~åíêçåáñ=pÉÅíáçå
The figure below illustrates the Lantronix Section on the System Tab:

Figure 5-26.  System Tab - Lantronix Section  (sample)

The table in the Lantronix Section lists all discovered Lantronix devices.  A Lantronix 
device is a third-party Ethernet-to-serial converter that enables you to control serial 
protocol routers via an Ethernet connection.  Devices such as the Lantronix model 
UDS100, UDS200 or UDS2100 can be successfully controlled, and each Lantronix device 
typically controls two serial routers.  For more information, visit http://www.lantronix.com.  

The following information is provided in the table:

• The Type column lists the specific type of Lantronix device (e.g., UDS100, 
UDS2100, etc.).

• The IP Address column lists the Lantronix device’s IP address.

• The MAC Address column lists the Lantronix device’s MAC address.

• The Channel Count column lists the number of serial channels which the 
Lantronix device controls.
Encore GC and ECU  •  User’s Guide 75

http://www.lantronix.com/


5.  Menu Orientation
Destination Setup Tab
aÉëíáå~íáçå=pÉíìé=q~Ä
The figure below illustrates the Destination Setup Tab:

Figure 5-27.  Destination Setup Tab  (sample)

The Destination Setup Tab is used to set up parameters for each of your destinations.  
Parameters include destination type (e.g., single screen, wide screen), output settings, test 
patterns, EDID settings and processor selection.  In the row of tabs, one Destination 
Control Tab appears for each destination configured on the Destination Setup Tab. 

The tab is divided in half:  

• On the left, the Destination Table lists parameters for up to 32 destinations.  
Refer to the “Destination Table” section on page 77 for details.

• On the right, the Destination Settings Section provides expandable sections 
that enable you to configure the specific settings for each destination.  Refer to the 
“Destination Settings Section” section on page 78 for details.

Note that you can resize the two sections by clicking and dragging the dividing bar.  
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The figure below illustrates a portion of the Destination Table.

Figure 5-28.  Destination Table  (sample)

The Destination Table lists the parameters for up to 32 destinations — one destination per 
row.  The columns in the table can be resized by clicking and dragging the boundary 
between headings, and you can change the order of the columns by clicking and dragging 
a column heading to a new location.

When you click on a destination row, its settings appear in the Destination Settings 
Section to the right, enabling you to enter new information, or modify existing information.

Descriptions of each column are provided below:

• The Number column lists the destination’s number, from 1 to 32.

• The Name column lists a user-specified name for the selected destination, as 
entered in the Name field in the Destination Settings Section.  Note that this 
name also appears on the tab itself, as shown in the example below:

Figure 5-29.  Tab label  (example)

• The Type column lists the specific type of destination (e.g., Single Screen or Wide 
Screen VP), as entered in the Type field in the Destination Settings Section.

• The Size column lists the size of the destination’s projector array, using the 
formula H (# horizontal projectors) x V (# vertical projectors).  

~ For a single screen VP, the array is always 1 x 1.

~ For a wide screen VP, the array size is set in the Widescreen Settings 
section — in the Destination Settings Section.

• The Processor ID(s) column lists the physical IDs of each processor, along with 
the number of processors assigned to the selected destination.

• The ME Count column lists the absolute number of M/Es available for use in the 
selected destination.  

• To delete a destination, click the desired row, and then press Delete on your 
keyboard.  You can also right-click the row and select Delete.
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The figure below illustrates the Destination Settings Section when a Single Screen VP 
destination is selected.

Figure 5-30.  Destination Settings Section  (sample)

The Destination Settings Section provides several expandable sections, within which you 
can configure the settings for each destination.  

• To expand a section, click the “+.”  

• To shrink a section, click the “-.”

The entire group of sections pertains to the selected destination row in the Destination 
Table.  Different sections appear and disappear, depending on the destination type:  

• If a wide screen VP is selected, the Widescreen Settings section appears.

• If a single screen SP is selected, the Routing Modes section appears.

• If a single screen VP destination is selected, the Widescreen Settings and 
Routing Modes sections are not shown.  

Information can only be entered for destinations that have a physical processor.  For 
example, if you only have one processor, you can not configure a second destination.  If 
you attempt to do so, an error message appears.

At the top of the section:

• The Destination Number field shows the destination that you are configuring, as 
selected in the Destination Table.

• The Name field enables you to enter a custom name for the selected destination.

• The Type drop-down menu enables you to choose the type of destination.  
Choices include Single Screen VP, Single Screen SP and Wide Screen VP. 

• Click Apply All to apply and save all changes, then in the Menu Bar, click ECU > 
Save Configuration.

The following sections are discussed below:

• Output Settings Section

• Test Patterns Section

• EDID Setting Section

• Processor Selection Section

• Widescreen Settings Section

• Routing Modes Section
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The figure below illustrates the Output Settings Section:

Figure 5-31.  Destinations Settings - Output Settings Section

The Output Settings Section enables you to set up the destination’s output parameters.  

• Format — sets the resolution and frame rate at which you want to drive your 
projector.  To minimize synchronization problems, select a frame rate that is 
consistent with your input sources.

If you are using 59.94 NTSC video inputs, run the output at the 
same rate in order to reduce jutter artifacts.  

• Gamma — sets the output gamma. 

• Raster Box Size — sets the size of the raster box that appears around PIPs and 
Keys.  

~ Adjustment range (in pixels):  0 to 8

• Color Space — sets the output’s color space to either RGB or YPbPr.

In the Output Monitor section, individual sync controls are provided for your Preview, 
Program 1 and Program 2 monitors.

• Sync — sets the sync value.  Choose between +H+V, -H-V, +H-V, -H+V or 
CSync. 

• SOG / Y — selects a specific “sync on green” signal.  Choose between Off, 
Standard or Tri-Level (for certain HD devices).  

In the Genlock section, select the type of analog genlock signal that is connected to the 
Processor’s Genlock connector. 

• Source — sets the genlock source, either Black Burst, CSync or None.

~ When Source = None, Type = Free-Run

~ When Source = Black Burst, Type = V Lock

~ When Source = CSync, Type = V Lock

Please note the following important points regarding genlock:

• PAL or NTSC black burst or composite sync signals are recommended.
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• In wide screen applications, all Processors must be locked together.  If you 
provide genlock to the first Processor in your configuration, genlock is 
automatically distributed to the other Processors via Program Link connections.

• If you do not use genlock in a wide screen application, Encore GC automatically 
makes the first Processor in your configuration the master.

• In single screen applications, each Processor requires its own genlock signal.

• Genlock is highly recommended in configurations that utilize camera sources. 

Once all changes have been entered in the Output Settings Section:

• Click Apply to enter all changes, and send the new parameters to the ECU.

• If required, prior to clicking Apply, click Undo to revert all changes in the section 
back to the last set of “applied” output parameters.

qÉëí=m~ííÉêåë=pÉÅíáçå
The figure below illustrates the Test Patterns Section:

Figure 5-32.  Destinations Settings - Test Patterns Section

The Test Patterns Section lets you control test patterns and raster boxes for a VP’s three 
outputs.  Controls are similar for each output:

• Raster Box — when enabled, the selected output displays a raster box defined by 
the exact outer edges of the output resolution.  

If the output is 1024 x 768, the raster box encapsulates that format.  

Please note:

~ The Burst test pattern is the only pattern that is smaller than the selected 
output resolution.  When the Raster Box is enabled, the Burst pattern 
will appear within its boundaries.  

~ The Raster Box can be enabled when the test pattern is Off.

• Test Pattern — use the drop-down menu to set the test pattern.  Changes do not 
occur until you click Apply.  Choose between the following patterns: 

~ H Ramp ~ Gray Steps 1

~ V Ramp ~ Gray Steps 2

~ 100% Color Bars ~ White

~ 16x16 Grid ~ Black

~ 32x32 Grid ~ Red

~ Burst ~ Green

~ 75% Color Bars ~ Blue

~ 50% Gray ~ Gray Bars
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In addition, when a wide screen destination is chosen, the following additional test 
patterns are available:

~ H Align ~ V Align

~ H and V Align

These three alignment test patterns are used for performing projector lens shift 
and registration adjustments.

• Click Apply to enable/disable all changes to the output(s), and send the new 
parameters to the ECU. 

• Click All Off to turn off all test patterns and raster boxes simultaneously.

bafa=pÉííáåÖ=pÉÅíáçå
The figure below illustrates the EDID Setting Section:

Figure 5-33.  Destinations Settings - EDID Setting Section

The EDID Setting Section enables you to update the system’s preferred EDID resolution 
for the processor’s DVI inputs — for the selected destination bus.  

Extended Display Identification Data (EDID) is a VESA standard data format that contains 
information about a display device and its resolution.  The system’s EDID file is stored in 
non-volatile memory.  This file is read by an external computer’s DVI graphic card when the 
computer’s DVI output is connected to a Video Processor via the DVI-I connector during 
boot-up.  The Processor must be powered on first for the EDID information to be read.  

The following functions are provided:

• Select Format — the drop-down menu selects the preferred DVI video format 
with which you want to program the system’s EDID non-volatile memory.

• Current Format — displays the current EDID video format in memory.

• Prior to clicking Apply, click Undo to return to the previously selected format.

• Click Apply to apply the new EDID format, and send the parameters to the ECU.  
When you click Apply, an alert is shown:

Figure 5-34.  EDID Change Format Alert

Note This function is designed for advanced users only.  Do not 
program EDID unless it is necessary.
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~ If required, click Cancel to stop the procedure without changing the 
current format.

~ To proceed, ensure that all DVI inputs to each VP are disconnected, then 
click OK to apply the new EDID format.

~ After a minute, when EDID programming is complete, re-connect DVI 
inputs to the VP, then reboot the external computer(s).

Please note that the Processor’s EDID PROM is not reset to any default during a factory 
reset.  To change the EDID, you must use the EDID Setting Section.

mêçÅÉëëçê=pÉäÉÅíáçå=pÉÅíáçå
The figure below illustrates the Processor Selection Section:

Figure 5-35.  Destinations Settings - Processor Selection Section

The Processor Selection Section enables you to add and remove Processors from the 
selected destination.  

• The Added column shows the Processors that are currently assigned to the 
destination, and which can also be removed.  In the table, Processors are 
identified by ID, and the Processor with the asterisk ( * ) is the master.

• The Available column shows the Processors that are available to be assigned to 
the destination.  If a Processor is currently assigned to another destination, it will 
not appear in the list.  Processors are identified by ID.

• Highlight a Processor in the Available column, then click << to add it to the 
destination.

• Highlight a Processor in the Added (Master) column, then click >> to remove it 
from the destination.

• Highlight a Processor in the Available column and a Processor in the Added 
(Master) column, then click << >> to swap their positions.

• If required, prior to clicking Apply, click Undo to revert all changes in the section 
back to the last set of “applied” parameters.

• Click Apply to enter all changes, and send the new parameters to the ECU.
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The figure below illustrates the Widescreen Settings Section:

Figure 5-36.  Destinations Settings - Widescreen Settings Section  (sample)

The Widescreen Settings Section enables you to define the parameters for widescreen 
destinations.  This section only appears when a widescreen destination is set up and 
selected in the Destination Table. 

• Processors — When two or more Processors are added to a destination, the size 
fields enable you to select any combination of the available units, and lay them out 
in a horizontal only, vertical only, or horizontal plus vertical array.  Fields are 
provided for H (horizontal) and V (vertical) array size.  At the right, the Projectors 
field indicates the total number of projectors used in the array.  This field is for 
information only.

• Total Horizontal Resolution — this field sets the total number of horizontal pixels 
in the overall wide screen display.  The formula is:

# screens * horizontal output resolution - 
(overlap width * (# screens - 1))

If two screens are used, each with an output resolution of 1024 x 768 and an 
overlap of 200 pixels, the Total H Res is: 

2 * 1024 - (200 * 1) = 1848

As you adjust the Total Horizontal Resolution, the Overlap value tracks and the 
wide screen markers (if enabled) adjust accordingly.  

• Total Vertical Resolution — This field displays the array’s vertical resolution.  In 
an array that is exclusively horizontal, this field is fixed. 

• Widescreen Markers — the radio buttons enable or disable the wide screen 
markers, which when enabled, show the boundaries of active data.  
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• Background — the radio buttons in this section select the method by which your 
background graphics were originally produced:

~ Edge-butted — choose this option if background graphics were 
produced without pre-data doubling (from a multi-head graphics card).

~ Overlapped — choose this option if backgrounds were produced using 
pre-data doubling (e.g., from a Dataton® Watchout system).

• Justification — sets the desired wide screen justification, either Center or Left.  
Once set, wide screen markers adjust accordingly.  

• Data Doubling — use the radio buttons to enable or disable data doubling.  
Typically, the function is only disabled when unscaled background sources are 
pre-data doubled.  In Chapter 3 of the Encore Presentation System User’s 
Guide, refer to the “Overview of Edge-Blending Technology” section for details.

• For a destination that includes a horizontal blend, the following adjustments can 
be made:

~ Horizontal Overlap — sets the horizontal overlap between projectors.  
As you adjust, the Total Horizontal Resolution value tracks, and wide 
screen markers adjust.  

~ Feather — the check box enables or disables edge feathering between 
projectors.  If the array does not include a horizontal blend, this function 
is grayed out.

~ Gamma — sets gamma for the feathered regions in a horizontal blend.  
If the array does not include a horizontal blend, this is grayed out.

• Adjustment range:  1.0 to 5.0

• For a destination that includes a vertical blend, the following adjustments can be 
made:

~ Vertical Overlap — sets the vertical overlap between projectors.  As you 
adjust, the Total Vertical Resolution value tracks.  

~ Feather — the check box enables or disables edge feathering between 
projectors.  If the array does not include a vertical blend, this function is 
grayed out.

~ Gamma — sets gamma for the feathered regions in a vertical blend.  If 
the array does not include a vertical blend, this is grayed out.

• Adjustment range:  1.0 to 5.0

• Test Links — For wide screen destinations only, click Test Links to test the 
program and source link cables that are required for wide screen operation.  This 
button only appears when a defined wide screen destination is active.  When 
clicked, you will be asked to confirm your selection. 

When the test is complete, Preview and Program outputs are fully restored and 
the test results are displayed.  If any cables fail, the complete connection list will 
be shown in the display for reference when troubleshooting the cable connections.

Note This test affects the Program output.
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The figure below illustrates the Routing Modes Section, which only appears when a 
single screen SP destination is set up and selected in the Destination Table.

Figure 5-37.  Routing Modes Section  (sample)

The Routing Modes Section defines the routing parameters for a single screen 
ScreenPRO-II destination.  The radio buttons set the routing mode for the ScreenPRO-II’s 
analog and SDI inputs — either Internal or External.  Your selection instructs the Encore 
GC on how sources are used on the ScreenPRO-II.

• The Analog Routing Mode line provides two mutually exclusive radio buttons, 
which affect the use of the ScreenPRO-II’s eight analog inputs.  

~ Select Internal to patch individual analog inputs to the ScreenPRO-II.  
On the Sources Tab, two patching options are available:

• Select SP2 as the connection type, then select inputs and 
processors in the normal manner.  

• Select All SP as the connection type, then select inputs only.  
This choice enables you to use the same input for all 
ScreenPRO-II’s, eliminating the need to select processors.  

~ Select External to patch an external analog router output to either 
analog input 1 or analog 2 on the ScreenPRO-II.  Use the Output Patch 
Tab for patching.

• The SDI Routing Mode line provides two mutually exclusive radio buttons, which 
affect the use of the ScreenPRO-II’s two SDI inputs.  Note that this line is only 
enabled if the ScreenPRO-II has SDI inputs.

~ Select Internal to patch individual SDI inputs to the ScreenPRO-II.  On 
the Sources Tab, two patching options are available:

• Select SP2 as the connection type, then select inputs and 
processors in the normal manner.  

• Select All SP as the connection type, then select inputs only.  
This choice enables you to use the same input for all 
ScreenPRO-II’s, eliminating the need to select processors.  

~ Select External to patch an external SDI router output to either SDI input 
1 or 2 on the ScreenPRO-II.  Use the Output Patch Tab for patching.

• If required, prior to clicking Apply, click Undo to revert all changes in the section 
back to the last set of “applied” parameters.

• Click Apply to enter all changes, and send the new parameters to the ECU.
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The Routers Tab is used to set up your system’s routers and DAs, including name, 
manufacturer, signal type, matrix size, communication type and IP address.  A maximum of 
eight routers can be controlled, either via Ethernet or Lantronix.  

The figure below illustrates the Routers Tab:

Figure 5-38.  Routers Tab  (sample)

The Routers Tab is divided into two sections:  

• The Routers Table on the left lists the parameters of each router in your system.  
Refer to the “Routers Table” section on page 87 for details.

• The Router Data Section on the right enables you to configure (or change) 
parameters for each router in your system.  Refer to the “Router Data Section” 
heading on page 87 for details.

Note that you can resize the two sections by clicking and dragging the dividing bar.

Note Encore GC is designed to only discover routers that have 
been configured on the Routers Tab.  Therefore, at startup, 
routers will not appear on the System Tab until they are 
configured in the Routers Tab.
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The Routers Table lists the parameters of each router.  Columns can be resized by clicking 
and dragging the boundary between the column headings.  You can also change the order 
of the columns by clicking and dragging a column heading to a new location in the table.

• The ID column provides a numeric ID of the selected router, from 1-8.  The 
number is not tied to a physical or electronic ID on the router itself.  A maximum of 
eight routers can be controlled.   

• The Name column lists a user-specified name for the selected router.

• The Manufacturer column lists the router’s manufacturer.

• The Signal Type column lists the router’s signal type, either Analog, SDI or DVI. 

• The # Inputs column lists the size of the router’s input matrix.

• The # Outputs column lists the size of the router’s output matrix.

• The Comm Type column lists the router’s communication type.  

• To delete a router, click the desired line then press Delete on your keyboard.

oçìíÉê=a~í~=pÉÅíáçå
Use the Router Data Section to enter data for all routers and DAs.  At the top of the 
section, the Router Number field shows the line that is selected in the table.  Please note:

• To configure a new router, click any blank line in the Routers Table, and use the 
Router Data Section to enter all information.  To modify an existing router, click 
on that specific line in the table, then use the Router Data Section to change 
information.  Refer to the “Router Configuration” section on page 88 for details.

• To configure a new DA, click any blank line in the table, and use the Router Data 
Section to enter all information.  To modify an existing DA, click on that specific 
line in the table, then use the Router Data Section to change information.  Refer 
to the “DA Configuration” section on page 89 for details.   

Note When you click on any field in the table, information from that 
line populates the Router Data section to the right.

Note IP addresses for routers and Lantronix devices are not listed 
in the table.  To view a specific IP address, click the desired 
line in the table, then look in the Router Data section.
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Click the Router Radio Button to configure (or change) a router — either via Ethernet or 
Lantronix.  The following fields are available:

Figure 5-39.  Router Data section

• Use the Name field to enter a user-specified name for the router.

• Use the Signal Type drop-down menu to choose the router’s signal type. 

• Use the # of Inputs field to list the size of the router’s input matrix.

• Use the # of Outputs field to list the size of the router’s output matrix.

• Use the Manufacturer drop-down menu to choose the router’s manufacturer.

• Use the Communication Type drop-down menu to select the router’s 
communication type, either Ethernet or Lantronix.  

~ If Ethernet is selected, enter the router’s IP address (and port, if 
applicable) in the Communication Setup section.

~ If Lantronix is selected, the Communication Setup section changes to 
display the following information:

Figure 5-40.  Communication Setup section, for Lantronix devices

• Use the Device drop-down menu to choose the Lantronix 
device that is connected to Encore GC’s closed network.

• Use the Channel selector to specify the Lantronix serial 
channel (either 1 or 2) that is connected to the router. 
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• Use the Baud Rate drop-down menu to match the baud rate of 
the router connected to the Lantronix.

• In the Data Bits section, specify the number of data bits. 

• In the Stop Bits section, specify the number of stop bits. 

• In the Parity section, specify the type of router parity. 

• At the bottom of the section, the Lantronix device’s IP Address 
and MAC Address are listed.  The Lantronix IP address must 
be set at the device itself.   

• When all fields have been entered:

~ Click the Apply button (at the top of the section) to apply all new data (or 
all changes).  The Routers Table updates with the new information, and 
the new data is immediately sent to the ECU.  

~ In the Menu Bar, click ECU > Save Configuration.

~ Configure the next router.  

a^=`çåÑáÖìê~íáçå
Click the DA Radio Button to configure or change a DA.  The section changes as follows:

Figure 5-41.  DA Data section

• Use the Name field to enter a user-specified name for the DA.

• Use the Signal Type drop-down menu to choose the DA’s signal type. 

• For DAs, the # of Inputs is fixed at one.

• Use the # of Outputs field to list the number of DA outputs.

• When all fields have been entered:

~ Click the Apply button (at the top of the section) to apply all new data (or 
all changes).  The Routers Table updates with the new information, and 
the new data is immediately sent to the ECU.  

~ In the Menu Bar, click ECU > Save Configuration.

Important When you add a new router or DA, the Output Patch Tab 
changes to reflect the new hardware, and the new router is 
added to the Router drop-down menu on the Sources Tab. 
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~ Configure the next DA.   

In Chapter 6, refer to the “Router and DA Setup” section on page 149 for step-by-step 
router configuration instructions.

Important When you add a new router or DA, the Output Patch Tab 
changes to reflect the new hardware, and the new router is 
added to the Router drop-down menu on the Sources Tab. 
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The figure below illustrates the Output Patch Tab:

Figure 5-42.  Output Patch Tab  (sample) 

The Output Patch Tab enables you to patch router outputs to various video processor 
inputs.  When you add a new router or DA to the system on the Routers Tab, the Output 
Patch Tab updates with new data.

The tab is divided in half:  

• On the left, the Router Outputs Section lists each system router, with individual 
folders representing each format, and individual lines representing each output.  

• On the right, the Device Inputs Section lists all video processors and other 
destinations that are configured in your system.

~ Individual folders are provided which represent each format.

~ Individual lines are provided for each input, and each label indicates both 
the physical processor input (e.g., 1A), and the logical Destination 
Control Tab layer (e.g., [3A]).  

Note that you can resize the two sections by clicking and dragging the dividing bar.  

To make a “router output” to “device input” patch, click and hold the desired router 
output, then drag it directly on top of the desired device input.  

Note Before you patch outputs and assign sources, it is strongly 
recommended that you complete a set of “connection 
charts” for your Encore GC and ECU system.  These charts 
will ensure that you have an error-free installation, particularly 
when complex patching is required.  In Chapter 3 of the 
Encore Presentation System User’s Guide, refer to the 
“Connection Charts” section for instructions.
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Note that a “tool tip” label of the selected output appears as you drag.

Figure 5-43.  Output patch tool tip

To create the patch, drag the output to the desired input, and release the mouse button.  
When the patch is complete:

• The selected output’s label expands to show the physical input to which it is now 
connected on the processor (e.g., 1A), and the logical layer in which it will 
appear on the Destination Control Tab (e.g., [3A]).  

• Similarly, the selected input’s label expands to show the output that is routed it.

Figure 5-44.   Completed output patch, with expanded labels.  

Once all of your patches are complete, you can check them graphically using the CTRL 
button on the keyboard.  There are several options: 

• Hold down CTRL and click an individual patch (in either column) to view the 
output-to-input connection graphically.

Figure 5-45.  Individual patch view

• Hold down CTRL and click a format folder or a router folder to see all connections 
for that device.

• Hold down CTRL and click the top Router Outputs or Device Inputs folder to 
view all patches for the system.

Once all of your patches are complete, in the Menu Bar click ECU > Save Configuration.
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The figure below illustrates the Sources Tab:

Figure 5-46.  Sources Tab  (sample)

The Sources Tab is used to set up all inputs, either via router or direct connection to the 
Processor(s).  Setup parameters include source name, connection type, router, and the 
desired input number on the GUI.  Selections on this tab directly determine the active 
inputs on the Destination Control Tab(s).

The tab is divided in half:  

• On the left, the Source Table lists parameters for up to 64 sources.  Refer to the 
“Source Table” section on page 94 for details.

• On the right, the Source Parameters Section enables you to configure the name, 
connection type, router, and the router input for each source.  Refer to the 
“Source Parameter Section” heading on page 132 for details.

Note that you can resize the two sections by clicking and dragging the dividing bar.  In 
addition, you can:

• Click the triangle (pointing left)  to expand the Source Parameter Section, and 
hide the Source Table. 

• Click the triangle (pointing right)  to expand the Source Table, and hide the 
Source Parameter Section. 
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In the Sources Tab, the figure below illustrates the Source Table:

Figure 5-47.  Source Table  (sample)

The Source Table lists the parameters for up to 64 sources — one source per row.  The 
columns in the table can be resized by clicking and dragging the boundary between 
headings, and you can change the order of the columns by clicking and dragging a column 
heading to a new location.

When you click on a source row, its settings appear in the Source Parameter Section to 
the right, enabling you to enter new information, or to modify existing information.

Descriptions of each column are provided below:

• The ID column lists the source’s number, from 1 to 64.  This number represents 
the button on which the source appears in the Destination Control Tab.

• The Name column lists a user-specified name for the source, as entered in the 
Name field in the Source Parameter Section.  In the Destination Control Tab, 
this name appears on the selected source button, and in the top row of a PIP 
(when the source is assigned to a particular layer).

Figure 5-48.  Sample source names, buttons and PIPs

• The Connection Type column indicates how the selected source is connected to 
the Processor.  This data is entered in the Connection Type field in the Source 
Parameter Section.  
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• The Connection column lists the name of the router or processor plus the specific 
input connector to which the source is physically connected.  This data is entered 
in the Connection Type and Input fields in the Source Parameter Section.

• The Image column lists the location of the graphic that represents the source on 
the Palette. 

pçìêÅÉ=m~ê~ãÉíÉê=pÉÅíáçå
In the Sources Tab, the figure below illustrates the Source Parameter Section:

Figure 5-49.  Source Parameter Section  (sample)

The Source Parameters Section enables you to specify the name, connection, router and 
input for each source.  To enter data for a source, first click on the desired source row in the 
Source Table.  This action populates the parameter section with all current data — 
enabling you to enter new information, or to modify existing information.

Descriptions of each field are provided below.  Note that the fields change slightly, 
depending on the connection type.

• Use the Name field to enter a custom source name, e.g, PC 1, PC 2, etc.  Default 
names are Source 1, Source 2, etc.  In the Destination Control Tab, the name 
will appear on the selected source button, and in the top row of a PIP (when the 
source is assigned to a layer).

• Use the Connection Type drop-down menu to select how the specific source is 
connected to the Processor.  

~ Select Router if the source is connected via router.  To complete the 
connection, you must select a router and an input.

~ Select Direct Analog if the source is connected directly to one of the 
processor’s analog inputs.  To complete the connection, you must select 
a processor and an input.

~ Select Direct DVI if the source is connected directly to one of the 
processor’s DVI inputs.  To complete the connection, you must select a 
processor and an input.

~ Select Direct SDI if the source is connected directly to one of the 
processor’s SD inputs.  To complete the connection, you must select a 
processor and an input.

~ Select SP2 if the source is connected directly to a ScreenPRO-II input  
— but if you want all connected ScreenPRO-IIs to switch simultaneously 
to the same input.  To complete the connection, select an input only.

• The GUI Image field is currently not implemented.  
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• If a Router was selected in the Connection Type field:

~ Use the Router drop-down menu to select the router to which the source 
is connected.  All routers on the Routers Tab appear in the menu.

~ Use the Input field to select the specific input connector (on the router) to 
which the source is connected. 

• If a Direct Connection to a Processor (e.g., Direct DVI, Direct SDI, Direct Analog) 
was selected in the Connection Type field:

~ Use the Processor drop-down menu to select the Processor to which 
the source is directly connected.  All Processors as listed on the System 
Tab appear in the menu.

~ Use the Input field to select the specific physical input connector (on the 
Processor) to which the source is connected (e.g., 1A, 1B, etc.).

~ When an input is selected, note that the Mixer Layer field indicates the 
layer on which the source appears on the Destination Control Tabs.  
This field is provided for information only.

• If SP2 was selected in the Connection Type field:

~ Use the Processor drop-down menu to select the Processor to which 
the source is directly connected.  All Processors as listed on the System 
Tab appear in the menu.

~ Use the Input field to select the specific input connector (on the 
Processor) to which the source is connected (e.g., 1-8, SDI 1, SDI 2).

• If ALL SP was selected in the Connection Type field:

~ Use the Input field to select the specific input (on all ScreenPRO-II 
processors) to which the source is connected (e.g., 1-8, SDI 1, SDI 2).

• After data is entered (or changed) for each source, click Apply to send the new 
information to the ECU.

• After all data is entered, in the Menu Bar click ECU > Save Configuration.
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The figure below illustrates the Stills Tab:

Figure 5-50.  Stills Tab  (sample)

The Stills Tab is used to name, save, recall, erase and delete still frames that have been 
captured on the Destination Control Tab(s) from a selected layer, the current background 
or the DSK.

The tab is divided in half:  

• On the left, the Still Management Section provides status for the system’s three 
on-line frame buffers, plus buttons that enable you to save, recall, erase and 
delete still frame files.  Refer to the “Still Management Section” heading on 
page 98 for details.

• On the right, the Still Frame Table lists the status of all 100 available still frame 
files.  Refer to the “Still Frame Table” heading on page 99 for details.
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The figure below illustrates the Still Management Section, which provides status for the 
system’s three on-line frame buffers, plus buttons for saving, recalling, erasing and deleting 
still frame files.     

Figure 5-51.  Still Management Section  (sample)

The following functions are provided:

• Use the Destination drop-down menu to select the destination on which you want 
to save and recall stills.  Remember that each destination has a pool of 100 stills 
that you can manage.  

• For widescreen destinations only, use the VP drop-down menu to select the 
individual VP (or all VPs) for which you want to save or recall files.  The default 
selection is “All,” enabling you to save a still for all video processors, but in certain 
situations, you may elect to save (or recall) a still for only one of the widescreen 
destination’s processors.

• In the Still Frame Buffers section, three mutually exclusive radio buttons are 
provided the system’s on-line frame buffers (Buffer 1, 2 and 3).  The “selected” 
radio button determines the buffer that you can save to a file, or the buffer that you 
can load up with a still file from memory.  

Below the buffer name, several labels can appear:

~ Empty indicates that the buffer is empty, and available for use.

~ Unsaved indicates that a frame has been grabbed on a Destination 
Control Tab, but it has not been saved into non-volatile memory.  The 
resolution at which it was grabbed is listed.  

~ File ID “n” (plus an optional name) indicates a frame that has been 
recalled from memory to the indicated frame buffer.  The resolution at 
which it was stored is listed.
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• To the right of the Still Frame Buffers section are four buttons, each of which 
functions in conjunction with the highlighted row in the Still Frame Table and the 
selected radio button.  If a row is not highlighted, all four buttons are grayed out:

~ Click Save to File >> to save the selected frame buffer to the highlighted 
file in the Still Frame Table.  Once saved, the row turns green to 
indicated that the memory register’s status is Full.

~ Click Recall from File << to recall the highlighted still frame from 
memory into the selected frame buffer.

~ Click Erase File to permanently erase a frame.  This is a “destructive” 
process which takes several seconds.  When clicked, the row’s green 
color clears and the memory register’s status changes to Empty.

~ Click Delete File to mark a selected frame as deleted — but the ERASE 
function is still required for permanent deletion.  This is essentially a 
“quick” delete function.  When clicked, the row’s green color clears and 
the memory register’s status changes to Empty.

píáää=cê~ãÉ=q~ÄäÉ
The Still Frame Table lists the status of all 100 still frame files in the library.  Please note:

• The columns can be resized by clicking and dragging the boundary between 
headings

• You can change the order of the columns by clicking and dragging a column 
heading to a new location.

• You can sort a column by ascending or descending order, simply by clicking a 
column heading. 

Figure 5-52.  Still Frame Section  (sample)

Descriptions of each column are provided below.  

• The ID Column lists the system-assigned file number for each still frame in 
memory, from 1 to 100.  

• The Name column lists the user-assigned name for each still in the library.  
Double click a cell to edit a name.

• The Resolution column lists the resolution at which the still was captured.

• The Status column provides status for each file (e.g., Full, Empty).  
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The figure below illustrates a Destination Control Tab, which enables you to configure the 
“look” of your presentation, including all sources, PIPs, Keys and backgrounds.

Figure 5-53.  Destination Control Tab  (sample) 

Following are descriptions of each Destination Control Tab section: 

1) Tool Bar

The Tool Bar provides an array of icons that are (almost) identical to those on the 
View Menu.  Different sets of icons are active (or grayed out) based on which 
PIP(s) are selected in the Palette.  Refer to the “Tool Bar” section on page 101. 

2) Palette

The Palette is the Encore GC’s workspace in which you configure your 
presentation’s exact “look.”  The solid red border represents the dimensions of the 
selected destination — whether it is a single screen or a widescreen.  Refer to the 
“Palette” section on page 104 for details.   

3) Layer Control Section

The Layer Control Section enables you to control the look on both Program and 
Preview, by enabling or disabling layers.  In conjunction with the controls in the 
Source/Preset Section, you can assign sources to PIPs and Keys, and control 
up to six layers (on up to three mixers).  Refer to the “Layer Control Section” 
heading on page 132 for details.   

5

1

2

3

4

1) Tool Bar 3) Layer Control Section 5) Mixer Control Section

2) Palette 4) Source/Preset Section
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4) Source/Preset Section

The buttons in the Source/Preset Section enable you to select sources for the 
active PIP(s) or Key(s) on the Palette.  In addition, you can also learn, recall and 
delete Presets within this section.  Refer to the “Source/Preset Section” heading 
on page 133 for details.  

5) Mixer Control Section

The Mixer Control Section provides expandable sections that enable you to 
configure the specific settings for each available mixer.  All sections are identical.  
Refer to the “Mixer Control Section” heading on page 136 for details.    

Please note the following important points regarding the Destination Control Tab: 

• In the row of tabs, one Destination Control Tab appears for each destination that 
is configured on the Destination Setup Tab. 

• If the system does not detect any valid video processors, no Destination Control 
Tabs will appear. 

• You can resize the Palette and Mixer Control Sections by clicking and dragging 
the dividing bar.  In addition, you can:

~ Click the triangle (pointing left)  to expand the Mixer Control Section, 
and hide the Palette. 

~ Click the triangle (pointing right)  to expand the Palette, and hide the 
Mixer Control Section. 

qççä=_~ê
The figure below illustrates the Tool Bar, which enables you to perform various functions to 
one (or more) selected PIPs or Keys.  Tool tip help is provided for each icon.

Figure 5-54.  Tool Bar

Starting from the left, the View Group controls your “view” of the Palette:

Figure 5-55.  View Group

• Click Zoom In to zoom the view closer to PIPs on the Palette.

• Click Zoom Out to zoom the view farther away from PIPs.

• The “percentage” box indicates the percentage of Palette magnification. 

• Click Show All to adjust the view to ensure that the entire destination screen is 
visible on the Palette.

Note Different sets of icons are active (or grayed out) based on 
which PIPs or Keys are selected in the Palette.  In the sample 
above, all icons are active for discussion purposes only.
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The icons in the Alignment Group are only enabled when two or more PIPs or Keys are 
selected simultaneously (using the standard SHIFT + click technique).  If only one is 
selected, the items are grayed out.

Figure 5-56.  Alignment Group

• Click Align Top to align the top edges of all selected PIPs or Keys.

• Click Align Bottom to align the bottom edges of all selected PIPs.

• Click Align Left to align the left edges of all selected PIPs. 

• Click Align Right to align the right edges of all selected PIPs.

• Click Align Centers Vertically to align the vertical axes of all selected PIPs.

• Click Align Centers Horizontally to align the horizontal axes of all selected PIPs.  

The icons in the Centering Group are only enabled when one (or more) PIPs or Keys are 
selected in the Palette.  If the background is clicked, the items are grayed out.  Note that if 
two or more PIPs are selected, the PIP selected first is the master for the selected function.  

Figure 5-57.  Centering Group

• Click Center Horizontally to center all selected PIPs horizontally, along the 
screen’s vertical axis.  PIPs do not change their vertical position.

• Click Center Vertically to center all selected PIPs vertically, along the screen’s 
horizontal axis.  PIPs do not change their horizontal position.

• Click Center in Destination to center all selected PIPs vertically and horizontally, 
within the destination’s horizontal and vertical axes.  

The icons in the Full Screen Group are only enabled when one (or more) PIPs are 
selected in the Palette.  If the background is clicked, the items are grayed out.

Figure 5-58.  Full Screen Group

• Click Full Screen Vertical to take the selected PIP(s) to full screen, using the 
source’s height as the guide.  If borders are on, they will be taken into account so 
that they are visible. 

• Click Full Screen Horizontal to take the selected PIP(s) to full screen, using the 
source’s width as the guide.  If borders are on, they will be taken into account.

Note In each case, the PIP or Key selected first is the master for 
the selected function.  For example, given two PIPs in the 
Palette, one screen left and one screen right, you can align to 
either one — provided that you click it first, and then SHIFT + 
click the second PIP. 
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The icons in the Similarity Group are only enabled when two (or more) PIPs are selected 
in the Palette.  If the background is clicked, or if only one PIP is selected, the items are 
grayed out.  Note that if two or more PIPs are selected, the PIP selected first is the master 
for the selected function. 

Figure 5-59.  Similarity Group

• Click Make Same Width to make the second (and subsequent) PIPs that you 
select the same width as the first selected PIP.

• Click Make Same Height to make the second (and subsequent) PIPs that you 
select the same height as the first selected PIP.

• Click Make Same Size to make the second (and subsequent) PIPs that you select 
the same size as the first selected PIP.

At the far right of the Tool Bar, two special buttons are provided:

Figure 5-60.  Freeze and Grab buttons

• Click a PIP, Key, or click the background layer in the Palette, then click Freeze to 
freeze the layer.  The button’s label identifies the selected PIP, Key, BG or DSK 
layer (e.g., Freeze 1A), and changes to Unfreeze when clicked again (e.g., 
Unfreeze 1A).

• Click Grab (1, 2 or 3) to capture the selected layer into the indicated frame buffer.  
To select a different frame buffer, right-click the Grab button and choose the 
desired buffer.  

Figure 5-61.  Grab Pop-up Menu

Once grabbed, the frame is available for naming and filing on the Stills Tab.  

Note All frame grabs are full screen captures.  A frame can be 
captured from BG A, BG B, the DSK, or any of the scaled 
inputs (layers).  When you capture a layer, you will capture 
the selected PIP with no borders, and with black as the 
background.  In Chapter 7, refer to the “Working with Frame 
Grabs” section on page 184 for details.
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The figure below illustrates a sample Palette:

Figure 5-62.  Palette  (sample)

The Palette is the workspace in which you configure your presentation’s exact “look.”  If 
you have your Program and Preview monitors properly connected to your Video 
Processors, you’ll see that the still images on the Palette precisely represent the live 
images on the system’s true video outputs.

The following topics are discussed in this section:

• Palette Attributes

• Palette Views

• PIP and Key Behavior

• Default Images and Labels

• Raster Boxes

• Palette Cursors

• PIP and Key Positioning

• Palette Pop-ups

• Palette Dialogs

m~äÉííÉ=^ííêáÄìíÉë
The Palette has the following important attributes:

• The solid red border represents the dimensions of the selected destination 
(whether it is a single screen or a widescreen), as configured on the Destination 
Tab in the Output Settings Section.  The area outside the red border is also an 
active area, because PIPs and key can be positioned on or off screen.

• The various still images on the Palette represent scaled PIPs and Keys.  These 
images represent layers, and each is controlled in the Layer Control Section.

• Behind the PIPs and Keys is the full screen background layer.  The Encore GC 
controls up to two backgrounds, only one of which is displayed at a time, and both 
backgrounds are controlled in the Layer Control Section.

• If your configuration has multiple destinations and multiple Destination Control 
Tabs, each destination has its own Palette. 
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There are three ways to view the Palette, as selected in the Menu Bar:

• Click View > Preview to show only the destination’s preview output in the Palette 
(for the selected destination).

• Click View > Program to view only the destination’s program output in the Palette.

• Click View > Preview and Program to create a split screen in the Palette, with 
the program output above and the preview output below.  

mfm=~åÇ=hÉó=_ÉÜ~îáçê
When you enable a layer in the Layer Control Section and manipulate that layer in the 
Palette, its size, position, crop, border and shadow represent the layer’s behavior on the 
Program and Preview outputs.

aÉÑ~ìäí=fã~ÖÉë=~åÇ=i~ÄÉäë
When you assign a source to a layer, the Encore GC places an image inside the PIP or key 
layer.  Each PIP or key is labeled with its layer and scaler location (e.g., Layer 1A), and 
with its source name (e.g., Camera 1), as assigned on the Sources Tab.  If a layer does 
not have a source assigned, the label “Source Unknown” appears.

Figure 5-63.  Layer labels
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In the Palette (and on your Preview output), each PIP or Key is surrounded by a border 
called a Raster Box.  This border helps identify the PIP or Key’s mixer and layer.   

• The PIP or Key with a “corner” style raster box is Layer A.  

• The PIP or Key with a “dashed” raster box is Layer B.

Figure 5-64.  Raster Box styles

• The "blinking" raster box is always the one enabled for modification. 

• If two or more PIPs or Keys are selected (using the standard Shift + Click 
method), you can modify them simultaneously.  

PIP 1A PIP 1B
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• The borders of raster boxes that are underneath other layers (such as another 
PIP) are still visible on Preview and in the Palette.   

Figure 5-65.  Raster Box visibility

Raster box color assignments are as follows:

• Layers 1A and 1B:  Red

• Layers 2A and 2B:  Green

• Layers 3A and 3B:  Blue

m~äÉííÉ=`ìêëçêë
The following four types of cursors are available on the Palette:

• The Selection Cursor is a single arrow that appears when you mouse over the 
background layer, enabling you to select the layer.  

Figure 5-66.  Background Cursor

• The PIP Cursor is a four-headed arrow that appears when you mouse over a PIP 
or a Key layer, enabling you to move the layer by clicking and dragging.  

Figure 5-67.  PIP Cursor  

• The Edge Cursor is a two-headed horizontal or vertical arrow that appears when 
you mouse over the edge of a PIP or a Key.  This enables you to resize the layer 
by clicking and dragging (if Lock Aspect Ratio is on), or change the layer’s 
aspect ratio (if Lock Aspect Ratio is off). 

Figure 5-68.  Edge Cursor

PIP 1A

PIP 1B

Note When you mouse over a PIP or a key, a tool-tip message 
shows the layer’s size and position.
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• The Crop Cursor is a small cross that appears when you mouse over the edge of 
a PIP or a Key when Crop Mode is enabled.  This allows you to crop the selected 
edge of a PIP or Key by clicking and dragging. 

Figure 5-69.  Crop Cursor
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On the Palette, the area surrounding the red border is an active area.  PIPs and Keys can 
be positioned fully on, partially on, or fully off of the Palette, as shown below:

Figure 5-70.  Two PIPs fully on screen  (sample)

Figure 5-71.  One PIP partially off screen  (sample)
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Figure 5-72.  One PIP fully off screen  (sample)
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In the Palette, right-clicking PIPs, Keys and the background layer provides access to two 
different pop-up menus:

• Background/DSK Pop-Up Menu

• PIP/Key Pop-Up Menu

Background/DSK Pop-Up Menu

Right-click on the background layer to display the Background/DSK Pop-up Menu:

Figure 5-73.  Background/DSK Pop-up Menu

• Click Background Properties to display the Background Properties Dialog.  
Background A or B must be enabled.  Refer to the “Background Properties 
Dialog” section on page 118 for details.

• Click DSK Properties to display the DSK Properties Dialog.  The DSK must be 
enabled.  Refer to the “DSK Properties Dialog” section on page 124 for details.

PIP/Key Pop-Up Menu

Right-click on a PIP or a Key to display the PIP/Key Pop-up Menu:

Figure 5-74.  PIP/Key Pop-up Menu

• Click Border Properties to display the Border Properties Dialog.  Refer to the 
“Border Properties Dialog” section on page 111 for details.
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• Click Shadow Properties to display the Shadow Properties Dialog.  Refer to 
the “Shadow Properties Dialog” section on page 112 for details.

• Click Key Properties to display the Key Properties Dialog.  Refer to the “Key 
Properties Dialog” section on page 113 for details.

• Click Input Properties to display the Input Properties Dialog.  Refer to the 
“Input Properties Dialog” section on page 114 for details.

• Check (or uncheck) Lock Aspect Ratio to lock or unlock the PIP’s aspect ratio.  
The checkmark indicates “locked.”  When locked, a PIP’s H and V size tracks 
proportionally.  When unlocked, H and V size can be adjusted individually.

• Check Crop Enabled to crop the edges of a PIP.  When enabled, several 
functions are available:

~ Enable Crop.  Place your cursor over any edge of the PIP, and then click 
and drag to crop the image.

~ In Crop mode, place your cursor over the inside of the image, and then 
click and drag to move the image around — inside the cropped region.

~ In Crop mode, place your cursor over the inside of the image hold down 
CTRL, and then click and drag to move the cropped region around the 
Palette, leaving the image in place. 

~ Enable Resize to move the cropped image around the Palette, or resize 
the cropped image by clicking and dragging an edge.  

Note If you un-check Crop Enabled, the image returns to full size, 
and all cropped edges are cleared.
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Six different dialogs can be accessed within the Palette, or by clicking Layers in the Menu 
Bar.  Complete descriptions are provided in the following sections.  

• Border Properties Dialog

• Shadow Properties Dialog

• Key Properties Dialog

• Input Properties Dialog

• Background Properties Dialog

• DSK Properties Dialog

Please note the following important points regarding the behavior of the Palette dialogs:

• Multiple dialogs can be open simultaneously.

• With a dialog open (e.g., Border Properties), you can click on different layers in 
the Palette, and the data within the dialog updates according to the selected layer.  
This enables you to easily compare settings between layers.

• An error message (e.g., No Source Selected, No PIP Selected) appears in place 
of the dialog’s adjustments and controls if the proper layer or background is not 
selected in the Palette. 

Important If the selected source or background layer is already on 
Program, parameters can not be adjusted (even if a dialog is 
already open).  To adjust the layer, clear it in the normal 
manner, after which full adjustment capabilities are available 
once the layer is on Preview.
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The figure below illustrates the Border Properties Dialog:

Figure 5-75.  Border Properties Dialog  (sample)

The Border Properties Dialog enables you to add a border to a PIP, and adjust its shape, 
style and color as desired.  The following functions are provided:  

• Enabled — use the check box to enable or disable the border. 

• Style — select one of 20 border styles from the drop-down menu, including single 
color and dual color with various combinations of soft edge.

• In the Color section, use the sliders and spinners to adjust the border’s R, G and 
B attributes.  The border color changes in the Palette as you adjust.

• Click the Choose button to display the Choose Color Dialog.  Click the desired 
border color, and note that each selection is added to the “Recent” section.  Click 
OK to accept the selected color.

Figure 5-76.  Choose Color Dialog  (sample) 

• Specified In — use the drop-down menu to select the method by which you want 
to specify the border size, either as a percentage of the PIP size or in pixels.  

• Size — adjust’s the border size using the slider and spinner.  Note that if “% of 
PIP” is selected and you switch to “Pixels,” the system auto converts.
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The figure below illustrates the Shadow Properties Dialog:

Figure 5-77.  Shadow Properties Dialog  (sample)

The Shadow Properties Dialog enables you place a shadow behind a PIP.  The following 
functions are provided:  

• Enabled — use the check box to enable or disable the shadow.

• In the Size section, use the sliders and spinners to adjust the shadow’s horizontal 
and vertical size as a percentage of the PIP’s size.  

• In the Position section, use the sliders and spinners to adjust the shadow’s 
horizontal and vertical position as a percentage of the PIP’s size.

• Use the Transparency slider and spinner to adjust transparency, from 0 
(transparent) to 1024 (opaque).  
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The figure below illustrates the Key Properties Dialog:

Figure 5-78.  Key Properties Dialog  (sample)

The Key Properties Dialog provides the tools to adjust the active key.  The following 
functions are available:

• Enabled — use the check box to enable or disable the key.  If the layer is 
currently a PIP and you enable the check box, it changes to a key, and the small 
red label “Key” appears on the layer.  Similarly, if you disable the check box, the 
layer returns to a PIP, and its previous border and shadow properties are restored.

• Key Type — the key type is fixed as Luma (luminance).  A Luma key is one in 
which the hole-cutting information is derived from the luminance (brightness) level 
of the key source.

• Fill Source — the fill source (the video that fills the key hole) is fixed as Self.  The 
key source is filled with the key source video itself, for example, the video from a 
character generator or logo.

• Clip — adjusts the threshold of the video that “cuts” into the background image.  A 
hole will be cut into the background anywhere that foreground luminance is 
greater than the clip level.  The hole is then filled with the Fill Source.  

~ Adjustment range:  0 to 1023

• Gain — adjusts the sensitivity of the keyer, enabling you to change the sharpness 
of the keyed image.  Gain only affects the key hole, as set by the clip.  

~ Adjustment range:  0 to 1023.99

• Opacity — enables you to adjust the opacity of the keyed image, from fully 
opaque to fully transparent.  

~ Adjustment range:  0 to 1024
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The figure below illustrates the upper and lower sections of the Input Properties Dialog:

Figure 5-79.  Input Properties Dialog  (sample)

The Input Properties Dialog is used to adjust all parameters for the source input currently 
displayed in the selected layer.  The dialog enables you to set all configuration options for 
the selected input.  Note that the menu tracks the input selected in the Palette.  

The following functions are provided for the selected input: 

• Click Force Acquire to force the system to perform the optimum image setup.  
Use this feature as a good starting point for setup.    

Important Different combinations of functions are enabled or grayed out, 
depending on the selected connector, format and color space.

Note The Force Acquire function only works on the selected Input 
Connector.  For the selected input, be sure to select the 
correct connector type on the Sources Tab before issuing the 
Force Acquire command.
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• Check Source Preview to quickly isolate the selected layer for sizing and 
adjustment purposes — in Preview only.  When enabled, the border and shadow 
are turned off, and the PIP (or Key) is re-sized in the center of the screen.  When 
disabled, the layer is restored.

Please note: 

~ When Source Preview is enabled, use the drop-down menu to size the 
image to 90% of the output resolution or to 1:1.

~ If the system is in wide screen mode, the layer is centered in screen 1.

~ All other layers are hidden.

~ The background switches to a neutral gray.

~ While Source Preview is enabled, you can only perform input 
adjustments and source selections.  All other layer, destination and 
output functions are disabled.

• Input Connector — indicates the physical connector to which the input is 
connected on the M/E, either HD-15, DVI or BNC.  Note that the connection type 
is determined by the selection on the Sources Tab.

• Source Type — use the drop-down menu to set the type of input connected to the 
M/E.  Available choices change depending on the selected Video Format, and 
the choice also affects the Color Space selection.  Input types include:

~ RGB
~ YPbPr
~ Composite/S-Vid
~ HD SDI
~ SDI

~ DVI Digital    

• Video Format — this drop-down menu performs two functions:

~ The menu displays the resolution that is automatically determined by the 
Force Acquire function. 

~ The menu enables you to manually set the resolution of the source.    

~ If the “Adjusted” label appears, it indicates that the sizing has been 
changed by the user. 

In Appendix A, refer to the “Input and Output Resolutions” section on page 194 
for details on all available resolutions.  Please note:

~ Manually selecting a video format automatically defaults the Color 
Space.  In some cases, the Color Space cannot be changed due to the 
selected resolution.  

~ The choice of available formats varies depending on the selected 
connector.  For example, when BNC is selected, only standard definition 
and high definition resolutions can be selected. 

• Color Space — use the two radio buttons to set the input’s color space, either 
SMPTE or RGB.  The system automatically sets the Color Space based on the 
selected Video Format and/or Input Connector — but in some cases, color 
space can be changed.

• Contrast — use the spinner to set the input’s contrast.  

• Brightness — use the spinner to set the input’s brightness.  
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• Input Sync Type — if enabled, use the drop-down menu to set the type of sync 
used by the source.  Choices include H/V, CSync (composite sync). SOG (sync 
on green) and Auto.

• Gamma — use the spinner to set the input gamma, enabling you to match the 
source’s gamma.

~ Adjustment range: 1.0 to 3.0

• Sync Slice — use the spinner to select the sync comparator threshold for RGsB 
(RGB with Sync on Green) or YPbPr analog component video sources.

~ Adjustment range:  from 20mV to 280mV, adjustable in steps of 10mV.  
The default value is 160mV.  

When the VP detects Macrovision® copy protection on the incoming YPbPr NTSC/
PAL video, the Sync Slice value is repositioned to 60mV to account for the 
reduced amplitude sync pulse.

Please note:

~ The default Sync Slice level has been optimized for virtually all sources 
that will be encountered and should rarely, if ever, require adjustment.

~ You can adjust the level to improve sync detection and synchronization 
in cases of extremely noisy RGsB or YPbPr signals.

• Sharpness — use the spinner to set the input’s sharpness.  

~ Adjustment range: -10 (very smooth) to 10 (very sharp). 

• The controls in the Aspect Ratio section enable you to change the image’s 
aspect ratio to pre-defined configurations, or a “custom” configuration.  

~ Mode — use the drop-down menu to select the desired aspect ratio, 
either 16:9, 5:4, 4:3, 3:2, 1:1 or Custom.

~ Ratio — when Custom is selected in the Mode field, use the spinner to 
select a custom aspect ratio.  The field is grayed out when a pre-defined 
ratio is selected.

• Motion Threshold — if enabled, use the spinner to increase or decrease the de-
interlacer’s sensitivity towards moving content.  The adjustment range is 0 to 15:

~ 0 — the de-interlacer has the maximum sensitivity to motion.

~ 15 — the de-interlacer has the least amount of sensitivity to motion.  
Moving pixels will be treated as “static.”

~ 4 (default) — the optimum value for a wide range of motion conditions.

For example, if you detect “popping” or “flickering” noise in the image, particularly 
along sharp edges such as text, increase the motion threshold value to effectively 
decrease motion sensitivity.  This will help to alleviate the pixel flickering.  

• Pulldown Compensation — This function is applicable only for standard video 
(component, s-video, composite) inputs.  The default mode is off (un-checked).  
The feature should be enabled to process video derived from film material. 

• Sampling Mode — the two radio buttons set the sampling for the selected input, 
and also change the functions available in the “Sizing” section directly below.

~ When 1:1 is selected, the system provides pixel-for-pixel sampling, and 
generally better image quality.  

~ When Oversample is selected, the system performs multiple samples 
for every pixel, with a resulting “softer” image.
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• 1:1 Sizing — When 1:1 is selected in the Sampling Mode section, the “Sizing” 
section provides the following controls:

Figure 5-80.  1:1 sizing controls  (sample)

~ Clock Phase — sets the system’s A/D converter, allowing you to select 
where pixels are sampled (ideally, on the pixel’s peak).  

• Adjustment range: -16 to 15  

For best visual results when adjusting high-resolution sources, project a 
burst test pattern and adjust the sampling for the minimum noise.  

~ Horizontal Total — sets the total pixel count per line.  

~ Horizontal Active — sets the width of the active area.

~ Horizontal Position — sets the start of the active area’s horizontal offset 
from H sync.

~ Vertical Total — fixed value which cannot be adjusted.

~ Vertical Active — sets the number of vertical lines in the image.  

~ Vertical Position — sets the start of the active area’s vertical offset from 
V sync.

• Oversample Sizing — When Oversample is selected in the Sampling Mode 
section, the “Sizing” section provides the following four controls:

Figure 5-81.  Oversample sizing controls  (sample)

Select and adjust Right Edge, Left Edge, Top Edge or Bottom Edge as 
required, to fit the image precisely in its raster box.

• The functions in the Color Balance section change depending on the selected 
Source Type.

~ When RGB sources are selected, the section provides tabs for R, G and 
B — each of which has sliders and spinners for contrast and brightness.  

• Adjustment range: -25% to +25%

Note This field is not adjustable for digital sources, including digital 
signals on the DVI and BNC input connectors.  This field is 
not adjustable for NTSC and PAL sources.
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~ When Composite, S-Video or YPbPr sources are selected, the 
Saturation and Hue controls are enabled: 

• Adjustment range (Saturation): 75% to 125%

• Adjustment range (Hue): -90.0 to 90.0, in degrees  

• Save — When all parameters have been entered, click Save to save the input 
settings.  Using an automatic “copy down” function, the saved file will be 
transferred to all active destinations.  

_~ÅâÖêçìåÇ=mêçéÉêíáÉë=aá~äçÖ
The Background Properties Dialog enables you to select and define background sources 
A and B.  For each background, you can choose between a solid matte color, a DVI input, 
an analog input, or a captured frame grab.  The dialog changes depending on the selected 
background “type.”

The following topics are discussed in this section:

• Background and DSK Connections

• Shared Background Properties Dialog Functions

• Matte Background Properties

• DVI Background Properties

• Analog Background Properties

• Still Frame Background Properties

Background and DSK Connections

Please note the following important points regarding inputs, sources and physical 
connections for the background and the DSK:

• On the Encore Video Processor’s rear panel, there are two DVI-I input connectors 
(A and B) for each M/E, and each contains both a digital and an analog input.  
Depending upon your application (and the location of the M/E), you can use the 
input for a scaled or an unscaled source:

• The “digital” side of the connector accepts connections from a standard DVI 
output or digital graphic router.  This side of the input can be used as both a 
scaled input source or as an unscaled Background or DSK source.

• Using an optional breakout cable, the “analog” side of the connector accepts 
connections from a VGA output or VGA router.  This side is designed for inputting 
the system’s unscaled sources — Background and DSK.  

~ The lowest priority M/E in your system must be used for inputting the 
Background source.

~ The highest priority M/E in your system must be used for inputting the 
DSK source.

Physical connection rules are as follows:

• In a 3 M/E system:

~ M/E 1 connectors are the highest priority, and they appear as Layer 3 on 
the Encore GC.  The DSK will be connected to the M/E 1 board.

~ M/E 2 connectors have middle priority.  They appear as Layer 2. 

Important Always click Save after you’re changed an input’s settings.
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~ M/E 3 connectors are the lowest priority.  They appear as Layer 1.  
Background sources will be connected to the M/E 3 board. 

• In a 2 M/E system:

~ M/E 1 connectors are the highest priority, and appear as Layer 2.  The 
DSK will be connected to the M/E 1 board.

~ M/E 2 connectors are the lowest priority, and appear as Layer 1.  
Background sources will be connected to the M/E 2 board. 

~ M/E 3 connectors are not installed.

• In a 1 M/E system:

~ M/E 1 connector priorities are relative to the connectors being used:   

• The DVI Input A or Analog Input A connector could be set up 
as a Background input (lowest priority).

• The DVI Input B or Analog Input B connector could be setup 
as a DSK input (highest priority).

This leaves the other connectors to fall in between Background and 
DSK.  The rule stating that “A” connectors are lower in priority than “B” 
connectors still holds.

~ M/E 2 and 3 connectors are not installed.

Shared Background Properties Dialog Functions

The figure below illustrates the top section of the Background Properties Dialog, which is 
shared between all selected background types:

Figure 5-82.  Background Properties Dialog - shared section

• Force Acquire — For DVI and Analog background types, click to automatically 
detect the input signal resolution and acquire the selected input.  The button is 
grayed out for Matte and Still Frame background types. 

• All — For single screen destinations, this check box and the Processor drop-
down menu are both grayed out.  In widescreen configurations, different 
backgrounds can be assigned to different video processors, thus the All check 
box and the Processor drop-down menu are active.

~ Enable the All check box to create backgrounds across all video 
processors.

~ Disable the All check box to create individual backgrounds for different 
video processors.  In this case use the Processor drop-down menu to 
select the specific processor for which you want to create a background. 

• Freeze — For DVI and Analog background types, click to freeze the selected full 
screen input signal, in preparation for capturing it into a frame buffer.  The button 
is grayed out for Matte and Still Frame background types. 
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• Capture — For DVI and Analog background types, click to capture the input into 
the selected frame buffer, as chosen with the Frame Buffer drop-down menu.  
The Capture button is grayed out for Matte and Still Frame types.  

• Type — use the pull-down menu to select the desired background type:

~ Select MATTE to use a solid color as the background.  Refer to the 
“Matte Background Properties” section on page 120 for details.

~ Select DVI to use a digital graphic from a computer (or other DVI source) 
as the background.  Refer to the “DVI Background Properties” section 
on page 121 for details.

~ Select Analog to use an analog graphic from a computer (or other 
analog source) as the background.  Refer to the “Analog Background 
Properties” section on page 122 for details.

~ Select Still Frame Buffer 1, 2 or 3 to use a frame grab as the 
background.  Refer to the “Still Frame Background Properties” section 
on page 123 for details.

Matte Background Properties

The figure below illustrates the Background Properties Dialog with Matte type selected.

Figure 5-83.  Background Properties Dialog - Matte Type  (sample)

Use the Matte Color sliders and spinners to create a solid background matte color to use 
behind your PIPs and Keys.  The system supports two separate matte colors — one for 
Background A and one for Background B.  

• For R, G and B, adjust each component from 0 to 1023.

• Click the Choose button to display the Choose Color Dialog.  Click the desired 
background color, and note that each selection is added to the “Recent” section.  
Click OK to accept.

• Click Save to save the selected background configuration.

Note All frame grabs are full screen captures.  In Chapter 7, refer 
to the “Working with Frame Grabs” section on page 184 for 
details.
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DVI Background Properties

The figure below illustrates the Background Properties Dialog with DVI type selected.

Figure 5-84.  Background Properties Dialog - DVI Type  (sample)

The following functions are provided for a DVI background source:

• Video Format — this section performs two functions:

~ The field displays the resolution that is automatically determined by the 
Force Acquire function. 

~ Use the pull-down menu to manually set the resolution of the incoming 
DVI source.    

• For the two settings in the Crop Offset section:

~ If the source’s input resolution matches the output resolution, or if output 
resolution is larger than input resolution, Crop settings are grayed out.  

~ If input data is smaller than the output resolution, the area around the 
active data is set to black, and input data is centered in the screen.

~ If the source’s input resolution is larger than the output resolution, the H 
Crop Offset and V Crop Offset sliders and spinners can be used to 
choose which portion of the background you want to display.  

• Click Save to save the selected background input configuration.
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Analog Background Properties

The figure below illustrates the upper and lower sections of the Background Properties 
Dialog — with Analog type selected.

Figure 5-85.  Background Properties Dialog - Analog Type  (sample)

The following functions are provided for an Analog background source:

• Video Format — this section performs two functions:

~ The drop-down menu displays the resolution that is automatically 
determined by the Force Acquire function. 

~ Use the drop-down menu to manually set the resolution of the incoming 
analog source.    

• For the two settings in the Crop Offset section:

~ If the source’s input resolution matches the output resolution, or if output 
resolution is larger than input resolution, Crop settings are grayed out.  

~ If input data is smaller than the output resolution, the area around the 
active data is set to black, and input data is centered in the screen.

~ If the source’s input resolution is larger than the output resolution, the H 
Crop Offset and V Crop Offset sliders and spinners can be used to 
choose which portion of the background you want to display.  

• Contrast — use the slider and spinner to set the background’s contrast.  

~ Adjustment range:  75% to 125%

• Brightness — use the slider and spinner to set the background’s brightness.  

~ Adjustment range:  75% to 125%
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• 1:1 Sizing — This section provides the following controls: 

~ Clock Phase — sets the system’s A/D converter, allowing you to select 
where pixels are sampled (ideally, on the pixel’s peak).  

• Adjustment range: -16 to 15  

For best visual results when adjusting high-resolution sources, project a 
burst test pattern and adjust the sampling for the minimum noise.  

~ Horizontal Total — sets the total pixel count per line.  

~ Horizontal Active — sets the width of the active area.

~ Horizontal Position — sets the start of the active area’s horizontal offset 
from H sync.

~ Vertical Total — fixed value which cannot be adjusted.

~ Vertical Active — sets the number of vertical lines in the image.  

~ Vertical Position — sets the start of the active area’s vertical offset from 
V sync.

• The Color Balance section provides tabs for R, G and B — each of which has 
sliders and spinners for contrast and brightness.  

• Adjustment range: -25% to +25%

• Save — Click Save to save the input in its designated input file.  

Still Frame Background Properties

The figure below illustrates the Background Properties Dialog with one of the three still 
frame buffers selected.

Figure 5-86.  Background Properties Dialog - still frame buffer type  (sample)

Use the drop-down menu to select Still Frame Buffer 1, 2 or 3 to use as the background.  
Please note:

• Use the Freeze and Capture buttons to capture a still from an Analog or DVI input 
which has been selected as the background.

• You can also use the Stills Tab to recall stills from memory, back into a selected 
frame buffer, for use as a background.
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The DSK Properties Dialog provides the tools necessary to adjust the DSK (Downstream 
Key).  For the DSK, you can elect to key a dedicated physical M/E input or one of the 
system’s capture frames.  The dialog changes depending on the selected DSK “type.”  

The following topics are discussed in this section:

• Shared DSK Properties Dialog Functions

• DVI DSK Properties

• Analog DSK Properties

• Still Frame DSK Properties

Shared DSK Properties Dialog Functions

The figure below illustrates the top section of the DSK Properties Dialog, which is shared 
between all selected DSK types:

Figure 5-87.  DSK Properties Dialog - shared section

• Force Acquire — For DVI and Analog DSK types, click to automatically detect 
the input signal resolution and acquire the selected input.  The button is grayed 
out when either a Still Frame DSK type or “None” is selected. 

• All — For single screen destinations, this check box and the Processor drop-
down menu are both grayed out.  In widescreen configurations, different DSKs 
can be assigned to different video processors, thus the All check box and the 
Processor drop-down menu are active.

~ Enable the All check box to create a DSK across all video processors.

~ Disable the All check box to create individual DSKs for different video 
processors.  In this case use the Processor drop-down menu to select 
the specific processor for which you want to create a DSK. 

• Freeze — For DVI and Analog DSK types, click to freeze the selected full screen 
input signal, in preparation for capturing it into a frame buffer.  The button is 
grayed out when either a Still Frame DSK type or “None” is selected. 

Note Refer to the “Background and DSK Connections” section 
on page 118 for important background information on DSK 
inputs and sources.
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• Capture — For DVI and Analog DSK types, click to capture the input into the 
selected frame buffer, as chosen with the Frame Buffer drop-down menu.  The 
button is grayed out when either a Still Frame DSK type or “None” is selected.  

• Input — use the pull-down menu to select the physical video processor input to 
which the desired DSK source is connected — either 1A or 1B.

• Type — use the pull-down menu to select the desired DSK type:

~ Select None to turn the DSK circuitry for a selected Processor off.  

~ Select DVI to use a digital graphic from a computer or other DVI source 
as the DSK.  Refer to the “DVI DSK Properties” section on page 126 for 
details. 

~ Select Analog to use an analog graphic from a computer (or other 
analog source) as the DSK.  Refer to the “Analog DSK Properties” 
section on page 129 for details.

~ Select Still Frame Buffer 1, 2 or 3 to use a frame grab as the DSK.  
Refer to the “Still Frame DSK Properties” section on page 131.

Note All frame grabs are full screen captures.  In Chapter 7, refer 
to the “Working with Frame Grabs” section on page 184.

Tip This selection is recommended when a DSK is only needed 
on the last screen in a widescreen configuration (such as a 
bug), and when only a single head graphics card is required.
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DVI DSK Properties

When a DVI source is selected for the DSK, three tabs are provided in the dialog:

• DVI DSK, Input Tab Selected

• DVI DSK, Key Tab Selected

• DVI DSK, Crop Tab Selected

DVI DSK, Input Tab Selected

The figure below illustrates the DSK Properties Dialog with the following selections made:

• DVI type 

• Input tab

Figure 5-88.  DSK Properties Dialog - DVI Type, Input Tab  (sample)

The following functions are provided for a DVI DSK source with the Input Tab selected:

• Video Format — this section performs two functions:

~ The field displays the resolution that is automatically determined by the 
Force Acquire function. 

~ Use the pull-down menu to manually set the resolution of the incoming 
DVI source.    

• For the two settings in the Crop Offset section:

~ If the source’s input resolution matches the output resolution, or if output 
resolution is larger than input resolution, Crop settings are grayed out.  

~ If input data is smaller than the output resolution, the area around the 
active data is set to black, and input data is centered in the screen.

~ If the source’s input resolution is larger than the output resolution, the H 
Crop Offset and V Crop Offset sliders and spinners can be used to 
choose which portion of the DSK you want to display.  

• Click Save to save the selected DSK input configuration.
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DVI DSK, Key Tab Selected

The figure below illustrates the DSK Properties Dialog with the following selections made:

• DVI type 

• Key tab

Figure 5-89.  DSK Properties Dialog - DVI Type, Key Tab  (sample)

The following functions are provided for a DVI DSK source with the Key Tab selected:

• Key Type — the DSK key type is fixed as Luma (luminance).  

• Fill Source — the fill source (the video that fills the key hole) is fixed as Self.  

• Clip — adjusts the threshold of the video that “cuts” into the background image.  A 
hole will be cut into the background anywhere that the DSK source’s luminance is 
greater than the clip level.  The hole is then filled with the Fill Source.  

~ Adjustment range:  0 to 1023

• Gain — adjusts the sensitivity of the keyer, enabling you to change the sharpness 
of the keyed image.  Gain only affects the key hole, as set by the clip.  

~ Adjustment range:  0 to 1023.99

• Opacity — enables you to adjust the opacity of the keyed image, from fully 
opaque to fully transparent.  

~ Adjustment range:  0 to 1024

• Click Save to save the selected DSK input configuration.
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DVI DSK, Crop Tab Selected

The figure below illustrates the DSK Properties Dialog with the following selections made:

• DVI type 

• Crop tab

Figure 5-90.  DSK Properties Dialog - DVI Type, Crop Tab  (sample)

The following functions are provided for a DVI DSK source with the Crop Tab selected:

• From Top — use the vertical sliders and spinners to crop video from the top edge 
of the DSK.  

• From Bottom — use the vertical sliders and spinners to crop video from the 
bottom edge of the DSK.  

• From Left — use the horizontal sliders and spinners to crop video from the left 
edge of the DSK source.  

• From Right — use the horizontal sliders and spinners to crop video from the right 
edge of the DSK.  

• Click Save to save the selected DSK input configuration.
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Analog DSK Properties

When an Analog source is selected for the DSK, three tabs are provided in the dialog:

• Analog DSK, Input Tab Selected

• Analog DSK, Key Tab Selected

• Analog DSK, Crop Tab Selected

Analog DSK, Input Tab Selected

The figure below illustrates the top and bottom portion of the DSK Properties Dialog with 
the following selections made:

• Analog type 

• Input tab

Figure 5-91.  DSK Properties Dialog - Analog Type, Input Tab  (sample)

The following functions are provided for an Analog DSK with the Input Tab selected:

• Video Format — this section performs two functions:

~ The field displays the resolution that is automatically determined by the 
Force Acquire function. 

~ Use the pull-down menu to manually set the resolution of the incoming 
Analog source.    

• For the two settings in the Crop Offset section:

~ If the source’s input resolution matches the output resolution, or if output 
resolution is larger than input resolution, Crop settings are grayed out.  

~ If input data is smaller than the output resolution, the area around the 
active data is set to black, and input data is centered in the screen.
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~ If the source’s input resolution is larger than the output resolution, the H 
Crop Offset and V Crop Offset sliders and spinners can be used to 
choose which portion of the DSK you want to display.  

• Contrast — use the slider and spinner to set the analog DSK’s contrast.  

~ Adjustment range:  75% to 125%

• Brightness — use the slider and spinner to set the analog DSK’s brightness.  

~ Adjustment range:  75% to 125%

• 1:1 Sizing — This section provides the following controls: 

~ Clock Phase — sets the system’s A/D converter, allowing you to select 
where pixels are sampled (ideally, on the pixel’s peak).  

• Adjustment range: -16 to 15  

For best visual results when adjusting high-resolution sources, project a 
burst test pattern and adjust the sampling for the minimum noise.  

~ Horizontal Total — sets the total pixel count per line.  

~ Horizontal Active — sets the width of the active area.

~ Horizontal Position — sets the start of the active area’s horizontal offset 
from H sync.

~ Vertical Total — fixed value which cannot be adjusted.

~ Vertical Active — sets the number of vertical lines in the image.  

~ Vertical Position — sets the start of the active area’s vertical offset from 
V sync.

• The Color Balance section provides tabs for R, G and B — each of which has 
sliders and spinners for contrast and brightness.  

• Adjustment range: -25% to +25%

• Save — Click Save to save the DSK in its designated input file.  

Analog DSK, Key Tab Selected

When an analog source is selected for the DSK and the Key Tab is selected, functions are 
identical to those provided when a DVI source is selected.  Refer to the “DVI DSK, Key Tab 
Selected” section on page 127 for details. 

Analog DSK, Crop Tab Selected

When an analog source is selected for the DSK and the Crop Tab is selected, functions are 
identical to those provided when a DVI source is selected.  Refer to the “DVI DSK, Crop 
Tab Selected” section on page 128 for details. 
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Still Frame DSK Properties

When a still frame buffer is selected as the DSK source, two tabs are provided in the dialog 
(and the Crop Tab is grayed out):

• Still Frame DSK, Input Tab Selected

• Still Frame DSK, Key Tab Selected

Still Frame DSK, Input Tab Selected

The figure below illustrates the DSK Properties Dialog with the following selections made:

• Still Frame Buffer type (one of three selected)

• Input tab

Figure 5-92.  DSK Properties Dialog - still frame buffer type, Input Tab  (sample)

Use the drop-down menu to select Still Frame Buffer 1, 2 or 3 to use as the DSK source.  
Please note:

• Use the Freeze and Capture buttons to capture a still from an Analog or DVI input 
which has been selected as the DSK.

• You can also use the Stills Tab to recall stills from the library (memory) back into 
a selected frame buffer, for use as a DSK source.

Still Frame DSK, Key Tab Selected

When a still frame buffer is selected for the DSK and the Key Tab is selected, functions are 
identical to those provided when a DVI source is selected.  Refer to the “DVI DSK, Key Tab 
Selected” section on page 127 for details. 
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The figure below illustrates the Layer Control Section, which enables you to control the 
“look” on Program and Preview for the selected destination.  Using the buttons, you can 
enable or disable layers, backgrounds and the DSK.  In conjunction with the controls in the 
Source/Preset Section, you can assign sources to PIPs and Keys, and control up to six 
layers (on up to three mixers).  

Figure 5-93.  Layer Control Section  (sample)

• The Program Row controls layers directly on the video processor’s Program 
output.  Green buttons are provided for backgrounds A and B, the DSK and 
Black.  Blue buttons are provided for layers 1A through 3B. 

~ When a button is clicked on, it turns red — and the layer immediately 
cuts to Program (for the selected destination).

~ When a button is clicked off, it returns to its default “dim” color — and the 
layer immediately cuts off Program.

~ When a button is gray, the layer is not available.  

• The Preview Row controls layers on the processor’s Preview output.  Green 
buttons are provided for backgrounds A and B, the DSK and Black.  Blue buttons 
are provided for layers 1A through 3B.

~ When a layer button is clicked on, it glows bright, and the layer is 
enabled on Preview — in preparation for a transition to Program.

~ When a layer button is clicked off, it returns to its default color, and the 
layer is cleared from Preview — in preparation for a transition off of the 
Program output.

~ When a button is gray, the layer is not available.     

Two transition buttons and a spinner are also provided on the Preview Row:

~ Click Clear All to clear all layers from Preview.

~ Click Cut to instantly cut the Preview’s look to Program.  

~ Click Auto Trans to perform a smooth transition of the Preview’s look to 
Program.  Note that auto transitions can not be paused. 

Note In the Menu Bar, click View > Program or View > Preview 
And Program to see the results of any “Program Row” 
actions on the Palette.  Watch your physical Program Monitor 
output to see the actual video from all Program Row changes.

Note In the Menu Bar, click View > Preview or View > Preview 
And Program to see the results of any “Preview Row” 
actions immediately on the Palette.  Watch your physical 
Preview Monitor output to see the actual video from all 
Preview Row changes.
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~ Use the Transition Rate spinner (above the Auto Trans button) to 
adjust the transition rate, from 0.0 to 120.0 seconds.  

• Remember that the buttons (layers) on the Preview Row are critical for setting up 
a transition to the next look.  For example:

~ If layer 1A is off Program but enabled on Preview, it will transition on to 
Program when Cut or Auto Trans is clicked. 

~ If layer 1A is on Program and also enabled on Preview, it will not  
transition off of Program when Cut or Auto Trans is clicked.  Here, there 
is no difference between the Program and Preview states of the layers.

~ If layer 1A is on Program and disabled on Preview, it will transition off of 
Program when Cut or Auto Trans is clicked. 

These rules hold true for multiple layers, backgrounds, the DSK and Black, and all 
combinations of different layers.

• Once a transition completes (either Cut or Auto Trans), buttons on the Program 
Row change color accordingly.  For example:

~ If 1A is off Program but enabled on Preview, it turns red on Program 
once the transition interval completes. 

~ If 1A is on Program (and glowing red) but disabled on Preview, it returns 
to its default “dim” color on Program once the transition completes. 

pçìêÅÉLmêÉëÉí=pÉÅíáçå
The buttons in the Source/Preset Section enable you to select sources for the active 
PIP(s) or Key(s) on the Palette — those that are enabled in the Layer Control Section.  In 
addition, you can also learn, recall and delete Presets.  

The following topics are discussed in this section:

• Source Section

• Preset Section

• Resource Conflicts

pçìêÅÉ=pÉÅíáçå
The figure below illustrates the Source/Preset Section, with the Source Section selected.

Figure 5-94.  Source Section  (sample)

• The Source Section provides four pages of 16 source buttons each, 
corresponding directly to the 64 available sources that can be configured and 
named on the Sources Tab.  

• To assign a source to a PIP or Key, simply click the desired layer in the Palette, 
then click the desired source button.

• The buttons in this section are completely linked with other system tabs, and the 
buttons are enabled (or disabled) depending on many factors:  
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~ When sources are named and inputs are assigned on the Sources Tab, 
this determines the buttons that are enabled in the Source Section, and 
the labels that appear on the buttons themselves.

~ When router outputs are patched on the Output Patch Tab and inputs 
are assigned on the Sources Tab, these factors determine only those 
layers into which sources can be assigned on the Palette.  

For example:

• If router output 1 is patched to a processor’s physical input 1A 
(which appears as logical input 3A on the Encore GC), clicking 
layer 3A on the Palette causes only those sources assigned 
from that router to appear in the Source Section.    

• Similarly, if router output 2 is patched to your processor’s 
physical input 3A (which appears as logical input 1A), clicking 
layer 1A on the Palette causes only those sources assigned 
from that router to appear in the Source Section.

In this manner, the array of buttons in the Source Section will change 
depending on which layer is clicked in the Palette.

mêÉëÉí=pÉÅíáçå
The figure below illustrates the Source/Preset Section, with the Preset Section selected.

Figure 5-95.  Preset Section  (sample)

• The Preset Section provides four pages of 16 buttons each, corresponding 
directly to the 64 Presets that can be stored and recalled in the Encore GC 
system.  Each button represents one “look” of the selected destination, including 
the current state of all mixers, layers, sources, backgrounds and the DSK.

• Button color is important:

~ Gray buttons are empty Preset registers. 

~ Dim Yellow buttons represent stored presets (such as button 1 above).

~ Bright Yellow buttons represent “selected” active presets (such as button 
2 above) that have been recalled to Preview.

• Click Learn, then click a Preset button to learn the current “look” into a Preset 
register.  You can learn to an empty register, or you can overwrite one in which a 
Preset is already stored.  Please note:

~ When you click Learn, all empty Preset register buttons glow white.

~ When you overwrite a register that already contains a Preset, there is no 
confirmation dialog.  

• Click Delete, then click a Preset button to delete that preset.  There is no 
confirmation dialog when you delete, so please use care when deleting. 
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• To recall a preset to Preview, simply click its button:

~ If any layers within the recalled Preset’s “look” are already on Program, 
they will not change position on the Palette, but on the physical Preview 
output, raster boxes will change position to indicated the “next” look.

~ If any layers within the recalled Preset’s “look” are not on Program, they 
will appear both on the Palette and the physical Preview output. 

• To transition a recalled Preset to Program, click Auto Trans or Cut.  If there are 
no resource conflicts (see the “Resource Conflicts” section below), all recalled 
layers will move from point to point per the recalled look, or dissolve on/off 
Program as required.  Note that the current transition rate in the Layer Control 
Section will be used for all transitions. 

• Preset can be used in conjunction with “manual” Program/Preview transitions (as 
selected and performed in the Layer Control Section) without restriction.

oÉëçìêÅÉ=`çåÑäáÅíë
Resources, as they apply to Presets, are the layers that comprise the current “look.”  

• The contents of a Preset are locked to the mixers from which they were originally 
stored.  For example, if you store a Preset that only has Layers 1A and 1B 
enabled on Preview, that Preset can only be recalled into Mixer 1.

• When you store a Preset, you are not only recording the entire look, but you are 
also recording the priorities of the individual layers (PIPs and Keys) as selected in 
the Layer Control Section.  

• When you recall a Preset, you are recalling the entire look, and all previously 
stored priorities — PIPs, Keys, colors, sources, etc.

If a resource conflict occurs when you click to recall a Preset, the Alert Dialog appears:

Figure 5-96.  Resource Conflict Alert Dialog  (sample)

The dialog lists all “discovered” conflicts in the “Error Message” section.  These include:

• No available destination

• No valid info for VP [n]

• DSK is on Program

• BG_A is on Program

• BG_B is on Program

• Mixers are on Program

• Cannot set ME mode
Encore GC and ECU  •  User’s Guide 135



5.  Menu Orientation
Destination Control Tabs
At the bottom of the dialog, three options are provided:

• Click Auto Resolve to pull the conflicting resources smoothly off of Program, and 
place the “requested” resources on Preview.

• Click Auto Resolve and Transition to pull the conflicting resources smoothly off 
of Program, place the “requested” resources on Preview, and smoothly transition 
the new “look” to Program.  

• Click Close to close the dialog, but take no action on Preview or Program.  This 
option enables you to make your own choices with regard to resolving the conflict, 
or selecting another “non-conflicting” Preset.  

In Chapter 7, refer to the “A Word About Resources” section on page 167 for more 
information about resource conflicts.

jáñÉê=`çåíêçä=pÉÅíáçå
The Mixer Control Section provides expandable sections that enable you to configure the 
specific settings for each available mixer.  All sections are identical, and one section will be 
provided for each M/E in your video processors.  The figure below illustrates the Mixer 
Control Section with Mixer 1 expanded:

Figure 5-97.  Mixer Control Section, Mixer 1 expanded  (sample)

Each mixer has two layers, A and B, and each can be assigned to either PIP or Key 
functionality.  (In Chapter 1, refer to the “A Word About Layers” section on page 20 for 
details.)  The controls in each Mixer Control Section are designed for easy layer setup 

Important Both of the “resolve” options affect the Program video output, 
but are designed in such a way as to appear very smooth to 
the viewer, rather than abrupt. 
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and adjustment, and many controls are duplicates of those found in the Palette dialogs.  

The following controls are provided:

• Mode — Use the drop-down menu to select one of four different transition modes:

Figure 5-98.  Mode drop-down menu

~ Select Split to operate the mixer’s two layers independently.  You can 
independently transition the following combinations of effects:

• One or two PIPs

• One or two Keys

• One PIP and one Key

~ Select Mix-Src (Mix Source) to perfectly co-locate both mixers after 
every transition.  Layers A and B are exactly the same vertical size — in 
exactly the same position — with exactly the same border and shadow.  

This mode is ideal for transitioning images inside a static PIP.  Even 
though two identical PIPs are used, they visually appear as one, 
provided that they are both the same aspect ratio.  

~ Select Swap to locate both layers independently, with different positions, 
sizes, borders and shadows.  Layers A and B can be positioned and 
sized as desired — but only one can be on screen at a time.

~ Select Key Cut/Fill to cut a key hole with video from Layer B, and fill 
with video from Layer A.  In this mode, the two layers can be 
manipulated independently, and labels on the individual layers in the 
Palette change to “Key Cut” and “Key Fill” accordingly.  

• In the Preview section, the following controls affect PIPs and Keys on Preview:

Figure 5-99.  Mixer Preview section  (sample)

Note Controls for a particular layer will be grayed out if that layer is 
currently on Program.

Note In this mode, two PIPs will be the same vertical size, but may 
differ in horizontal size, for example, if one layer is 4:3 and the 
other layer is 16:9.
Encore GC and ECU  •  User’s Guide 137



5.  Menu Orientation
Destination Control Tabs
~ Enable the Swap Z-Order check box to swap the priority of two layers in 
the same mixer.  In Split mode only, the function works with two Keys, 
two PIPs, or one of each.  

~ Enable the Border check box to place a border around a PIP on layer A 
or B.  This function is identical to the Enabled check box at the top of the 
Border Properties Dialog.  

~ Enable the Shadow check box to place a shadow underneath a PIP on 
layer A or B.  This function is identical to the Enabled check box at the 
top of the Shadow Properties Dialog.  

~ Enable the Key check box to change a PIP to a Key.  Disable the check 
box to return to a PIP.  This function is identical to the Enabled check 
box at the top of the Key Properties Dialog.  

• In the Scalers section, precision controls are provided for adjusting the PIP or 
Key’s position, width and height:

Figure 5-100.  Mixer Scalers section  (sample)

~ For both scalers A and B, the X and Y spinners change as you manually 
click and drag a PIP or Key around the Palette.  For precision placement 
or adjustment, however, use the X and Y spinners to manually position a 
PIP or Key along the Palette’s X-Axis or Y-Axis, respectively.    

~ For both scalers A and B, the Width and Height spinners change as you 
manually scale a PIP or Key (by clicking and dragging on an edge).  For 
precision width and height adjustment, however, use the Width and 
Height spinners to manually scale a PIP or Key’s size.  

Note When Swap Z-Order is enabled, the priority visually changes 
on the Palette, and the red labels on the PIPs and Keys 
themselves indicate the change. 

Note Note that the Lock Aspect Ratio control on the PIP/Key 
Pop-up Menu affects whether or not the Width and Height 
adjustments track together, or can be independently adjusted.
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If two or more destinations are configured, select the Multiple Destinations Tab to 
configure Presets that affect multiple destinations simultaneously.  The figure below 
illustrates the Multiple Destination Tab.

Figure 5-101.  Multiple Destination Tab  (sample) 

The Multiple Destination Tab is divided into two sections:

• Destinations Section

• Presets Section

aÉëíáå~íáçåë=pÉÅíáçå
The top Destinations Section provides 32 latching buttons, representing the maximum 
number of destinations for which the Encore GC system is capable of supporting.  Any 
combination of destinations can be selected:

• Dim turquoise buttons represent “unselected” configured destinations.  

• Bright turquoise buttons represent “selected” destinations.  

• Gray buttons represent un-configured destinations.

At the right, three controls work in conjunction with the selected Preset in the Presets 
Section (at the bottom of the tab).  For all enabled destinations:

• Click Cut to instantly cut all layers that are enabled on Preview to the Program 
output.  

• Click Auto Trans to perform a smooth transition of all layers enabled on Preview 
to Program.  

• Use the Transition Rate spinner (below the Auto Trans button) to adjust the 
transition rate, from 0.0 to 120.0 seconds.  
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The bottom Presets Section provides four pages of 16 buttons each, corresponding to the 
64 Presets that can be stored and recalled in the system.  Each button represents one 
“look” of all selected destinations, including the current state of all mixers, layers, sources, 
backgrounds and DSKs.  

• Button color is important:

~ Gray buttons are empty Presets. 

~ Dim Yellow buttons represent stored multi-destination presets.

~ Bright Yellow buttons represent “selected” active presets that have been 
recalled to Preview — for all selected destinations.

• For all enabled destinations:

~ Click Learn followed by a selected Preset button to learn the current 
“looks” into a register.  You can learn to an empty register, or you can 
overwrite one in which a Preset is already stored.  

• When you click Learn, all empty register buttons glow white.

• When you overwrite a register that already contains a Preset, 
there is no confirmation dialog.  

~ Click Delete followed by a selected Preset to delete that preset.  There is 
no confirmation dialog. 

• To recall a preset to Preview for all selected destinations, simply click its button.

• To transition a recalled Preset to Program, click Auto Trans or Cut in the 
Destinations Section.  If there are no resource conflicts (see the “Resource 
Conflicts” section on page 135), all recalled layers will move from point to point 
per the recalled look, or dissolve on/off Program as required.  Note that the 
current transition rate will be used for all transitions.

Note The entire Encore GC system has one set of 64 Presets, 
which can be stored and recalled throughout the system.  
These Presets can be single destination or multi-destination. 

Important Prior to learning a Preset that includes multiple destinations, 
ensure that the desired “individual” destination looks are set 
up on Preview on their respective Destination Control Tabs.
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When the Encore GC system is offline, click File > Load Demo Cfg to place the system in 
demonstration mode:

Figure 5-102.  File Menu in Offline mode

The “demo” version of Encore GC is pre-configured with two destinations — one single 
screen and one widescreen, and the version enables you to explore all tabs, menus and 
features.  In addition, you can also explore the Multiple Destinations Tab, which only 
appears when two (or more) destinations are configured.   

To exit the demo mode, click Discover ECU on the System Tab. 

Note In “demo” mode, you cannot save Presets and the “System 
Save” function is grayed out.
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få=qÜáë=`Ü~éíÉê
This chapter provides comprehensive instructions for setting up the Encore GC system.  
The following topics are discussed:

• Setup Prerequisites

• System Setup Sequence

• ID Setup and System Power-up

• Installing Encore GC Software

• Launching the Encore GC Application

• Updating ECU and Processor Software

• Resetting Software

• Destination Setup

• Router and DA Setup

• Patching Outputs

• Patching Sources

• Verifying Output and Source Patches

• Projector Setup

• Input Setup

• Background Setup

• DSK Setup

• Saving the System Configuration

Note Once you have reviewed all of the sections in this chapter, 
please continue with Chapter 7, “Operations” on page 163.
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Before starting to set up your Encore GC system, please review the following prerequisites:

• Ensure that you are familiar with all Encore GC system hardware.  Refer to 
Chapter 2, “Hardware Orientation” on page 29 for details.

• Ensure that all hardware is properly installed, and that all sources, routers and 
peripherals are properly connected.  Refer to Chapter 3, “Hardware Installation” 
on page 33 for details.

• Ensure that you are familiar will all Encore GC menus.  Refer to Chapter 5, “Menu 
Orientation” on page 61 for details.  

póëíÉã=pÉíìé=pÉèìÉåÅÉ
This section provides a top level view of the entire Encore GC setup procedure, plus links 
to each individual sequence.  Please note:

• The first few procedures point to steps already covered in Chapter 4, “Getting 
Started” on page 43.  Links are included here, so as to provide a complete view of 
the entire setup sequence.

• Many procedures add information to procedures that were partially covered in 
Chapter 4, “Getting Started.”  The remainder of procedures provide new, 
important setup information that is vital to configuring the Encore GC system.

The entire Encore GC setup sequence is outlined below.

1. “ID Setup and System Power-up,” page 145.

2. “Installing Encore GC Software,” page 145.

3. “Launching the Encore GC Application,” page 145. 

4. “Updating ECU and Processor Software,” page 145. 

5. “Resetting Software,” page 146. 

6. “Destination Setup,” page 146. 

7. “Router and DA Setup,” page 149.

8. “Patching Outputs,” page 149.

9. “Patching Sources,” page 150.

10. “Verifying Output and Source Patches,” page 152.

11. “Projector Setup,” page 153.

12. “Input Setup,” page 155.

13. “Background Setup,” page 158.

14. “DSK Setup,” page 160.

15. “Saving the System Configuration,” page 162.

Important For the optimum Encore GC setup, it is recommended that 
you follow all procedures in the order outlined below.
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fa=pÉíìé=~åÇ=póëíÉã=mçïÉêJìé

Encore GC setup:  Step 1.

This procedure provides instructions for setting up Encore VP, VPx and ScreenPRO-II IDs 
and powering up your Encore GC and ECU system.  Each unit in your system must have a 
unique ID.  

In Chapter 4, refer to the “ID Setup and System Power-up” section on page 45 for 
instructions.  When complete, please continue with the “Installing Encore GC Software” 
section below.

fåëí~ääáåÖ=båÅçêÉ=d`=pçÑíï~êÉ

Encore GC setup:  Step 2.

For “first time” system installations, use this procedure to install Encore GC software.  In 
Chapter 4, refer to the “Installing Encore GC Software” section on page 46 for 
instructions.  When complete, please continue with the “Launching the Encore GC 
Application” section below.

i~ìåÅÜáåÖ=íÜÉ=båÅçêÉ=d`=^ééäáÅ~íáçå

Encore GC setup:  Step 3.

Use this procedure to launch the Encore GC application and connect to the ECU.

Prerequisite — Ensure that you are familiar with the System Tab.  In 
Chapter 5, refer to the “System Tab” section on page 71.

In Chapter 4, refer to the “Launching the Encore GC Application” section on page 50 for 
instructions.  When complete, please continue with the “Updating ECU and Processor 
Software” section below.

réÇ~íáåÖ=b`r=~åÇ=mêçÅÉëëçê=pçÑíï~êÉ

Encore GC setup:  Step 4.

If required, use this procedure to update ECU and video processor software to match that 
of the Encore GC.

Prerequisite — Ensure that you are familiar with the System Tab.  In 
Chapter 5, refer to the “System Tab” section on page 71.

In Chapter 4, refer to the “Updating ECU and Processor Software” section on page 52 for 
instructions.  When complete, please continue with the “Resetting Software” section on 
page 146.

1

2

3

4
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Encore GC setup:  Step 5.

If required, use this procedure to reset the ECU and all video processors to their factory 
default settings.

Prerequisite — Ensure that you are familiar with the System Tab.  In 
Chapter 5, refer to the “System Tab” section on page 71.

In Chapter 4, refer to the “Resetting Software” section on page 54 for instructions.  When 
complete, please continue with the “Destination Setup” section below.

aÉëíáå~íáçå=pÉíìé

Encore GC setup:  Step 6.

This procedure enables you to set up your system’s destinations.  Note that this is the 
complete procedure, which was partially covered in Chapter 4.  

Prerequisite — Ensure that you are familiar with the Destination Setup Tab.  
In Chapter 5, refer to the “Destination Setup Tab” section on page 76.

Use the following steps to set up or add destinations to your Encore GC system.  

1. Click the Destination Setup Tab.  Remember that at first startup, the left-hand 
Destination Table is completely empty.

2. In the Destination Table, click the row for the destination number that you wish to 
set up.  Any row can be selected.  

3. In the right-hand Destination Settings Section, enter a name for the new 
destination in the Name field, if desired.  Otherwise, use the default name 
provided by the system (e.g., Dest 1, Dest 2, etc.).

4. Click the Type drop-down menu to choose the type of destination.  The 
destination choices are Single Screen VP, Single Screen SP and Wide Screen VP.

Remember that in the Destination Settings Section, different sections appear 
and disappear, depending on the destination type.

5. Click the “+” adjacent to the Processor Selection heading to expand the section.  

Figure 6-1.  Processor Selection heading

6. To add processor(s) to the destination, highlight the processor(s) in the Available 
column, then click << to transfer the processor(s) to the Added (Master) column.  

7. When all processors have been assigned for the selected destination, click Apply.

8. Click the “+” adjacent to the Output Settings heading to expand the section.  

Figure 6-2.  Output Settings heading

5

6
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9. Use the Format drop-down menu to set the resolution and frame rate at which 
you want to drive your projector.  

10. Use the Gamma spinner to set the output gamma. 

11. Use the Raster Box Size spinner to set the size of the raster box that appears 
around PIPs and Keys.  

12. Use the Color Space radio buttons to set the output’s color space.

13. Use the Sync drop-down menus to set the sync parameters for your Preview, 
Program 1 and Program 2 monitors. 

14. Use the SOG / Y drop-down menus to select a specific “sync on green” signal for 
your Preview, Program 1 and Program 2 monitors. 

15. Use the Source drop-down menu to set the genlock source that is connected to 
the Processor’s Genlock connector.

16. Click Apply to enter all changes.

17. Click the “+” adjacent to the EDID Setting heading to expand the section.  

Figure 6-3.  EDID Setting heading

This section enables you to update the system’s preferred EDID resolution for the 
processor’s DVI inputs — for the selected destination bus. 

18. Use the Select Format drop-down menu to select the preferred DVI video format 
with which you want to program the system’s EDID non-volatile memory.

19. Click Apply to apply the new EDID format, and send the parameters to the ECU.  
When you click Apply, an alert is shown:

~ If required, click Cancel to stop the procedure without changing the 
current format.

~ To proceed, ensure that all DVI inputs to each VP are disconnected, then 
click OK to apply the new EDID format.

~ After a minute, when EDID programming is complete, re-connect DVI 
inputs to the VP, then reboot the external computer(s).

Note that the Processor’s EDID PROM is not reset to any default during a factory 
reset.  To change the EDID, you must use the EDID Setting Section.

20. For widescreen destinations only, click the “+” adjacent to the Widescreen 
Settings heading to expand the section.  

Figure 6-4.  Widescreen Settings heading  

Note This function is designed for advanced users only.  Do not 
program EDID unless it is necessary.

Note Refer to the “Wide Screen Projector Setup” section on 
page 154 for wide screen setup instructions.
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21. For ScreenPRO-II destinations only, click the “+” adjacent to the Routing Modes 
heading to expand the section.  

Figure 6-5.  Routing Modes heading

22. Use the Analog Routing Mode radio buttons to set the selected ScreenPRO-II’s 
eight analog inputs to either Internal or External routing mode.  

23. If applicable, use the SDI Routing Mode radio buttons to set the selected 
ScreenPRO-II’s two SDI inputs to either Internal or External routing mode.  

24. Click Apply to enter all changes.

25. For all types of destinations, click the “+” adjacent to the Test Patterns heading to 
expand the section.  

Figure 6-6.  Test Patterns heading

This section enables you to control test patterns and raster boxes for a VP’s three 
outputs — Preview, Program 1 and Program 2.  Controls are similar for each.

26. Use the Raster Box check box to enable or disable a raster box, as defined by 
the exact outer edges of the output resolution.  

27. Use the Test Pattern drop-down menus to set the desired test pattern.  

28. Click Apply to enter all changes to your selected test patterns.

29. Click Apply All at the top of the Destination Settings Section to enter all 
changes, and send the parameters to the ECU.  

30. Repeat the entire procedure from step 2 to add additional destinations, provided 
that video processors are available.   

31. In the Menu Bar, click ECU > Save Configuration.  

When complete, please continue with the “Router and DA Setup” section below.

Note Once you click Apply All, the Destination Table fills in with 
the new destination.  In addition, a new tab appears for the 
newly created destination (to the left of the System Tab) — 
indicating that a valid destination is now available.

Note If you need to delete a destination, highlight the destination in 
the Destination Table and press Delete on your keyboard.
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Encore GC setup:  Step 7.

Use this procedure to set up your system’s routers and DAs.  Up to eight routers can be 
configured.  These steps must be followed precisely, so that all routers will be properly 
recognized on the System Tab. 

Prerequisite — Ensure that you are familiar with the Routers Tab.  In 
Chapter 5, refer to the “Routers Tab” section on page 86.

In Chapter 4, refer to the “Router and DA Setup” section on page 57 for instructions on 
setting up routers and DAs.   

When complete:

• In the Menu Bar, click ECU > Save Configuration.

• Please continue with the “Patching Outputs” section below.

m~íÅÜáåÖ=lìíéìíë

Encore GC setup:  Step 8.

Use this procedure to patch router outputs to various video processor inputs.  

Prerequisite — Ensure that you are familiar with the Output Patch Tab.  In 
Chapter 5, refer to the “Output Patch Tab” section on page 91.

Use the following steps to patch router outputs to video processor inputs.    

1. Click the Output Patch Tab.  Remember that the tab is divided in half:

~ On the left, the Router Outputs Section lists each router, with folders 
representing each format, and individual lines representing each output.  

~ On the right, the Device Inputs Section lists all video processors that 
are configured in your system.

2. In the Router Outputs Section, open up the folder for the first router that you 
want to patch — and note its format (e.g., DVI, SDI, Analog).

3. In the Device Inputs Section, open up the target folder for processor to which 
you want to patch inputs.  Ensure that you open the folder that matches the 
router’s format. 

7

Note If you need to delete a router or DA, highlight the desired 
router or DA in the Router Table and press Delete on your 
keyboard.

8

Note Before you patch outputs, it is strongly recommended that 
you complete a set of “connection charts” for your Encore 
GC and ECU system.  In Chapter 3 of the Encore 
Presentation System User’s Guide, refer to the 
“Connection Charts” section for instructions.
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4. To make a patch, click and hold the desired router output (in the Router Outputs 
Section), and drag it directly on top of the desired device input (in the Device 
Inputs Section), then release the mouse button.  

5. Repeat steps 2 through 4 for each patch.  Note that when each patch is complete, 
each label expands to show the physical input to which the output is now 
connected on the processor (e.g., 1A), and the logical layer in which it will 
appear on the Destination Control Tab (e.g., [3A]).  

6. To check your patches graphically, hold down CTRL and click an individual patch 
(in either column) or an individual folder (in either column) to view the output-to-
input connection graphically.  

7. In the Menu Bar, click ECU > Save Configuration.

When complete, please continue with the “Patching Sources” section below.

m~íÅÜáåÖ=pçìêÅÉë

Encore GC setup:  Step 9.

Use this procedure to patch router sources to specific input buttons on the Destination 
Control Tab(s).  Setup parameters include source name, connection type, router, and the 
desired input number on the GUI.  Selections directly determine the active inputs on the 
Destination Control Tab(s).

Prerequisite — Ensure that you are familiar with the Sources Tab.  In 
Chapter 5, refer to the “Sources Tab” section on page 93.

Use the following steps to patch sources.    

1. Click the Sources Tab.  Remember that the tab is divided in half:

~ On the left, the Source Table lists the parameters for up to 64 sources.  
Remember that the ID number represents the button on which the 
source appears in the Destination Control Tab. 

~ On the right, the Source Parameters Section enables you to configure 
the name, connection type, router, and the router input for each source.

2. Click the row in the Source Table for the button that you wish to set up in the 
Destination Control Tab.

3. In the Source Parameters Section, enter a custom name for the source in the 
Name field (e.g, PC 1, VTR 2, etc.).  

Note If you need to delete an output patch, highlight the desired 
patch in either the Router Outputs Section or the Device 
Inputs Section and press Delete on your keyboard.

9

Note Before you patch sources, it is strongly recommended that 
you complete a set of “connection charts” for your Encore 
GC and ECU system.  In Chapter 3 of the Encore 
Presentation System User’s Guide, refer to the 
“Connection Charts” section for instructions.
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4. Use the Connection Type drop-down menu to select how the specific source is 
connected to the Processor.  

~ Select Router if the source is connected via router.  

~ Select Direct Analog if the source is connected directly to one of the 
processor’s analog inputs.  

~ Select Direct DVI if the source is connected directly to one of the 
processor’s DVI inputs.  

~ Select Direct SDI if the source is connected directly to one of the 
processor’s SD inputs.  

~ Select SP2 if the source is connected directly to a ScreenPRO-II input  
— but if you want all connected ScreenPRO-IIs to switch simultaneously 
to the same input.  

5. If a Router was selected in the Connection Type field:

~ Use the Router drop-down menu to select the router to which the source 
is connected.  

~ Use the Input field to select the specific input connector (on the router) to 
which the source is connected. 

6. If a Direct Connection to a Processor (e.g., Direct DVI, Direct SDI, Direct Analog) 
was selected in the Connection Type field:

~ Use the Processor drop-down menu to select the Processor to which 
the source is directly connected.  

~ Use the Input field to select the specific input connector (on the 
Processor) to which the source is connected (e.g., 1A, 1B, etc.).  Note 
that the Mixer Layer field indicates the layer on which the source 
appears on the Destination Control Tab(s).

7. If SP2 was selected in the Connection Type field:

~ Use the Processor drop-down menu to select the Processor to which 
the source is directly connected.  

~ Use the Input field to select the specific input connector (on the 
Processor) to which the source is connected (e.g., 1-8, SDI 1, SDI 2).

8. If ALL SP was selected in the Connection Type field use the Input field to select 
the specific input (on all ScreenPRO-IIs) to which the source is connected.

9. After data is entered (or changed) for each source, click Apply to send the new 
information to the ECU.

10. Repeat steps 2 through 9 for all additional Destination Control Tab buttons that 
you wish to set up.  

11. In the Menu Bar, click ECU > Save Configuration.

When complete, please continue with the “Verifying Output and Source Patches” section 
below.

Note If you need to delete a source patch, highlight the desired 
patch in the Source Table and press Delete on your 
keyboard.
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Encore GC setup:  Step 10.

Use this procedure to verify all router output and source patches on your various 
destinations.  

Prerequisite — Ensure that you are familiar with the Destination Control 
Tab, and in particular, the tab’s Layer Control Section, Source/Preset 
Section and Palette.  In Chapter 5, refer to the “Destination Control Tabs” 
section on page 139.

Use the following steps to verify output and source patching.  

1. Ensure that your Program and Preview monitors (and projectors) are properly 
configured and connected to the outputs of your video processors.

2. Click a Destination Control Tab.  Remember that one tab appears for each 
destination that you have configured on the Destination Setup Tab.

3. In the Menu Bar, click View > Preview.  This action enables you to view only the 
VP’s preview output in the Palette (for the selected destination).

4. In the Layer Control Section, click layer 1A on the Preview row.  The layer (PIP) 
appears in the Palette, and the source buttons assigned to that layer appear in 
the Source/Preset Section.  Remember that for the selected layer, the location 
and names of these buttons are based on the following factors:

~ The routers configured on the Routers Tab.  

~ The “Router Output” to “Device Input” patches on the Output Patch Tab. 

~ The source (router input) patches on the Sources Tab.

5. In the Source/Preset Section, switch source buttons, and verify that sources 
switch properly on your router and on your Preview monitor.  If a sources does not 
switch properly, first click the “force acquire” button in the source’s Input 
Properties Dialog.  In Chapter 5, refer to the “Input Properties Dialog” section 
on page 114 for details.

If the source still does not display properly, verify the previous setup steps:

~ “Router and DA Setup,” page 149.

~ “Patching Outputs,” page 149.

~ “Patching Sources,” page 150.

6. Press Auto Trans to transition the PIP to Program.  On your Program monitor, 
verify that the PIP transitions properly to Program.  

7. Repeat the procedure from step 4, for layer 2A (if configured).

8. Repeat the procedure from step 4, for layer 3A (if configured).

9. Repeat the procedure from step 2 for all other destinations that you have 
configured.  

When complete, please continue with the “Projector Setup” section below. 

10
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Encore GC setup:  Step 11.

This procedure enables you to set up your projectors for both single screen and 
widescreen destinations. 

Prerequisite — Ensure that you are familiar with the Destination Setup Tab.  
In Chapter 5, refer to the “Destination Setup Tab” section on page 76.

The following procedures are provided:

• Single Screen Projector Setup

• Wide Screen Projector Setup

páåÖäÉ=pÅêÉÉå=mêçàÉÅíçê=pÉíìé
Use the following steps to set up a projector for a single screen destination.  

1. On the Destination Setup Tab, highlight the single screen destination whose 
projector you want to configure.

2. Expand the Test Patterns Section.

3. Enable the Raster Box for the output(s) on which you want a test pattern to 
appear — Preview, Program 1 and/or Program 2.

4. In the drop-down “test pattern” menu(s), select the Burst pattern and click Apply.

5. At the projector itself, perform the following adjustments to ensure that the output 
data is properly displayed:

~ Adjust the image for the minimum amount of noise.

~ Adjust the pixel clock for proper image position, such that the entire 
Raster Box is visible.

6. In the drop-down “test pattern” menu(s), select one of the many Gray Scale test 
patterns and click Apply.

7. At the projector itself, adjust color balance, brightness and contrast.  

8. Once the projector is properly set, turn each Raster Box off, and set the “test 
pattern” drop-down menu to Off.  

9. At the top of the entire section click Apply All to complete the procedure.

10. In the Menu Bar, click ECU > Save Configuration.

11. Repeat from step 1 for additional single screen destination projector setups.

11

Important Refer to your projector’s technical manual for information on 
all projector setup and adjustment procedures. 
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Use the following steps to set up projectors for a wide screen application.  This 
procedure affects all projectors assigned to the selected destination.  

1. On the Destination Setup Tab, highlight the wide screen destination whose 
projectors you want to configure.

2. Expand the Test Patterns Section.

3. Enable the Raster Box for the output(s) on which you want a test pattern to 
appear — Preview, Program 1 and/or Program 2.

4. In the drop-down “test pattern” menu(s), select the Burst test pattern, then click 
Apply.

5. Expand the Widescreen Settings Section.

6. Use the Processors H and V spinners to select the desired horizontal only, 
vertical only, or horizontal plus vertical array.  

7. As required, use the Total Horizontal Resolution and Total Vertical Resolution 
spinners to set the total number of horizontal and vertical pixels in the overall 
array.  Note that in an array that is exclusively horizontal, the vertical field is fixed.

8. Use the Widescreen Markers radio buttons to enable or disable the wide screen 
markers.  

9. Use the Background radio buttons to select how your background graphics were 
originally produced, either Edge-butted or Overlapped.

10. Use the Justification radio buttons to set the desired wide screen justification, 
either Center or Left.    

11. Use the Data Doubling radio buttons to enable or disable data doubling.

12. Use the horizontal and vertical Overlap, Feather and Gamma controls to fine 
tune the desired overlap and feathering between projectors.  

13. Click Apply to enter all changes.

14. At each projector, perform the following adjustments to ensure that the output data 
is properly displayed:

~ Adjust the images for a minimum amount of noise.

~ Adjust the pixel clocks for proper image position, such that the entire 
Raster Box is visible.

15. In the Test Patterns Section, in the drop-down “test pattern” menu(s), select one 
of the many Gray Scale test patterns and click Apply.

16. At the projector itself, adjust color balance, brightness and contrast.  

17. Once each projector is properly set, enable one of the three Alignment Test 
Patterns which are available in the “Program” drop-down test pattern menu — H 
Align, V Align or H and V Align.  

Note As required, you can change the Marker Mode during 
operations without affecting other wide screen settings.

Important Refer to your projector’s technical manual for information on 
all projector setup and adjustment procedures. 
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These special patterns allow you to perform projector lens shift and registration 
adjustments.

a. At each projector, perform lens shift and registration adjustments.  Refer 
to your projector’s technical manual for information on all lens shift and 
registration procedures

b. If required, adjust the horizontal and vertical “totals” to match those 
entered on the Wide Screen Settings Menu.

c. Repeat step 17 for the remaining Alignment Test Patterns.

d. When adjustments are complete, turn off the Alignment Test Pattern 
and click Apply.

18. If required, re-enable edge feathering and data doubling. 

19. At the top of the entire section click Apply All to complete the procedure.

20. In the Menu Bar, click ECU > Save Configuration.

21. Repeat from step 1 for additional wide screen destination projector setups.

When complete, please continue with the “Input Setup” section below. 

fåéìí=pÉíìé

Encore GC setup:  Step 12.

This procedure provides steps for setting up the system’s inputs, for single screen and wide 
screen destinations.  

Prerequisite — Ensure that you are familiar with the Input Properties 
Dialog.  In Chapter 5, refer to the “Input Properties Dialog” section.

The following topics are provided:

• Input Setup — Quick Start

• Input Setup — Comprehensive Method

• Input Setup Notes

fåéìí=pÉíìé=Ô=nìáÅâ=pí~êí
Use the following “quick start” method to set up inputs.   

1. Click the Destination Control Tab for the destination whose inputs you want to 
set up.

2. In the Layer Control Section, click a layer button on Preview (e.g., 1A).  

3. In the Source/Preset Section, select the first source that you wish to set up.

4. In the Palette, right-click the layer’s PIP, and select Input Properties.

5. Enable Source Preview to expand the PIP, display a gray background, and turn 
off borders and shadows.  

6. Click Force Acquire to perform the optimum image setup.

7. Click Save to save the new input configuration.

8. In the Source/Preset Section, select the (next) source that you wish to set up.

12
Encore GC and ECU  •  User’s Guide 155



6.  System Setup
Input Setup
9. Repeat from step 6 for the next source.

10. Repeat from step 1 for the next destination — only if required.  Refer to the “Input 
Setup Notes” section on page 157 for details.  When all inputs have been 
adjusted and saved, click Close to close the Input Properties Dialog.  

fåéìí=pÉíìé=Ô=`çãéêÉÜÉåëáîÉ=jÉíÜçÇ
Use the following “comprehensive” method to set up inputs.   

1. Click the Destination Control Tab for the destination whose inputs you want to 
set up.

2. In the Layer Control Section, click a layer button on Preview (e.g., 1A).  

3. In the Source/Preset Section, select the first source that you wish to set up.

4. In the Palette, right-click the layer’s PIP, and select Input Properties to display 
the Input Properties Dialog.

5. Click Source Preview to expand the PIP, display a gray background, and turn off 
borders and shadows.  

6. Click Force Acquire to perform the optimum image setup.

7. As required, adjust the following basic input properties:

a. To manually set the resolution, use the Video Format drop-down menu.  

b. To manually set the input type, use the Source Type drop-down menu.  
Remember that the choices change depending on the selected Format, 
and in some cases, this function is not available.

c. Use the Color Space radio buttons to set the input’s color space, either 
SMPTE or RGB.  In some cases, this function is not available.

d. Use the Contrast and Brightness spinners to set the input’s contrast 
and brightness.  

e. Use the Sync Type drop-down menu to set the source’s sync type.  

f. Use the Sync Slice spinner to adjust the sync slice as required.

g. Use the Gamma spinner to set the input gamma.

h. Use the Sharpness spinner to set the input’s sharpness.  

8. Adjust the Aspect Ratio Menu if required:

a. Use the Mode drop-down menu to select the aspect ratio.  

b. If Custom is selected as the mode, use the Ratio spinner as required.

9. Use the Motion Threshold spinner to increase or decrease the de-interlacer’s 
sensitivity towards moving content, if required.  

10. Enable the Pulldown Compensation check box if required.  Remember that this 
function only applies to standard video (component, s-video, composite) inputs.

11. Use the Sampling Mode radio buttons to set the sampling mode.

a. If 1:1 Sampling was selected:
• Use the Clock Phase spinner to adjust for the cleanest, 

brightest and sharpest image.
• Use the H Total spinner to set the total pixel count per line.  
• Use the H Active spinner to set the width of the active area.
• Use the H Position spinner to set the start of the active area’s 

horizontal offset from H sync.
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• Use the V Active spinner to set the number of vertical lines in 
the image.  

• Use the V Position spinner to set the start of the active area’s 
vertical offset from V sync.

b. If Oversample was selected:
• Use the Right Edge spinner to adjust the source’s right edge.
• Use the Left Edge spinner to adjust the source’s left edge.
• Use the Top Edge spinner to adjust the source’s top edge.
• Use the Bottom Edge spinner to adjust the bottom edge.

12. Use the controls in the Color Balance section to adjust the input’s color balance.

a. When RGB sources are selected, tabs are provided for R, G and B.   
Use the brightness and contrast sliders and spinners to adjust color 
balance as required.

b. When Composite, S-Video or YPbPr sources are selected, use the  
Saturation and Hue spinners to adjust saturation and hue as required.

13. Click Save to save the new input configuration in memory.  

14. In the Source/Preset Section, select the (next) source that you wish to set up.

15. Repeat from step 6 for the next source.

16. Repeat from step 1 for the next destination — only if required.  Refer to the “Input 
Setup Notes” section on page 157 for details.  When all inputs have been 
adjusted and saved, click Close to close the Input Properties Dialog.  

fåéìí=pÉíìé=kçíÉë
You do not have to repeat the input setup procedure for other destinations if either of the 
following two criteria are met:

• Your other destinations use sources that are patched to the same router.

• Your other destinations use input that are configured using the “All SP” function 
on the Sources Tab.

In this case, all other system destinations will automatically receive input configuration files 
via the system’s “copy down” functionality.

You do have to repeat the input setup procedure if either of the following criteria are met:

• Your other destinations use a different router.

• Your other destinations use unique input patching.

When complete, please continue with the “Background Setup” section on page 158. 

Important Ensure that you click Save before you close the Input 
Properties Dialog — otherwise your adjustments will be lost.  
If you do not save the input, the next time the source is 
selected, the input’s default settings will be displayed.
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Encore GC setup:  Step 13.

This procedure enables you to set up Encore GC’s two “background” sources (BG A and 
BG B).  A background can be configured as a DVI input, an analog input, a matte color or a 
frame grab. 

Prerequisite — Ensure that you are familiar with the Background 
Properties Dialog.  In Chapter 5, refer to the “Background Properties 
Dialog” section on page 118.

Please note the following important points:

• For ScreenPRO-II destinations, remember that BG B and the DSK are mutually 
exclusive.  This occurs because the BG/DSK Input B is shared between the DSK 
and BG B on all individual ScreenPRO-II units.

• For single or wide screen Encore GC systems using single M/E video processors, 
there are only two DVI inputs available (1A and 1B).  In this configuration, you can 
not set up both backgrounds and the DSK — you can only configure two of the 
three (e.g., both backgrounds or one background plus one DSK).  

Use the following steps to set up your background sources:

1. Click the Destination Control Tab for the destination whose backgrounds you 
want to set up.

2. In the Layer Control Section, click a background button on Preview (e.g., BG A).  

3. In the Palette, right-click the background layer and select Background 
Properties to display the Background Properties Dialog.

4. For widescreen destinations only:

~ Enable the All check box to create a background across all video 
processors.

~ Disable the All check box to create individual backgrounds for different 
video processors.  In this case use the Processor drop-down menu to 
select the specific processor for which you want to create a background. 

5. To configure a matte background:

a. Select Matte in the Type drop-down menu.

b. Use the sliders and spinners in the Matte Color section to adjust the 
matte color as desired.

c. Click Save.

6. To configure a DVI background:

a. Select DVI in the Type drop-down menu.

b. Ensure that your DVI source (e.g., a PC) is properly connected to the 
Video Processor or ScreenPRO-II chassis, and that the PC is turned on.

c. Ensure that EDID is properly set.  If not, refer to the “Destination Setup” 
section on page 146 for details. 

d. Set the DVI source’s format:

• Click Force Acquire, or ...

• To manually set the source’s resolution, select the desired 
format using the Video Format drop-down menu.

13
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e. (Optional)  Adjust H and V Crop Offset as required.

f. Click Save.

7. To configure an Analog background:

a. Select Analog in the Type drop-down menu.

b. Ensure that your analog source is properly connected to the Video 
Processor chassis.    

c. Set the analog source’s format:

• Click Force Acquire, or ...

• To manually set the source’s resolution, select the desired 
format using the Video Format drop-down menu.

d. (Optional)  Adjust H and V Crop Offset as required.

e. (Optional)  Adjust Contrast, Brightness, Sizing and Color Balance.

f. Click Save.

8. To configure a frame grab background:

a. Ensure that you have captured frame(s) into one of the three available 
frame buffers, or have loaded frame(s) from permanent memory into one 
of the three buffers.  In Chapter 7, refer to the “Working with Frame 
Grabs” section on page 184 for instructions.

b. Select Still Frame Buffer 1, Buffer 2 or Buffer 3 in the Type drop-down 
menu.

c. Click Save.

9. Repeat from step 2 for BG B.

10. Repeat from step 1 for the next destination’s background sources.

11. When all backgrounds have been adjusted and saved, click Close to close the 
Background Properties Dialog.  

When complete, please continue with the “DSK Setup” section below. 

Note Analog backgrounds cannot be configured on ScreenPRO-II 
destinations.  

Important Using analog background in edge-butted mode could 
possibly cause seams, and is not recommended!
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Encore GC setup:  Step 14.

This procedure enables you to set up theEncore GC’s DSK source.  An DSK can be 
configured as a DVI input, an analog input, a frame grab or “none.”   

Prerequisite — Ensure that you are familiar with the DSK Properties 
Dialog.  In Chapter 5, refer to the “DSK Properties Dialog” section on 
page 124.

Please note the following important points:

• For ScreenPRO-II destinations, remember that BG B and the DSK are mutually 
exclusive.  This occurs because the BG/DSK Input B is shared between the DSK 
and BG B on all individual ScreenPRO-II units.

• For single or wide screen Encore GC systems using single M/E Video Processors, 
there are only two DVI input connectors available (1A and 1B).  In this 
configuration, you can not set up both backgrounds and the DSK — you can only 
configure two of the three (e.g., both backgrounds, or one background plus DSK).  

Use the following steps to set up your DSK source:

1. Click the Destination Control Tab for the destination whose DSK you want to set.

2. In the Layer Control Section, click DSK.  

3. In the Palette, right-click the background layer and select DSK Properties to 
display the DSK Properties Dialog.

4. For widescreen destinations only:

~ Enable the All check box to configure a DSK across all video 
processors.

~ Disable the All check box to create individual DSKs for different video 
processors.  In this case use the Processor drop-down menu to select 
the specific processor for which you want to create a DSK.  

5. Click the Input Tab.

6. To configure the DSK with no input:

a. Select None in the Type drop-down menu.

b. Click Save.

7. To configure a DVI input as the DSK:

a. Select DVI in the Type drop-down menu.

b. Use the Input drop-down menu to select the DVI input connector from 
which the DSK source is pulled.

c. Ensure that your DVI source is properly connected to the Video 
Processor or ScreenPRO-II chassis, and that the PC is turned on.

14

Note Typically, in a wide screen destination, the DSK is placed on 
only one of the multiple screens (e.g., the far right screen).  
For this setup, select a individual video processors and set up 
their “types” accordingly — DVI or Analog for the DSK 
screen, and “none” for the remaining screens.
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d. Ensure that EDID is properly set.  If not, refer to the “Destination Setup” 
section on page 146 for details. 

e. Set the DVI source’s format:

• Click Force Acquire, or ...

• To manually set the source’s resolution, select the desired 
format using the Video Format drop-down menu.

f. (Optional)  Adjust H and V Crop Offset as required.

g. Click Save.

8. To configure an Analog source as the DSK:

a. Select Analog in the Type drop-down menu.

b. Ensure that your analog source is properly connected to the Video 
Processor chassis.    

c. Set the analog source’s format:

• Click Force Acquire, or ...

• To manually set the source’s resolution, select the desired 
format using the Video Format drop-down menu.

d. (Optional)  Adjust H and V Crop Offset as required.

e. (Optional)  Adjust Contrast, Brightness, Sizing and Color Balance.

f. Click Save.

9. To configure a frame grab as the DSK:

a. Ensure that you have captured frame(s) into one of the three available 
frame buffers, or have loaded frame(s) from permanent memory into one 
of the three buffers.  In Chapter 7, refer to the “Working with Frame 
Grabs” section on page 184 for instructions.

b. Select Still Frame Buffer 1, Buffer 2 or Buffer 3 in the Type drop-down 
menu.

c. Click Save.

10. Click the Key Tab, and use the spinners and sliders to adjust Clip, Gain and 
Opacity.

11. For Analog and DVI key types only, click the Crop Tab and use the spinners and 
sliders to adjust the four crop parameters as required:  From Top, From Bottom, 
From Left and From Right.

12. When your DSK is fully adjusted, click Save, then click Close to close the DSK 
Properties Dialog.

When complete, please continue with the “Saving the System Configuration” section on 
page 162. 

Note Analog DSKs cannot be configured on ScreenPRO-II 
destinations.  
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Encore GC setup:  Step 15.

This procedure enables you to save the current Encore GC configuration in the ECU, so 
that you can shut down and power-up again with the identical setup. 

Use the following steps to save the system configuration: 

1. In the Menu Bar, click ECU > Save Configuration.  This action saves the 
configuration of equipment, all setup parameters, and all of the Presets that you 
have created.

Please continue with Chapter 7, “Operations” on page 163.
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få=qÜáë=`Ü~éíÉê
This chapter includes operational instructions for all Encore GC modes and functions.  The 
following topics are discussed:  

• Prerequisites

• Operational Configuration

• Working with Layers

• Working with Presets

• Resetting Software

• Working with Frame Grabs

• Backing Up and Restoring Configurations

• External Control
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mêÉêÉèìáëáíÉë
Prior to reviewing this chapter, please ensure the following:

• All system destinations are properly configured.  In Chapter 6, refer to the 
“Destination Setup" section on page 146 for details.

• All system inputs (sources) are properly configured.  In Chapter 6, refer to the 
“Input Setup" section on page 155 for details.

• All system backgrounds are properly configured.  In Chapter 6, refer to the 
“Background Setup" section on page 158 for details.

• The DSK is properly configured.  In Chapter 6, refer to the “DSK Setup" section 
on page 160 for details.

• Ensure that you are familiar with all menus, tabs and dialogs.  Refer to Chapter 5, 
"Menu Orientation" on page 61 for details:

léÉê~íáçå~ä=`çåÑáÖìê~íáçå
The following topics are discussed in this section:

• Wide Screen Markers

• Lookahead Preview

• A Word About LOS

• A Word About Resources

Tip As you review each function, it is recommended that you 
practice each feature on the Encore GC itself — using a fully 
configured system consisting of Program and Preview 
monitors, projector(s), and all the required destinations, 
sources and backgrounds. 
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táÇÉ=pÅêÉÉå=j~êâÉêë
If you are using a wide screen destination, ensure that your Wide Screen Markers are 
enabled on the Destination Setup Tab.  In Chapter 5, refer to the “Destination Setup 
Tab" section on page 76 for details.  

Wide Screen Markers are thin vertical green lines at the edges of the Preview monitors 
that are used to denote the actual projected image area.  Markers apply to horizontal 
blends (e.g., 3W x 1H), and to horizontal + vertical arrays (e.g., 2W x 2H), but do not apply 
to vertical blends (e.g., 1W x 3H).

Using edge feathering and data doubling, Encore GC provides perfect and seamless wide 
screen images.  Because of the required overlap, a portion of the original image is unused, 
and does not get projected.  The location of the unused portion depends on your selected 
justification — left or center. 

With each type of justification, the Wide Screen Markers accurately denote the unused 
portion, thus enabling you to properly compose your screens.

• Left Justified Markers

The figure below illustrates the Wide Screen Marker in a left justified 
configuration.  Images to the left of the green vertical line are projected.  Images to 
the right are not. 

Figure 7-1.  Wide Screen Marker, Left Justification

• Center Justified Markers

The figure below illustrates the two Wide Screen Markers in a center justified 
configuration.  Images between the two vertical green lines are projected.  Images 
outside of the lines are not. 

Figure 7-2.  Wide Screen Marker, Center Justification
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iççâ~ÜÉ~Ç=mêÉîáÉï
Encore GC uses a “lookahead” preview system that ensures the accuracy of all your 
transitions.  The “look” that you create on Preview represents the exact appearance of 
Program, after you cut or “auto transition” the look to Program.

The illustration below represents a simple Preview-to-Program transition.  SPLIT mode is 
on, enabling you to have two PIPs on screen simultaneously:

Figure 7-3.  Program-to-Preview Transition with Lookahead

• In frame 1, Program consists of a background and a single PIP (1A). 

• In frame 2, a second PIP (1B) is selected and positioned on Preview.

• When CUT or AUTO TRANS is clicked, the PIP transitions to Program.  Frame 3 
represents the Program screen — identical to the Preview “look” in frame 2.

• Frame 4 represents Preview after the transition.  Preview will continue to match 
Program until you modify the preview image, in preparation for the next transition.

With these facts in mind, ensure that you always create the desired “next” look in Preview.  
In this manner, there won’t be any operational surprises:

• By using lookahead, you’ll always know visually what PIPs and keys you want to 
transition TO Program.

• Conversely, you’ll always know what PIPs and keys to you wish to clear — to 
visually remove elements FROM Program.  

^=tçêÇ=^Äçìí=ilp
If you experience LOS (loss of signal), the VP obeys a precise set of rules:

• Scaler LOS — If there is a LOS for a video signal inside a scaler (PIP or KEY), 
the video switches to black, but the scaler remains in its current size and position.  

• Background LOS — If there is a LOS for a background DVI input, the video 
switches to the background’s selected matte color.    

• DSK LOS — If there is a LOS for the DSK, the system switches the DSK Off 
(specifically, selecting "none" as the type).    

In each case, when the video signal recovers, the VP re-enables the signal as before.
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^=tçêÇ=^Äçìí=oÉëçìêÅÉë
Resources, as they apply to Presets, are the layers that comprise the current “look.”  

• The contents of a Preset are locked to the mixers from which they were originally 
stored.  For example, if you store a Preset that only has Layers 1A and 1B 
enabled on Preview, that Preset can only be recalled into Mixer 1.

• When you store a Preset, you are not only recording the entire look, but you are 
also recording the priorities of the individual layers (PIPs and Keys) as selected in 
the Layer Control Section.  

• When you recall a Preset, you are recalling the entire setup, and all previously 
stored priorities — PIPs, Keys, colors, sources, etc.

Several "resource" examples are provided below:

Example 1:  Split — No conflict.  

a. Enable Split mode.

b. Store a Preset that contains Source 1 on layer 1A, and layer 1B is clear.

c. Take Source 2 to Program on layer 1A.  

d. Recall the Preset.

You can recall the Preset to Preview, because the system temporarily 
borrows scaler 1B to avoid a resource conflict.

Example 2:  Split — Conflict.  

a. Enable Split mode.

b. Store a Preset that contains Source 1 on layer 1A, and layer 1B is clear.  

c. Take Source 2 to Program on layer 1A, and Source 3 to Program on 
Layer 1B.  

d. Recall the Preset — the Alert Dialog appears.  Here, you cannot recall 
the Preset to Preview, because both scalers are in use.  Remember, 
however, that Encore GC offers several "Auto Resolve" options.  Refer to 
the "Auto Resolve" section on page 168 for details.

Example 3:  Mix — No conflict.  

a. Enable Mix-Src mode.

b. Store a Preset that contains Source 1 on layer 1A.

c. Take Source 2 to Program on layer 1A.  

d. Recall the Preset.

You can recall the Preset to Preview, because there is always a layer 
available in Mix-Src mode.  The system will pick the available layer 
based on resources (e.g., if you stored the Preset in layer 1A, the system 
may recall it to layer 1B — if layer 1A is already in use).

Example 4:  Store a Split, Recall a Mix — No conflict.  

a. Enable Split mode.

b. Store a Preset that contains Source 1 on layer 1A and Source 2 on 
layer 1B.  

c. Enable Mix-Src mode.

d. Store a second Preset that contains Source 1 on layer 1A.  

e. Recall the first (Split) Preset, and take it to Program.
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f. Recall the second (Mix-Src) Preset.  The system recalls the Preset to 
Preview, but the mode changes to Split, enabling you to perform the 
transition.  The Preset is still stored as a Mix-Src, however.

^ìíç=oÉëçäîÉ
Knowing that resource conflicts can arise, you may wish to store (and organize) your 
Presets according to the use of resources:

• For example, you could store Presets on Page 1 that only use one PIP, and 
presets on Page 2 that use two PIPs.  

• As an alternate method, you may want to plan your presentations such that 
Presets are always recalled to an “empty” Program setup (with only a background 
visible).  This method avoids all resource issues entirely.

However, remember that Encore GC offers several "Auto Resolve" options that you can 
use when the Alert Dialog appears when you recall a Preset.   Three options are provided:

• Click Auto Resolve to pull the conflicting resources smoothly off of Program, and 
place the “requested” resources on Preview.

• Click Auto Resolve and Transition to pull the conflicting resources smoothly off 
of Program, place the “requested” resources on Preview, and smoothly transition 
the new “look” to Program.  

• Click Close to close the dialog, but take no action on Preview or Program.  This 
option enables you to make your own choices with regard to resolving the conflict, 
or selecting another “non-conflicting” Preset.  

Important Both of the “resolve” options affect the Program video output, 
but are designed in such a way as to appear very smooth to 
the viewer, rather than abrupt. 
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The following topics are discussed in this section:

• Switching Sources

• Manipulating PIPs and Keys

• Background Transitions

• Understanding Split and Mix-Src Modes

• Working with PIPs in Split Mode

• Working with PIPs in Mix-Src and Swap Modes

• Modifying PIPs

• Working with Keys in Split Mode

• Working with Keys in Mix-Src and Swap Modes

• Using Key Cut/Fill

• Modifying Keys

• Clearing Layers from Program

• Modifying Layers On Program

• Using Black

• Using the DSK

• Using Source Preview

pïáíÅÜáåÖ=pçìêÅÉë
Use the following steps to switch sources into a PIP or a Key:

1. Select the desired Destination Control Tab.

2. In the Menu Bar, click View > Preview to show Preview in the Palette, or View > 
Preview and Program to show both outputs.

3. In the Layer Control Section, click a layer button (e.g., 1A) to place that layer in 
the Palette.

4. In the Mixer Control Section, enable or disable Key as desired.

5. In the Source/Preset Section, click the desired source button to assign that 
source to the PIP or Key.

6. Manipulate the PIP or Key as desired.  Refer to the "Manipulating PIPs and 
Keys" section on page 170 for details.

Please note the following points regarding sources:

• In the Layer Control Section, when the layer’s button is Red on the Program 
row, the layer is on Program.  The layer is not active for manipulation.  

• If a router is used for input connection, a source can be assigned to multiple layers 
simultaneously.

• The blinking raster box in the Palette indicates the last selected PIP or Key, but it 
does not always indicate that the PIP or Key is available for modification, 
particularly if that PIP is on Program.  To "visually" know which layer can be 
modified, use View > Preview and Program to show both outputs. 
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To move a PIP or Key:

1. In the PIP/Key Pop-up Menu, ensure that Crop Enabled is un-checked.

2. Mouse over the PIP or Key until the four-headed arrow (PIP Cursor) appears.    

3. Click within the PIP or Key, and drag to move the image.

To scale a PIP or Key:

1. In the PIP/Key Pop-up Menu:

~ Ensure that Crop Enabled is un-checked.

~ Check or un-check Lock Aspect Ratio as desired.

2. Mouse over the edge of a PIP or Key until the two-headed arrow (Edge Cursor) 
appears.    

3. Click on the edge, and drag to scale the image.

To crop a PIP or Key:

1. In the PIP/Key Pop-up Menu, check the Crop Enabled option.

2. Mouse over the edge of a PIP or Key until the cross (Crop) cursor appears.    

3. Click on the edge, and drag to crop the image.

4. To move or scale a cropped PIP or Key, in the PIP/Key Pop-up Menu, select 
Crop Mode > Resize, then move or scale the image in the normal manner.

_~ÅâÖêçìåÇ=qê~åëáíáçåë
Use the following steps to perform a background transition:

1. Ensure that your backgrounds are properly set up.  In Chapter 6, refer to the 
“Background Setup" section on page 158 for details. 

2. Select the desired Destination Control Tab.

3. Select the desired background (BG A or BG B) on Preview.  

4. Right click in the Palette to display the Background/DSK Pop-up Menu, and 
select Background Properties to display the Background Properties Dialog.

5. In the Background Properties Dialog, change (and adjust) backgrounds if 
desired, to Matte, DVI, Analog or a Still Frame background.  

6. Perform the desired transition (AUTO TRANS or CUT).  When the selected 
background is on Program, its button is Red on the Program row.  

7. To clear a background from Program, turn the "on air" background button Off on 
Preview (or select the other background source), then perform the transition. 

Note When you clear a background by turning the button off on 
Preview, it clears to the last selected background matte color.  
Note that two separate matte colors can be defined, one for 
BG A and one for BG B.
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Encore GC provides two different modes with which you can transition PIPs and Keys:  

• Split Mode

• Mix-Src and Swap Modes

péäáí=jçÇÉ
With the Split mode enabled in the Mixer Control Section, a mixer’s two layers operate 
independently.  You can manipulate and transition the following combinations of effects on 
a single mixer:

• One or two PIPs

• One or two Keys

• One PIP and one Key

jáñJpêÅ=~åÇ=pï~é=jçÇÉë
With the Mix-Src (Mix Source) or Swap modes enabled in the Mixer Control Section, a 
mixer’s two layers are ganged together.  These two modes are mutually exclusive.

• With Mix-Src enabled, both mixer layers are perfectly co-located after every 
transition.  Layers A and B are exactly the same vertical size — in exactly the 
same position — with exactly the same border and shadow.  

This mode is ideal for transitioning images inside a static PIP.  Even though two 
identical PIPs are used, they visually appear as one, provided that they are both 
the same aspect ratio.  

• With Swap enabled, both mixer layers can be located independently, with different 
positions, sizes, borders and shadows.  Layers A and B can be positioned and 
sized as desired — but only one can be on screen at a time.  

tçêâáåÖ=ïáíÜ=mfmë=áå=péäáí=jçÇÉ
In Split Mode, a mixer’s two layers operate independently.

Use the following steps to work with PIPs in Split Mode.

1. Select the desired Destination Control Tab.

2. In the Layer Control Section, click the desired layer button.

3. In the Mixer Control Section, expand the selected layer’s mixer.  

4. Select Split, and ensure that the Key check box (for the layer) is un-checked.  

5. In the Source/Preset Section, click the desired source.

Note In this mode, two PIPs will be the same vertical size, but may 
differ in horizontal size, for example, if one layer is 4:3 and the 
other layer is 16:9.

Note In the Mix-Src and Swap modes, when neither layer is on 
Program, if you select one layer, the other is automatically de-
selected.  Only one layer can be active at a time.
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6. Adjust the PIP’s size, position, border and shadow as desired.  Refer to the 
“Modifying PIPs" section on page 172 for details.

7. Prior to the transition, set up additional PIPs and Keys as desired.

8. Transition the setup to Program.  

9. Repeat the procedure from step 1 for the next transition.

Please note:

• If a mixer is in Split mode and a layer is active for modification, selecting Mix-Src 
or Swap changes the mode accordingly, and Split is turned off.  Please note:

~ The layer selected on Preview remains selected, and if a layer is 
currently on Program, it remains on air.

~ If both layers are active on Program, Mix-Src cannot be enabled. 

• If a mixer is in Mix-Src or Swap, selecting Split automatically cancels the current 
mode, and the current layer on Program is automatically placed on Preview.  

tçêâáåÖ=ïáíÜ=mfmë=áå=jáñJpêÅ=~åÇ=pï~é=jçÇÉë
In Mix-Src and Swap modes, a mixer’s layers are ganged together.  Both layers can be 
perfectly co-located on screen (Mix-Src mode), or both can operate independently (Swap 
mode), but only one layer can be on Program at a time.

Use the following steps to work with PIPs in Mix-Src and Swap modes.

1. Select the desired Destination Control Tab.

2. In the Layer Control Section, click the desired layer button.

3. In the Mixer Control Section, expand the selected layer’s mixer.  

4. Select Mix-Src or Swap, and ensure that the Key check box (for the selected 
layer) is un-checked.  

5. In the Source/Preset Section, click the desired source.

6. Adjust the PIP’s size, position, border and shadow as desired.  Refer to the 
“Modifying PIPs" section on page 172 for details.

7. Prior to the transition, set up additional PIPs and Keys as desired.

8. Transition the setup to Program.  

9. Repeat the procedure from step 1 for the next transition. 

jçÇáÑóáåÖ=mfmë
Use the following steps to modify a PIP:

1. In the Palette, click the PIP that you wish to modify.  

2. Size, Position, Crop — Manipulate the PIP as required on Preview.  Refer to the 
"Manipulating PIPs and Keys" section on page 170 for details.

3. Border — Using the PIP/Key Pop-up Menu, select Border Properties to display 
the Border Properties Dialog.  Select the border’s style, color and size as 
desired.  In Chapter 5, refer to the "Border Properties Dialog" section on 
page 111 for details.   

4. Shadow — Using the PIP/Key Pop-up Menu, select Shadow Properties to 
display the Shadow Properties Dialog.  Choose the shadow’s size, position and 
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transparency.  In Chapter 5, refer to the "Shadow Properties Dialog" section on 
page 112 for details.

5. Freeze — Click the Freeze button in the Tool Bar to freeze the PIP.  Click again to 
unfreeze.  Please note:

~ If a mixer is in Mix-Src mode, you can only freeze and un-freeze while a 
layer is selected on Preview.  

~ If a mixer is in Split mode, you can freeze and un-freeze while a layer is 
selected on either Preview or Program.  

~ When Freeze is enabled for a layer, PIP and Key adjustments are not 
allowed. 

6. Alignment — Shift + Click two or more PIPs on the Palette.  In the Tool Bar, use 
the buttons in the Alignment Group to align the PIPs as required.  In Chapter 5, 
refer to the "Tool Bar" section on page 101 for details.

7. Centering — Click a single PIP, or Shift + Click two or more PIPs on the Palette.  
In the Tool Bar, use the buttons in the Centering Group to center the PIPs.  In 
Chapter 5, refer to the "Tool Bar" section on page 101 for details.

8. Full Screen — Click a single PIP, or Shift + Click two or more PIPs on the 
Palette.  In the Tool Bar, use the buttons in the Full Screen Group to size the 
PIPs to full screen as required.  In Chapter 5, refer to the "Tool Bar" section on 
page 101 for details.

9. Similarity — Shift + Click two or more PIPs on the Palette.  In the Tool Bar, use 
the buttons in the Similarity Group to make PIPs the same height or width.  In 
Chapter 5, refer to the "Tool Bar" section on page 101 for details.

10. Swap Z — In the Mixer Control Section, expand the mixer for a selected layer 
and click Swap Z-Order to swap the priority of two layers in the same mixer.  The 
function works with two Keys, two PIPs, or one of each.  Note that the layers 
remain at their current locations — only the priority changes.  

11. Transition — Transition the new look to program with a Cut or Auto Trans.

tçêâáåÖ=ïáíÜ=hÉóë=áå=péäáí=jçÇÉ
In Split Mode, a mixer’s two layers operate independently.  

Use the following steps to work with PIPs in Split Mode.

1. Select the desired Destination Control Tab.

2. In the Layer Control Section, click the desired layer button.

3. In the Mixer Control Section, expand the selected layer’s mixer.  

4. Select Split, and ensure that the Key check box (for the selected layer) is 
checked.  

5. In the Source/Preset Section, click the desired source.

6. Adjust the Key as desired.  Refer to the “Modifying Keys" section on page 175 
for details.

7. Prior to the transition, set up additional PIPs and Keys as desired.

Note The Swap Z-Order function only works in Split mode, and 
only works on the layers within a selected mixer.  You cannot 
use the function to swap the priority of different mixers.
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8. Transition the setup to Program.  

9. Repeat the procedure from step 1 for the next transition.

tçêâáåÖ=ïáíÜ=hÉóë=áå=jáñJpêÅ=~åÇ=pï~é=jçÇÉë
In Mix-Src and Swap modes, a mixer’s layers are ganged together.  Both Keys can be 
perfectly co-located on screen (Mix-Src mode), or both can operate independently (Swap 
mode), but only one layer can be on Program at a time.

Use the following steps to work with Keys in Mix-Src and Swap modes.

1. Select the desired Destination Control Tab.

2. In the Layer Control Section, click the desired layer button.

3. In the Mixer Control Section, expand the selected layer’s mixer.  

4. Select Mix-Src or Swap, and ensure that the Key check box (for the selected 
layer) is checked.  

5. In the Source/Preset Section, click the desired source.

6. Adjust the Key as desired.  Refer to the “Modifying Keys" section on page 175 
for details.

7. Prior to the transition, set up additional PIPs and Keys as desired.

8. Transition the setup to Program.  

9. Repeat the procedure from step 1 for the next transition. 

rëáåÖ=hÉó=`ìíLcáää
In any mixer, Key Cut/Fill is a mode in which the hole-cutting information is provided by a 
Key on Layer B, while the fill information is provided by a PIP on Layer A.    

Use the following steps to create a Key Cut/Fill:

1. Select the desired Destination Control Tab.

2. In the Mixer Control Section, expand the mixer on which you want to create a 
Key Cut/Fill.  

3. Select the Key Cut/Fill mode from the drop-down menu.  

4. In the Layer Control Section, click either layer, and note that both layer’s A and 
B are placed on the Palette.  A label appears in the center of each layer:

~ Layer B has the label Key Cut.  This layer cuts the hole.

~ Layer A has the label Key Fill.  This layer fills the hole.

5. Click each layer, and in the Source/Preset Section, select sources for each.

6. In the Palette, move Layer B on top of Layer A, and note the effect on your 
Preview monitor.

Note At this point, Layer A's image will disappear, however, the 
layer’s raster box remains visible on Preview.  Depending on 
current Key parameters (e.g., Clip, Gain), some part of the 
"fill" may be visible in the shape of the "cut" source. 
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7. Size and position the layers in the normal manner, and adjust the Key as desired 
(including clip, gain and opacity).  Refer to the “Modifying Keys" section on 
page 175 for details.

8. Transition the new setup to Program.  

jçÇáÑóáåÖ=hÉóë
Use the following steps to modify a Key:

1. In the Palette, click the Key that you wish to modify.  

2. Size, Position, Crop — Manipulate the Key as required.  Refer to the 
"Manipulating PIPs and Keys" section on page 170.

3. Key Mode — In the Mixer Control Section, enable Key, or select Key Cut/Fill 
from the drop-down menu.  

4. Clip, Gain, Opacity — Using the PIP/Key Pop-up Menu, select Key Properties 
to display the Key Properties Dialog.  Adjust the Key’s clip, gain, and opacity on 
Preview as required.  In Chapter 5, refer to the "Key Properties Dialog" section 
on page 113 for details.

5. Freeze — Click the Freeze button in the Tool Bar to freeze/unfreeze the Key.  
Please note:

~ If a mixer is in Mix-Src mode, you can only freeze and un-freeze while a 
layer is selected on Preview.  

~ If a mixer is in Split mode, you can freeze and un-freeze while a layer is 
selected on either Preview or Program.  

~ When Freeze is enabled for a layer, PIP and Key adjustments are not 
allowed. 

6. Alignment — Shift + Click two or more Keys (and/or PIPs) on the Palette.  In the 
Tool Bar, use the buttons in the Alignment Group to align the layers as required.  
In Chapter 5, refer to the "Tool Bar" section on page 101 for details.

7. Centering — Click a single Key, or Shift + Click two or more Keys (and/or PIPs) 
on the Palette.  In the Tool Bar, use the buttons in the Centering Group to center 
the layers.  In Chapter 5, refer to the "Tool Bar" section on page 101 for details.

8. Full Screen — Click a single Key, or Shift + Click two or more Keys (and/or PIPs) 
on the Palette.  In the Tool Bar, use the buttons in the Full Screen Group to size 
the layers to full screen as required.  In Chapter 5, refer to the "Tool Bar" section 
on page 101 for details.

9. Similarity — Shift + Click two or more Keys (and/or PIPs) on the Palette.  In the 
Tool Bar, use the buttons in the Similarity Group to make the layers the same 
height or width.  In Chapter 5, refer to the "Tool Bar" section on page 101.

10. Swap Z — In the Mixer Control Section, expand the mixer for a selected layer 
and click Swap Z-Order to swap the priority of two layers in the same mixer.  The 
function works with two Keys, two PIPs, or one of each.  Note that the layers 
remain at their current locations — only the priority changes.  

11. Transition — Transition the new look to program with a Cut or Auto Trans.

Note The Swap Z-Order function only works on the layers within a 
selected mixer.  You cannot use the function to swap the 
priority of different mixers.
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The "clear layer" procedure enables you to remove layers from Program — including 
backgrounds, mixers and the DSK.  When clearing layers, always use the Lookahead 
Preview function.  Refer to the "Lookahead Preview" section on page 166 for details.

Use the following steps to clear a layer (or all layers) from Program:

1. Check (and compare) the Program and Preview monitors, and note the layer(s) 
that you wish to clear.  In the Layer Control Section, remember that Red buttons 
indicate the layers that are on Program.  The following options are available:

~ To clear individual layers, in the Layer Control Section (on the Preview 
row), turn off the buttons for the layers that you wish to clear.      

~ To clear all layers, click Clear All in the Layer Control Section. 

~ Transition the setup to Program.  The selected layer(s) will transition off.

jçÇáÑóáåÖ=i~óÉêë=lå=mêçÖê~ã
Encore GC enables you to modify layers directly on Program, without first setting up a 
"look" on Preview.   This is a "cuts-only" mode.      

Use the following steps to modify layers directly on Program:

1. Select the desired Destination Control Tab.

2. In the Layer Control Section (on the Program row), click the desired layer button 
to "cut" the layer on and off Program.  This step is valid for all layers, including BG 
A, BG B, the DSK and Black.    

Please note:

• When you switch sources directly on Program, you may notice a glitch in the 
image as the scalers recall the source’s file.  

• If you use camera inputs in this mode, it is recommended that you use an external 
Genlock signal.  Refer to the "A Word About Resources" section on page 167 
for details on source files. 

rëáåÖ=_ä~Åâ
In the Layer Control Section, the Black button enables you to transition all layers, 
backgrounds and the DSK to black for the selected destination.  

Use the following steps to transition to/from Black:

1. Select the desired Destination Control Tab.

2. Regardless of the setup currently in Preview, in the Layer Control Section click 
Black to place source “black” on Preview.  All PIPs, keys and backgrounds are 
maintained under the black screen.  All raster boxes remain visible on Preview.

3. Perform a transition in the normal way to fade (or cut) Program to black.  

4. To transition up from black, turn off the Black button on Preview.  All PIPs, keys 
and backgrounds are restored in their previous positions.

5. Perform a transition in the normal way to fade (or cut) up from black.  
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rëáåÖ=íÜÉ=aph
Use the following steps to perform a downstream key:

1. Ensure that the DSK is properly set up, and that the desired key "type" is selected 
in the DSK Properties Dialog.  In Chapter 6, refer to the "DSK Setup" section on 
page 160 for instructions.

2. Please remember the following important DSK rules:

~ For ScreenPRO-II destinations, remember that BG B and the DSK are 
mutually exclusive.  

~ For single or wide screen Encore GC systems using single M/E Video 
Processors, there are only two DVI input connectors available (1A and 
1B).  In this configuration, you cannot use both backgrounds and the 
DSK — you can only use two of the three.  

3. Select the desired Destination Control Tab.

4. In the Layer Control Section, click DSK on Preview.  

5. In the Palette, right-click the background layer and select DSK Properties to 
display the DSK Properties Dialog.

6. For widescreen destinations only:

~ Enable the All check box to configure a DSK across all video 
processors.

~ Disable the All check box to create individual DSKs for different video 
processors.  In this case use the Processor drop-down menu to select 
the specific processor for which you want to create a DSK.  

7. On the Input, Key and Crop tabs, adjust DSK parameters, including key type, 
clip, gain, opacity and crop.      

8. Perform a Cut or Auto Trans. 

9. Clear the DSK from Program in the normal manner — by clearing its layer from 
Preview and then transitioning.   

rëáåÖ=pçìêÅÉ=mêÉîáÉï
The Source Preview function enables you to quickly isolate a selected layer for sizing and 
adjustment purposes — in Preview only.  

Use the following steps to use the Source Preview function:

1. In the Palette, click the layer that you want to isolate, and ensure the layer is on 
Preview only. 

2. In the Source/Preset Section, select a source.

3. Right-click the desired layer, and using the PIP/Key Pop-up Menu, select Input 
Properties to display the Input Properties Dialog.

4. Enable the Source Preview check box.  The following actions occur:

~ For the selected layer, the border and shadow are turned off, and if the 
layer is a Key, the Key is turned off.
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~ The PIP (or Key) is placed in the center of the screen.  

~ If the system is in wide screen mode, the layer is centered in screen 1 
and sized to 90% of that screen.

~ All other layers are hidden.

~ The background switches to a neutral gray.

5. Using the Input Properties Menu, adjust the source in the normal manner.

6. To restore Preview to its previous look, disable the Source Preview check box.

Please note the following important point regarding Source Preview:

• While the Source Preview mode is enabled, you can only perform input 
adjustments and source selections.  All other layer, destination and output 
functions are disabled.

Note Use the Source Preview Drop-down Menu to size the 
image to either 90% of the output resolution, or to 1:1.

Note If the 1:1 PIP size is less than the output resolution of the 
Preview screen, the PIP will be centered in the Preview 
screen at 1:1.  
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tçêâáåÖ=ïáíÜ=mêÉëÉíë
This section provides detailed instructions for working with Presets.  On the Destination 
Control Tabs, the Source/Preset Section enables you to store and recall entire setups.  
Each Preset button represents one “look,” including the current state of all mixers, layers, 
sources, backgrounds and the DSK.

The following topics are discussed in this section:

• Storing Presets

• Recalling Presets

• Deleting Presets

• Presets and Moves

• Multiple Destination Presets

• Preset Notes

píçêáåÖ=mêÉëÉíë
Use the following steps to store a Preset:

1. Set up the desired “look” on Preview.  Remember that one Preset equals a single 
“look,” including the current state of all mixers, layers, sources, backgrounds and 
the DSK.

2. In the Source/Preset Section, click the Preset tab and select the “page” on 
which you want to store the preset.  

3. Set the desired transition rate (which is stored with the Preset), using the 
"Seconds" spinner. 

4. To store the preset, click Learn, then click the desired Preset button.  

oÉÅ~ääáåÖ=mêÉëÉíë
Use the following steps to recall a Preset:

1. In the Menu Bar, click Presets > Preset Recall Options, to display the Preset 
Recall Options Dialog.  Select your "recall" options as desired.  For each recall, 
you can elect to include or exclude the background, DSK and/or borders.    

2. In the Source/Preset Section, click the Preset tab and select the “page” from 
which you want to recall the preset.  

3. To recall a Preset, simply click the desired Preset button to recall the stored “look” 
to Preview.  

~ If a resource conflict Alert appears, you have several options available 
for resolving the conflict.  Refer to the "Auto Resolve" section on 
page 168 for additional information.  

4. Transition the Preset to Program in the normal manner.  

Important The recall configuration (as set in the Preset Recall Options 
Dialog) is global, and it affects all recalls from that point 
forward, until changed.
Encore GC and ECU  •  User’s Guide 179



7.  Operations
Working with Presets
aÉäÉíáåÖ=mêÉëÉíë
Use the following steps to delete a Preset:

1. In the Source/Preset Section, click the Preset tab and select the “page” from 
which you want to delete a preset.  

2. Click Delete, then click the desired Preset button to delete that register from 
memory. 

mêÉëÉíë=~åÇ=jçîÉë
The ECU provides a unique "automatic pend move" feature:

• If you store several Presets in Split mode with the same PIP in different sizes and 
positions on screen, the system automatically pends a Move when you recall 
each Preset.  In this way, when you cut each Preset to Program, the PIP moves 
from point to point.  The end point of the last move becomes the starting point for 
the next move — regardless of the sequence in which the Presets are recalled.  

• As a rule, the layer(s) stored in each Preset must be the same, the source must 
be the same, and PIP parameters (in general) must be the same.   If any of these 
parameters are different, the system will not pend the move.

• For a given PIP, the following effects are valid "move" parameters, each of which 
will transition smoothly from point to point.  You can change any of these 
parameters, and the system will pend a move:

~ PIP or Key size and position

~ PIP or Key source size and position

~ PIP Shadow size and position

~ PIP or Key Crop values

If you change any other parameters, such as shadow opacity, border color, border 
style, etc., the system will not pend the move.

jìäíáéäÉ=aÉëíáå~íáçå=mêÉëÉíë
If two or more destinations are configured, use the Multiple Destinations Tab to configure 
Presets that affect multiple destinations simultaneously.  

The following topics are discussed in this section:

• Storing Multiple Destination Presets

• Recalling Multiple Destination Presets

• Deleting Multiple Destination Presets

Note Remember that the entire Encore GC system has one set of 
64 Presets, which can be stored and recalled throughout the 
system.  These Presets can be single destination or multi-
destination. 
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píçêáåÖ=jìäíáéäÉ=aÉëíáå~íáçå=mêÉëÉíë
Use the following steps to store a Preset:

1. Prior to learning a Preset:

~ Ensure that the desired “individual” destination Presets are recalled to 
Preview on their respective Destination Control Tabs, or ...

~ Set up "new" looks on Preview on each individual Destination Control 
Tab that you wish to store.

2. Click the Multiple Destination Tab.  In the tab’s top Destinations Section, 
turquoise buttons represent configured destinations.  

3. Click the destination button(s) for which you want to store a Preset.  Each button 
toggles between bright (selected) and dim (un-selected).

4. In the bottom Presets Section, select the “page” on which you want to store the 
Preset.  

5. Set the desired transition rate (which is stored with the Preset), using the 
"Seconds" spinner. 

6. To store the preset, click Learn, then click the desired Preset button.  

oÉÅ~ääáåÖ=jìäíáéäÉ=aÉëíáå~íáçå=mêÉëÉíë
Use the following steps to recall a Preset:

1. In the Menu Bar, click Presets > Preset Recall Options, to display the Preset 
Recall Options Dialog.  Select your "recall" options as desired.  For each recall, 
you can elect to include or exclude the background, DSK and/or borders.    

2. In the Presets Section, select the “page” from which you want to recall the preset.  

3. To recall a Preset, click the desired Preset button to recall the stored “look” to 
Preview — for the destinations selected within the Preset.  

~ If a resource conflict Alert appears, you have several options available 
for resolving the conflict.  Refer to the "Auto Resolve" section on 
page 168 for additional information.  

4. Transition the Preset to Program in the normal manner.

aÉäÉíáåÖ=jìäíáéäÉ=aÉëíáå~íáçå=mêÉëÉíë
Use the following steps to delete a Preset:

1. In the Presets Section, select the “page” from which you want to delete a preset.  

2. Click Delete, then click the desired Preset button to delete that Preset. 

mêÉëÉí=kçíÉë
Note that active destinations are stored in Presets.  If a destination which was saved in a 
Preset goes off-line, the Preset recalls "looks" on the destinations that are still available.

Important The recall configuration (as set in the Preset Recall Options 
Dialog) is global, and it affects all recalls from that point 
forward, until changed.
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oÉëÉííáåÖ=pçÑíï~êÉ
A “Factory Defaults” software reset is recommended, for example, after Encore GC has 
returned from an event or other presentation.  Although there are several types of reset 
procedures, the full “factory reset” function guarantees that all ECU and processor values 
are returned to their factory default settings, and that all previous configurations are erased. 

The following topics are discussed:

• Resetting the ECU

• Resetting Processors

oÉëÉííáåÖ=íÜÉ=b`r
Use the following steps to reset the ECU:

1. In the System Tab, click Reset to display the Reset Window.  In the left-hand 
section, the window displays device selection controls, plus a table that lists the 
IDs of all “discovered” processors.  In the right-hand section, reset options are 
listed along with a status box.

2. In the Device Selection section, check the ECU check box.

3. In the Reset Type section, choose the desired option:

~ Click Soft Reboot to restart the entire ECU OS (operating system).  
Stored configurations will not be lost, provided that you have previously 
clicked System Save in the System Tab.

~ Click Factory Defaults to reset the ECU to factory default values.  

4. Click Reset.  A warning dialog will be displayed, confirming which information will 
be lost or retained.  Click Yes to continue, or No to cancel the procedure. 

5. If Yes is clicked, the ECU is reset, and it disconnects from the Encore GC system.    

6. In the pop-up dialog, click Connect to re-populate the tables.

Important All stored ECU configurations will be lost when Factory 
Defaults is selected. 
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oÉëÉííáåÖ=mêçÅÉëëçêë
Use the following steps to reset the processors:

1. In the System Tab, click Reset to display the Reset Window.  In the left-hand 
section, the window displays device selection controls, plus a table of all 
“discovered” processors.  In the right-hand section, reset options are listed.

2. In the Device Selection section, uncheck the ECU check box, and select the 
desired “Processor” button.

~ Click All Processors to reset all VP and VPx processors, and all 
ScreenPRO-IIs.

~ Click All Encore VP to reset all VP and VPx processors only.

~ Click All SP to reset all ScreenPRO-IIs only.

~ Click Clear All Processors to reset your selections.  

~ If desired, click All Devices to reset all VP and VPx processors, all 
ScreenPRO-IIs and the ECU.

3. In the Reset Type section, choose the desired option:

~ Click Soft Reboot to restart the selected processor(s) OS.  Stored 
configurations will not be lost, provided that you have previously clicked 
System Save in the System Tab.

~ Click Factory Defaults to reset the selected processor(s) to factory 
default values.  

4. Click Reset.  A warning dialog will be displayed, confirming which information will 
be lost or retained.  Click Yes to continue, or No to cancel the procedure. 

5. If Yes is clicked, the selected processor(s) are reset, and they disconnect from the 
Encore GC system.  During the update procedure, all program and preview output 
video from the processors switches to black.  

At the conclusion of the procedure, program and preview video is restored from 
the selected processor(s).  

6. Close the Reset Window.

Important All stored processor configurations will be lost when Factory 
Defaults is selected. 

Note This procedure can take several minutes.
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tçêâáåÖ=ïáíÜ=cê~ãÉ=dê~Äë
The following topics are discussed in this section:

• Prerequisites

• Frame Capture Overview

• Capturing Frames from a Background or DSK Input

• Capturing Frames from a Layer

• Saving and Naming Frames in Permanent Memory

• Recalling Frames from Memory

• Erasing and Deleting Frames

mêÉêÉèìáëáíÉë
Please note the following important prerequisites to all frame grab procedures:

• Ensure that you are familiar with the Frame Grab buttons on the Tool Bar.  In 
Chapter 5, refer to the "Tool Bar" section on page 101 for details.

• Ensure that you are familiar with the Background Properties Dialog.  In 
Chapter 5, refer to the "Background Properties Dialog" section on page 118.

• Ensure that you are familiar with the DSK Properties Dialog.  In Chapter 5, refer 
to the "DSK Properties Dialog" section on page 124 for details.

• Ensure that you are familiar with the Stills Tab.  In Chapter 5, refer to the "Stills 
Tab" section on page 97 for details.

cê~ãÉ=`~éíìêÉ=lîÉêîáÉï
The Encore GC system enables you to capture frames into the processor’s three internal 
frame stores.  The “sources” of the frames are the background and DSK inputs on each VP 
(and VPx), or any active layer.  Please note:

• For single screen and ScreenPRO-II destinations, you are working with the 
individual destination’s three frame stores (Buffer 1, 2 and 3) as normal.   

• For widescreen destinations, even though you are using the frame stores of 
multiple VPs, you are "operationally" working with only three frame stores (Buffer 
1, 2 and 3) — each of which captures’s its “slice” of the complete widescreen.   

Encore GC provides complete flexibility with regard to frame grabs:

• Frame Buffers — The VP has three still frame buffers (Buffer 1, 2 and 3) which 
function as the three sources from which “on-air”  frames originate.  The contents 
of these buffers are visible on the Stills Tab.  During operations, you can:

~ Capture (grab) frames to any frame buffer.

~ Assign any frame buffer to BG A, BG B or the DSK.

~ Store the contents of a frame buffer into "permanent" memory.

~ Download a frame from permanent storage into any frame buffer. 

~ Overwrite any frame buffer with a new capture.  
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• Capture Sources — All frame grabs are full screen captures.  A frame can be 
captured from BG A, BG B, the DSK, or any of the scaled inputs (layers).  

The following important rules apply:

~ If BG A, BG B, or the DSK is on Program, a frame cannot be captured. 

~ If BG A, BG B, or the DSK is selected on Preview (and none of those 
three layers are on Program), a frame can be captured.

~ If you select a layer on Preview or Program, a frame can be captured 
— provided that BG A, BG B, or the DSK is not on Program.

~ In order to capture a frame from BG A, BG B, or the DSK, the 
background input "type" must be set to Analog or DVI.   

Once captured, a frame can be assigned as the input “type” for BG A, BG B, or 
the DSK in the Background Properties Dialog or the DSK Properties Dialog, 
respectively.  

• Permanent Frame Stores — The Encore GC enables you to store up to 100 
frames in non-volatile memory.  

Please note:

~ Frames in permanent storage are not lost when the VP powers down.    

~ Permanent frames can be overwritten, deleted (flagged for deletion 
only), or erased (permanently deleted). 

~ Any frame in permanent memory can be named.

`~éíìêáåÖ=cê~ãÉë=Ñêçã=~=_~ÅâÖêçìåÇ=çê=aph=fåéìí
Use the following steps to capture a frame from a background or DSK input:

1. Select the desired Destination Control Tab.

2. Ensure that the background (or DSK) input from which you want to capture is 
properly set up as an Analog or DVI input.  

~ In Chapter 6, refer to the "Background Setup" section on page 158 for 
background setup instructions.

~ In Chapter 6, refer to the "DSK Setup" section on page 160 for DSK 
setup instructions.

3. Ensure that BG A, BG B or the DSK are not on Program.  If these layers are on 
Program, transition them off Program in the normal manner.

4. In the Layer Control Section, on Preview, enable the background (or DSK) from 
which you want to capture a frame.  

5. Right-click the Palette’s background layer to display the pop-up menu:

~ To capture from a background, select Background Properties to display 
the Background Properties Dialog.

~ To capture from the DSK, select DSK Properties to display the DSK 
Properties Dialog.

Note Because all grabs are full screen captures, when you capture 
a layer, you will capture the selected PIP with no borders, and 
with black as the background.
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6. For widescreen destinations only:

~ Enable the All check box to capture a frame across all video processors.

~ Disable the All check box to capture individual frames for different video 
processors.  In this case use the Processor drop-down menu to select 
the specific processor for which you want to capture a frame.  

7. If the background is in motion, click Freeze if desired.

8. Use the drop-down menu (adjacent to the Capture button) to select the frame 
buffer into which you want to grab the frame (Buffer 1, 2 or 3).

9. Click Capture.  The captured frame now resides in the selected frame buffer.  

10. Repeat the procedure to capture additional frames from a background (or DSK) 
input.  Remember that you can always overwrite the selected frame buffer.  

Please note:

• The captured frame(s) can now be assigned as the background or DSK “type” for 
BG A, BG B or the DSK.  

• To save frames in permanent memory, refer to the "Saving and Naming Frames 
in Permanent Memory" section on page 187.

• Only "saved" frames can be named.

`~éíìêáåÖ=cê~ãÉë=Ñêçã=~=i~óÉê
Use the following steps to capture a frame from a layer.  

1. Select the desired Destination Control Tab.

2. Ensure that BG A, BG B or the DSK are not on Program.  If these layers are on 
Program, transition them off Program in the normal manner.

3. In the Layer Control Section, on Preview, click the layer from which you want to 
capture a frame.  The layer’s raster box blinks.  Note that you can not capture 
multiple layers simultaneously.

4. Adjust the PIP or Key’s size and position.  Remember that:

~ The system will capture the "selected" layer in its current size and 
position, with no borders, and with black as the background.

~ If you have two layers on Preview, only the active (selected) layer will be 
captured, regardless of image priority.

~ If the layer is a Key, the original source will be captured — and not the 
keyed effect.

5. If the layer is in motion, click the Freeze button in the Tool Bar, if desired.

Note When you select a Processor, the frame will be grabbed only 
for that Processor — leaving the other "wide screen" portions 
of that frame store available.

Note To view data about the captured frame, click the Still Tab.  In 
the Still Frame Buffers section, the still will be listed below 
the selected frame buffer’s radio button, along with the label 
"Unsaved" and the frame’s resolution.
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6. Right-click the Grab button, and use the pop-up menu to select the frame buffer 
into which you want to grab the frame (Buffer 1, 2 or 3).

7. Click the Grab button.  The captured frame now resides in the selected buffer.  

8. Repeat the procedure to capture additional frames from a layer.  Remember that 
you can always overwrite the selected frame buffer.  

Please note:

• The captured frame(s) can now be assigned as the background or DSK “type” for 
BG A, BG B or the DSK.  

• To save the grabbed frames in permanent memory, refer to the "Saving and 
Naming Frames in Permanent Memory" section below.

• Only "saved" frames can be named.

p~îáåÖ=~åÇ=k~ãáåÖ=cê~ãÉë=áå=mÉêã~åÉåí=jÉãçêó
Use the following steps to save a captured frame into permanent memory.  

1. Capture a  frame as outlined in the previous two sections.  

~ "Capturing Frames from a Background or DSK Input" on page 185.

~ "Capturing Frames from a Layer" on page 186.  

2. Click the Stills Tab, and in the Still Frame Buffer section, click the radio button 
for the frame you wish to save.  

3. In the right-hand Still Frame Files table, highlight the row for the file (ID) into 
which you want to save the frame.  You can highlight an empty line, or a line in 
which a frame already is stored. 

4. Click Save to File >> to save the captured frame into the highlighted file.  The row 
turns green to indicate that a frame is now stored in the register.   

5. To name the still frame file (or re-name any still frame file in memory), double-click 
in the appropriate "Name" cell, and type the desired name.  

6. Repeat the procedure to save additional frames.

oÉÅ~ääáåÖ=cê~ãÉë=Ñêçã=jÉãçêó
Use the following steps to recalled a frame from memory back into a still frame buffer:

1. Click the Stills Tab, and in the Still Frame Buffer section, click the radio button 
for the frame buffer into which you want to recall a frame.  

2. In the right-hand Still Frame Files table, highlight the row for the frame that you 
want to recall.   

Note To view data about the captured frame, click the Still Tab.  In 
the Still Frame Buffers section, the still will be listed below 
the selected frame buffer’s radio button, along with the label 
"Unsaved" and the frame’s resolution.

Note Remember that you can always overwrite a frame in 
permanent memory.
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3. Click Recall from File << to recall the frame from memory into the selected buffer. 

4. Repeat the procedure to recall additional frames.

bê~ëáåÖ=~åÇ=aÉäÉíáåÖ=cê~ãÉë
Please remember the following rules regarding erasing and deleting frames:

• The "Delete File" procedure enables you to mark a selected frame as deleted — 
but the "Erase File" function is still required for permanent deletion.  You can 
consider "Delete File" as a quick delete function.

• The "Erase File" procedure is a destructive process that enables you to 
permanently erase a selected frame.  

Use the following steps to delete a saved frame.  

1. Click the Stills Tab, and in the right-hand Still Frame Files table, highlight the row 
for the frame that you want to delete.   

2. Click Delete File.  The selected row changes back to the default gray or white.

3. Repeat the procedure to delete additional frames.

Use the following steps to permanently erase a saved frame.  

1. Click the Stills Tab, and in the right-hand Still Frame Files table, highlight the row 
for the frame that you want to erase.   

2. Click Erase File.  The selected row changes back to the default gray or white.

3. Repeat the procedure to erase additional frames.
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_~ÅâáåÖ=ré=~åÇ=oÉëíçêáåÖ=`çåÑáÖìê~íáçåë
The Encore GC system enables you to backup and restore your system configuration into a 
user-specified location on your PC or laptop.  The following topics are discussed:

• Backing up the Configuration

• Restoring the Configuration

_~ÅâáåÖ=ìé=íÜÉ=`çåÑáÖìê~íáçå
This procedure enables you to back up the ECU configuration.  Please note:

• When you back up the configuration, multiple system files are stored in a folder of 
your choice.  

• To store multiple system configurations, create and name separate folders, e.g., 
Sys Config 1, Sys Config 2.

Use the following steps to back up the configuration:

1. On your PC or laptop, create a folder in which you want to store the system 
configuration.  

2. In the Menu Bar, click ECU > Backup Configuration to display the Save 
Configuration Files In Dialog.

3. Navigate to the desired "save in" folder in the normal way.

4. In the dialog, click Save.  If backup files already exist in the selected folder, you 
will be asked to confirm the overwrite procedure.  Click Yes to All to continue.

5. The File Transfer Status window appears, which summarizes the status of the 
backup.  Click OK to complete the procedure.

oÉëíçêáåÖ=íÜÉ=`çåÑáÖìê~íáçå
Use the following steps to restore your configuration:

1. In the Menu Bar, click ECU > Restore Configuration to display the Get 
Configuration Files From Dialog.

2. Navigate to the folder in which the configuration is saved.

3. In the dialog, click Open.  

4. The File Transfer Status window appears, which summarizes the status of the 
restore operation.  Note that the connection to the ECU is lost during the restore 
process.  When the process is complete, the Reconnect Dialog appears.  Click 
Yes to complete the procedure.

At the conclusion of this procedure, your system is completely restored — exactly the way 
that you left it when you performed a complete system “backup.”    
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bñíÉêå~ä=`çåíêçä
For external control, third party controllers such as Crestron or AMX can be connected to 
the ECU network.  In this configuration, presets are programmed and stored using the 
Encore GC, downloaded to the ECU, and then triggered externally.

When you installed your Encore GC software, a "Documents" folder was also installed 
which contains the Encore GC protocol document:

• (Typical) Location:  C:\Program Files\Barco\Encore GC\Documents

• Filename:  Encore Controller Protocol Specification - Rev #.pdf

This document contains all the required remote commands and protocols for connecting 
your external control system to the ECU network.
190 Encore GC and ECU  •  User’s Guide



^K==péÉÅáÑáÅ~íáçåë

få=qÜáë=^ééÉåÇáñ
This appendix provides detailed technical specifications for the Encore GC and ECU.  The 
following topics are discussed:

• Physical and Electrical Specifications

• Agency Specifications

• Connectivity Specifications

• Input and Output Resolutions
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^K==péÉÅáÑáÅ~íáçåë
Physical and Electrical Specifications
mÜóëáÅ~ä=~åÇ=bäÉÅíêáÅ~ä=péÉÅáÑáÅ~íáçåë=
The table below lists OCU physical and electrical specifications.

Table A-1. OCU Physical and Electrical Specifications

Parameter Detail Specification

Mechanical Chassis H:  1.73 in. (4.39 cm), 1 RU rack mount

W:  16.79 in. (42.64 cm), 19.06 in. (48.38 cm) including ears

D:  18.00 in. (45.72 cm) 

Power Connector Standard IEC, integral on/off switch

Power 100-240 VAC, 50-60 Hz, 1.5 - 0.75A 

Temperature Range 0 - 60°C (32 - 140°F)

Humidity Operation 5% - 95% non-condensing

Weight 7.25 Kg (16 pounds)
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^K==péÉÅáÑáÅ~íáçåë
Agency Specifications
^ÖÉåÅó=péÉÅáÑáÅ~íáçåë=
The table below lists OCU agency specifications.  

Table A-2. OCU Agency Specifications

Parameter Detail Specification

Emissions Conforms to:

EN-55022;1998/A1:2000/A2:2003 Class A, Conducted Emissions, 150kHz to 30MHz

EN-55022;1998/A1:2000/A2:2003 Class A, Radiated Emissions, 30MHz to 1GHz

EN 61000-3-2:2000 Harmonic Current Emissions

EN 61000-3-3:1995/A1:1998 Voltage Fluctuations and Flicker

Immunity Conforms to:

EN 55024:1998/A1:2001/A2:2003

EN 61000-4-2:1995/A1:1998/
A2:2002

Electrostatic Discharge, 8kV Direct Air, 4kV Direct and 
Indirect contact

EN 61000-4-3:2002/A1:2002 Radiated RF Immunity, 80MHz-1000MHz, 3V/m, 80% AM 
1kHz

EN 61000-4-4:2004 EFT, 1kV Power, 0.5kV I/O

EN 61000-4-5:1995/A1:2001 Surge Immunity, 1kV Differential Mode, 2kV Common 
Mode

EN 61000-4-6:1996/A1:2001 Conducted RF Immunity, 150kHz - 80 MHz, 3Vrms, 80% 
AM 1kHz

EN 61000-4-11:2004 Voltage Dips and Interruptions

Safety Conforms to:

EN 60950-1 (2001) Electrical Safety Testing
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^K==péÉÅáÑáÅ~íáçåë
Connectivity Specifications
`çååÉÅíáîáíó=péÉÅáÑáÅ~íáçåë=
The table below lists OCU connectivity specifications.

fåéìí=~åÇ=lìíéìí=oÉëçäìíáçåë
The Encore GC and ECU supports a variety input and output resolutions, as specified in 
the supported video processors, such as the Encore VP and the ScreenPRO-II.  For 
details, refer to the appropriate processor’s User’s Guide.  

Table A-3. OCU Connectivity Specifications

Parameter Detail Specification

USB Ports 4 Two on front, two on rear

Ethernet Ports 2 Rear panel (LAN1, LAN 2), Dual PCIE x 1GbE

Serial Ports 2 Rear panel (COM 1, COM 2), 2 x RS-232

VGA Port 1 Rear panel, HD-15

Keyboard Port 1 Rear panel, PS-2
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_K==`çåí~Åí=fåÑçêã~íáçå

få=qÜáë=^ééÉåÇáñ
The following topics are discussed in this Appendix:

• Warranty

• Return Material Authorization (RMA)

• Contact Information

t~êê~åíó
All video products are designed and tested to the highest quality standards and are backed 
by a full 3-year parts and labor warranty.  Warranties are effective upon delivery date to 
customer and are non-transferable.  Barco warranties are only valid to the original 
purchaser/owner.  Warranty related repairs include parts and labor, but do not include faults 
resulting from user negligence, special modifications, lightning strikes, abuse (drop/crush), 
and/or other unusual damages.

The customer shall pay shipping charges when unit is returned for repair.  Barco will cover 
shipping charges for return shipments to customers.  

oÉíìêå=j~íÉêá~ä=^ìíÜçêáò~íáçå=Eoj^F
In the unlikely event that a product is required to return for repair, please call the following 
number and ask for a Sales Engineer to receive a Return Merchandise Authorization 
number (RMA).

• (888) 414-7226 

RMA Conditions are listed below:

a. Prior to returning any item, you must receive a Return Merchandise 
Authorization (RMA) number.  

b. All RMA numbers must appear on their return-shipping label.

c. All shipping and insurance charges on all RMAs must be prepaid by the 
customer 
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_K==`çåí~Åí=fåÑçêã~íáçå
Contact Information
`çåí~Åí=fåÑçêã~íáçå
Barco, Inc.
11101 Trade Center Drive
Rancho Cordova, California  95670
USA

• Phone: (916) 859-2500 

• Fax: (916) 859-2515

• Website:  www.barco.com

Sales Contact 

• Direct:  (916) 859-2505

• Toll Free:  (888) 414-7226

• E-mail:  folsomsales@barco.com

Barco N.V. 
Noordlaan 5
8520 Kuurne
BELGIUM 

• Phone: +32 56.36.82.11 

• Fax: +32 56.35.16.51

• Website:  www.barco.com

Technical Support 

• Tech Line:  (866) 374-7878 — 24 hours per day, 7 days per week

• E-mail: folsomsupport@barco.com
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`K==réÖê~ÇáåÖ=pçÑíï~êÉ

få=qÜáë=^ééÉåÇáñ
The following topics are discussed in this Appendix:

• Downloading Software

• Installing Software

açïåäç~ÇáåÖ=pçÑíï~êÉ
Two different methods can be used to download Encore GC system software:

• Via FTP Site

• Via Web Site

sá~=cqm=páíÉ
Barco's FTP site address is:  ftp.folsom.com

To download from the FTP site:

1. Create a target folder on your PC (e.g., Encore GC).

2. If you are using an FTP client, logon to our site as follows:

~ User name:  anonymous

~ Password:  your email address

Example:  johndoe@somecompany.com

If you are using a web browser to access our FTP site, point the browser to: 

ftp://ftp.folsom.com

3. Once logged on, navigate to the following directory:

ftp://ftp.folsom.com/Image Processing/EncoreGC/Released/

4. Transfer the following file to the target folder on your PC:

EncoreGCInstall.exe

5. Please continue with the “Installing Software” section on page 198.
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`K==réÖê~ÇáåÖ=pçÑíï~êÉ
Installing Software
sá~=tÉÄ=páíÉ
Barco's web site address is:  www.barco.com

To download from the web site:

1. Create a target folder on your PC (e.g., Encore GC).

2. On the web, navigate to:

http://www.barco.com

3. Navigate to the “Events” home page:

http://www.barco.com/events

4. Log in to the Barco Partnerzone.  Note that a user name and password are 
required.

5. Navigate to the “Software Updates” link.

6. Click the Folsom Image Processing tab.

7. Download the latest version of Encore GC software.

8. When the File Download Dialog appears, click Save to save the file to your 
computer.

9. When the Save As Dialog appears, navigate to the target folder and click Save.

fåëí~ääáåÖ=pçÑíï~êÉ
To install software:

1. With the software download complete, in Chapter 4, follow the software 
installation steps that are outlined in the “Installing Encore GC Software” section 
on page 46.
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